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1. Welcome to COPA-DATA help 

ZENON VIDEO-TUTORIALS 

You can find practical examples for project configuration with zenon in our YouTube channel 
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an 
initial insight into working with different zenon modules. All tutorials are available in English. 
 

GENERAL HELP 

If you cannot find any information you require in this help chapter or can think of anything that you 
would like added, please send an email to documentation@copadata.com. 

 

PROJECT SUPPORT 

You can receive support for any real project you may have from our Support Team, who you can contact 
via email at support@copadata.com. 

 

LICENSES AND MODULES 

If you find that you need other modules or licenses, our staff will be happy to help you. Email 
sales@copadata.com. 
 

2. Wizards 

In order to be able to handle recurring tasks in the engineering phase easily and expeditiously, zenon 
offers wizards for different fields of engineering. 

Users can also create their own wizards. 

https://www.copadata.com/tutorial_menu
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START WIZARDS 

To start a wizard: 

 In the Tools menu, select the Start Editor wizards... entry.  

or 

 press the short cut Alt+F12. 

The dialog to select an Editor wizard is opened. 

 

The wizard for project creation is automatically offered when a new project is created. 

SETTINGS ZENON6.INI  

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 

[VSTA]. 
 

3. Topics 

The following wizards are available in zenon: 

 Analyzer (on page 8)  
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 Export Wizard for Analyzer 2.10  (on page 9) 

 Export Wizard for Analyzer 2.20 (on page 37) 

 Export Wizard for Analyzer 3.00 (on page 67) 

 Export Wizard for Analyzer 3.10 (on page 100) 

 Meaning and Waterfall Chart Wizard (on page 134) 

 Sankey Wizard (on page 160) 

 Energy 

 Driver Simulation (on page 185) 

 IEC 61850 SSD Import (on page 190) 

 IEC850 Driver Configuration (on page 213) 

 Export - Import (on page 249) 

 FactoryLink Import Wizard (on page 249) 

 PDiag import wizard (on page 263) 

 WinCC Import Wizard (on page 271) 

 XML export wizard (on page 294) 

 XML Import Wizard (on page 299) 

 Language Table (on page 299) 

 Language Table Wizard (on page 300) 

 Language Translation Wizard (on page 305) 

 System Text Wizard (on page 310) 

 Metering Point Administration Wizard (on page 315) 

 Pharmaceutical (on page 402) 

 Pharmaceutical Wizard (on page 402) 

 Project (on page 430) 

 Backup Comparison Wizard  (on page 430) 

 Documentation wizard (on page 467) 

 Project Wizard (on page 443) 

 Variables  (on page 467) 

 Everywhere Essentials QR Code Generator (on page 467) 

 Variable creation wizard (on page 476) 

 Wizards VSTA (on page 479) 

 Demo Wizard: Empty template that can be amended individually. 
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3.1 Analyzer 

The zenon Analyzer has wizards that support correct setting of parameters for the SCADA system and 
the export of data from the SCADA system. The zenon SCADA system is currently supported. 

Wizards: 

 Export Wizard for Analyzer 2.10 (on page 9): Supports the export of metadata from zenon for 
the zenon Analyzer, version 2.10. 

 Export Wizard for Analyzer 2.20 (on page 37): Supports the export of metadata from zenon for 
the zenon Analyzer, version 2.20. 

 Export Wizard for Analyzer 3.00 (on page 67): Supports the export of metadata from zenon for 
the zenon Analyzer, version 3.00. 

 Export Wizard for Analyzer 3.10 (on page 100): Supports the export of metadata from zenon for 
the zenon Analyzer, version 3.10. 

 Meaning and Waterfall Chart Wizard (on page 134): Helps you prepare a zenon project for the 
processing of variable information in zenon Analyzer. 

 Sankey Wizard (on page 160): supports you when creating Sankey diagrams that you can see in 
the Runtime or which are used in zenon Analyzer. 

The wizards for zenon Analyzer are automatically installed when installing zenon 7.20. The Analyzer 

Export Wizard has its own DLL. Meaning and Waterfall Chart Wizard and Sankey Wizard share a DLL. 
Installation and maintenance thus differ from other zenon wizards. Analyzer wizards are automatically 
kept up to date with the updates from zenon from version 7.20. The update can, if required, also be 
carried out manually via the build file contained in the zenon Analyzer installation medium for zenon 
from version 7.10. These wizards are not updated by means of the update mechanism of the zenon 
wizard. For details, see the Installation and Update chapter in the zenon Analyzer manual. 

SYNTAX FOR INPUTS IN ZENON 

Input in in zenon depends on the version of zenon that is used. 

UP TO ZENON 7.11 

Up to and including zenon version 7.11, the meaning and waterfall model is entered in the zenon 
Resources label property. These can contain meanings for several categories. 

The following is applicable to entries in the resource label property: 

 Categories are separated by a semicolon (;). 

 Areas within a category are separated by a comma (,). 

 Categories are marked by an index: 
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 ME=: Identifies a (Meaning).  
Syntax: ME=[main meaning as text],[additional meaning as text],[additional 
meaning as text],…; 
Example: ME=Station_1,Station_2; 

 WF=: Identifies a variable for the waterfall display. 
Syntax: WF=[model name text],[line index INT],[index in column INT],[color 
code as text #XXXXXX]; 

 Every other entry is also understood as a Meaning 

Complete syntax for the Resources label property: 
ME=[meaning1],[meaning2],…,[meaningN];WF=[model name],[row index],[index in 

row],[color code]; 

Attention: The Resources label property is limited to 256 characters in the zenon Editor. 

FROM ZENON 7.20 

From zenon 7.20, there are separate properties in zenon for the definition of Meaning and waterfall, as 
well as the input of a display name. These entries do not need an identification in front of them. 

The following properties in the zenon  Analyzer variable properties group provide information for 
reports in the zenon Analyzer: 

 Display name: Entry of a display name of the variable in zenon Analyzer. This must be unique in 
the project. The check is not carried out when issued in zenon, but when imported into zenon 
Analyzer. If this property is changed after the first export to a zenon Analyzer, these changes are 
not applied in the zenon Analyzer. 

 Meaning: Entry of the (Meaning) of a variable in the zenon Analyzer. Entry is manual or by means 
of the Meaning and Waterfall Chart Wizard. Several meanings are separated by a comma. 
Syntax:[Meaning1],[Meaning2],…,[MeaningN] 

 Parameters for waterfall diagram: Parameters of a variable for a waterfall diagram in zenon 
Analyzer. Entry is manual or by means of the Meaning and Waterfall Chart Wizard. The 
individual parameters are separated by a comma. Several waterfalls are divided by a semicolon. 
Syntax: [model name],[row index],[index in row],[color code];  

Attention: All these input fields are limited to 256 characters in the zenon Editor. 

 When exporting to zenon Analyzer, both the previous property and the new one are checked. If 
both are assigned, the entries of the new properties are taken on. Entries that are created using 
the Meaning and Waterfall Chart Wizard are always entered into the new properties. 

 

3.1.1 Export Wizard for Analyzer 2.10 

The zenon  Export Wizard for Analyzer 2.10 supports the export of metadata from zenon from version 
7.10 SP0 for the zenon Analyzer 2.10. 
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The following can be exported: 

 Data from the global project 

 Equipment models 

 Alarm/event classes 

 Alarm/event groups 

 User 

 Data from selected projects: 

 Archives 

 Variables 

 

Note: The wizard is only available in English. 

COMPATIBILITY: 

The  Analyzer Export Wizard works, depending on the version, with different zenon Analyzer versions 
and different zenon versions. For details, read the Analyzer wizard compatibility chapter. 
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Install and call up wizard 

The wizard is automatically installed with zenon for each supported version of zenon Analyzer. 

STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 
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3. Select the Export Wizard for Analyzer 2.10. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
 

Start window 

When the wizard is opened, you receive an overview page that lists all exportable objects. 
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The individual objects are configured for the export on individual tabs. 

 

Click on the button with the arrow to navigate through the configuration (on page 41) of the export. 
 

Configuration 

When exporting with the Analyzer Export Wizard, all modules selected in the Settings (on page 43) tab 
are offered in sequence for detailed configuration. You get to the next level by clicking on the button 
with the right arrow. You can select individual tabs directly by clicking on the title of the tab. 

The following tabs are available for configuration of the export: 

 Settings (on page 43):  
Options for collection metadata 

 Equipment model: (on page 47)  
Export of the model groups from the global project 

 Event classes (on page 50):  
Alarm/Event classes from global project 

 Event Event groups (on page 52):  
Alarm/event groups from global project 
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 Users (on page 54):  
User from global project 

 Projects (on page 55):  
Projects from workspace 

 Historian (on page 58):  
Archives of the selected projects 

 Variables (on page 60):  
Variables of the selected projects 

 Finish (on page 65):  
Start of the export and output of the result 

 

Attention: Only one global project can be exported to the database! Workspaces with projects that are 
to be exported to the database must include this global project. 
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Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 

 

Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Export Exports the data to the Analyzer database. 

Is only active if the Finish tab is opened. 

Cancel Closes the wizard without exporting. 

When closing, a dialog asks if the configuration is to be saved 

 Yes: writes the settings configured in the Settings (on page 43) tab 
to the registry and closes the wizard; the wizard is opened with these 
settings the next time it is restarted 

 No: closes the wizard without saving the configuration 

The configuration is saved for each specific user. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
 

Settings 

In this tab: 

1. You define the database to which the wizard connects 

2. You define general options for exporting 
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3. You start the data readout 
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Option Description 

Settings Information and hints about current export processes. 

Database settings Connection settings to the Analyzer server. 

DB host Computer on which the database is located. 

DB instance Instance of the database. 

DB name Name of the database. 

Authentication Type of authentication: 

 Windows Authentication: Windows login information is 
used. 

 SQL Server Authentication: Login with data from an SQL 
server user. 

User name Entry of the user name. 

Only for login with SQL Server Authentication. Display only 

with Windows Authentication. 

Password Entry of the password. 

Only for login with SQL Server Authentication. No input 

possible with Windows Authentication. 

Remember password Password is saved for next connection. 

Only for login with SQL Server Authentication. Inactive for 

Windows Authentication. 

Options General options for the export. 

Load every project of this 

workspace into the memory 
Active: Loads all projects present in the workspace, even if 
they are not active and not set to Keep project in memory. 
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Keep the exisiting data in the 

Analyzer database 
Active: Only entries from the workspace are written to the 
database. 

Inactive: Entries in the database are also updated or 
deleted. 
Exception: Projects are not deleted 

Preselect existing Analyzer 

database content 
Active: Entries already present in the database are preselected in 
the individual areas. 

Load Data  

Load Data Clicking on the button loads, depending on the Load every 

project of this workspace into the memory parameter - the data 
from the currently loaded project into the wizard. 

In doing so, a check is made to see if data is present in the 
Analyzer database. Pre-existing data is combined with the data 
from the workspace and loaded into the wizard. In the event 
of naming conflicts, a dialog to rectify the error is called up. 

If the loading of data has been successfully concluded, the 
export can be configured in the following tabs. 

RENAME OBJECT 

Objects must always be named the same in the Analyzer database and in zenon. If objects that are 
already present in the database are renamed in zenon, these changes can be accepted or rejected when 
the data is combined. Rejection of the changes leads to the wizard being closed, because only objects 
with identical names can be handled correctly. 
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DIALOG FOR RENAMING 

In the event of conflicts in the naming of objects, a dialog for dealing with the error is opened: 

 

Option Description 

List of amended objects Contains all objects that were changed. Previous name and new name 
are displayed. The following renamed objects are displayed in the list: 

 Name of the equipment models 

 Names of the alarm/event classes 

 Names of the alarm/event groups 

 Project name 

 Variable name 

Exceptions: 

 Users are always recreated 

 Archive names are only created once in the database as a visual name 
and can be overwritten in the zenon Analyzer 

Rename Renames all objects listed in the database, closes the dialog and stops 
reading in data. 

Cancel Leaves the previous name in the database, finishes reading in data and 
closes the wizard. 

 
 

Equipment model 

Configuration of the model group which should be exported from the global project. 
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  Attention 

Each equipment group in zenon may only be assigned to one individual time model. 

If several time model groups are assigned, the Analyzer Wizard Export uses the first that 
it finds and exports this to the metadata of the Analyzer. Other time model groups are 
ignored. 
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Option Description 

Equipment modeling  Information and notes on exporting. 

Selection of equipment/medium Drop-down list to select what is offered in List of equipment 

models/media for configuration: 

 Plant: displays equipment models 

 Media: displays media 

List of equipment models/media List field with the possibility to select equipment models and model 
groups or media. To select an entry, activate the check box in front 
of the entry. 

In the list field the name, as it is stored in the database, is always 
displayed in the individual nodes. If the name was changed, the 
original name from the zenon project is displayed in brackets. 

Equipment groups that were deleted in the global project are no 
longer displayed. 

If, in the Settings tab, the option Keep the existing data in the 

Analyzer database was selected, amended objects in the database 
are deleted or updated. 

Select all Clicking on the button selects all equipment groups 

Deselect all Clicking on the button deselects all equipment groups. 
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Alarm/event classes 

Configuration of the alarm/event classes which should be exported from the global project. 
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Option Description 

Alarm/event classes Information and notes on exporting. 

List of the alarm/event classes List field with the possibility to select the alarm/event classes. To 
select an entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the 
check box sets the options for all selected rows. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the option Keep the existing data in the 

Analyzer database was selected, amended objects in the database 
are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Event groups 

Configuration of the alarm/event groups which should be exported from the global project. 
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Option Description 

Alarm/event groups Information and notes on exporting. 

List of the alarm/event groups List field in which you can select alarm/event groups. To select an 
entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the 
check box sets the options for all selected rows. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the option Keep the existing data in the 

Analyzer database was selected, amended objects in the database 
are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Users 

Configuration of the user which should be exported from the global project. 
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Option Description 

Users Information and notes on exporting. 

User List  List field with selection possibility for users. To select an entry, 
activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the 
check box sets the options for all selected rows. 

If, in the Settings tab, the option Keep the existing data in the 

Analyzer database was selected, amended objects in the database 
are deleted or updated. 

If a user was renamed in zenon they are considered new and 
recreated in the project. The previous user is deleted. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

 
 

Projects 

Configuration of the local projects which should be exported. The names for the server and 
standby-server can be changed here. To do this: 

1. Highlight the project in the list of projects 

2. Enter the desired name for the server and standby-server 
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If the name of the Server or the Standby Server is changed in the zenon project, this is only updated in 
the Analyzer database if the Network active setting was activated in the project properties. 
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Option Description 

Projects Information and notes on exporting. 

Project list List field with selection possibility for projects. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the check box 
sets the options for all selected rows. 

 

If, in the Settings tab, the option Keep the existing data in the Analyzer 

database was selected, amended objects in the database are deleted or 
updated. 

Server Address of the server for the project selected in the list window. 

Standby Address of the server for the project selected in the list window. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Historian 

Selection of the archive from the selected projects (on page 55). Only base archives are displayed. 
Aggregated archives are not displayed in the list, but are also selected with the base archives and 
written to the database. 
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Option Description 

Historian Information and notes on exporting. 

Archive list  List field with possibility to select for archives. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the check box sets 
the options for all selected rows. 

If, in the Settings tab, the option Keep the existing data in the Analyzer 

database was selected, amended objects in the database are deleted or 
updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Variables 

Configuration of the variables from the local project which should be exported. When selecting 
variables, the entries offered can be prefiltered. 
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Option Description 

Variables Information and notes on exporting. 

Variable Filter Selection of the variable filter using the following option fields: 

 Show all: All variables are displayed. 

 Historians only: Only archive variables are displayed. 

 Equipment groups only: Only variables are displayed which 
are part of the selected Equipment model (on page 47). 

 Show not selected only: Only variables that were not selected 
are displayed. 

Filter row Input of alphanumerical characters according to which the List of 

variables is to be filtered. 

List of variables List field with possibility to select variables. To select an entry, 
activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several rows are highlighted, a click in the 
check box sets the options for all selected rows. 

If, in the Settings tab, the option Keep the existing data in the 

Analyzer database was selected, amended objects in the database 
are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

RULES FOR THE EXPORT OF VARIABLES WITH REACTION MATRICES 

If linked variables are exported with reaction matrices, the limit value text and the status value of the 
reaction matrix statuses are also exported to the STATUSNAME table in the metadata database of the 
Analyzer. Because only certain states can be evaluated in the reports, they must be pre-sorted using the 
wizard. 

The following statuses of the reaction matrices can be exported or excluded: 
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Rema Rules 

Numeric  The default status is ignored. 

 If several statuses with the same status and limit value condition are set, then 
only the first status and its status text are exported. 

 Only statuses with a value that is equal to a limit value are exported (limit 
value condition). 

 The limit value conditions greater than, less than, as desired and 

range are ignored. 

Multi numeric  Correspond to the rules for numeric. 

 Substatuses are also ignored. 

Binary  

 

 Only statuses that have value bits set consistently from right to left in the bit 
mask (0 or 1) are set.  
For example: 
........ ....10.. 1 
........ .....100 . 
........ .....100 1 

The following are ignored, for example 
........ ........ 1 
........ ......00 1 
........ .10..100 1 

Multi binary  Correspond to the rules for Binary. 

 In addition, substatuses and statuses are also ignored with edge definitions in 
the bit mask. 

String   Are completely ignored and not exported. 

 
 

Finish 

To export the configured data: 
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1. In the Finish tab, click on the Export button 

 

2. the export is started 
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3. The exported elements are shown in the output window with the attendant success and error 
messages  
In addition, the number of objects that have been added, replaced or deleted, and the number 
of errors that occurred are shown. 

 

4. Click on Close to close the wizard 

RECONFIGURING THE WIZARD 

To reconfigure the wizard: 

1. Open the Settings (on page 43) tab 

2. click on button Load data 

3. Configure the tabs 
 

Close wizard 

To close the wizard: 

 Click on the Cancel button 
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 a dialog prompts whether the configuration should be saved 

 Clicking on Yes writes the settings configured in the Settings (on page 43) tab to the registry 
and closes the wizard; the wizard is opened with this configuration next time it is started 

 Click on No closes the wizard and the configuration is not saved. 
 

3.1.2 Export Wizard for Analyzer 2.20 

The zenon Analyzer Export Wizard 2.20 supports the export of metadata from zenon from version 7.0 
SP0 for the zenon Analyzer 2.20. 

The following can be exported: 

 Data from the global project 

 Equipment models 

 Alarm/event classes 

 Alarm/event groups 

 User 

 Data from selected projects: 

 Archives 

 Variables, with: 

- Display name (see visual names (on page 64) section) 

- Meaning (see meaning (on page 64) section) 

- Parameters for waterfall diagram (see parameter waterfall chart (on page 64) section) 
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 Sankey diagrams (see Sankey charts (on page 38) section) 

 

Note: The wizard is only available in English. 

COMPATIBILITY: 

The  Analyzer Export Wizard works, depending on the version, with different zenon Analyzer versions 
and different zenon versions. For details, read the Analyzer wizard compatibility chapter. 
 

Sankey diagrams 

The wizard automatically reads the definition for Sankey diagrams from all activated projects (on page 
43) and the global project. These are in the zenon project folder \Files\Others.  
For this, the following applies: 

 Only valid XML files that were created for the zenon Analyzer are taken into account.  
Diagrams that have the Analyzer  and Valid attributes set to True in the Sankey XML file are 
valid. All other Sankey diagrams are ignored and not loaded. 



Topics 

 

 

39 

 

 

 All Sankey diagram definitions are written to the zenon Analyzer metadata database in the 
SANKEY_DIAGRAMM, SANKEY_OBJECT and SANKEY_VARIABLE tables. 

 Diagrams are added depending on the setting for the Keep the existing data in the Analyzer 

database option (on page 43): 

 Active: Only new diagrams are added to the Analyzer database. 

 Inactive: New diagrams are added and existing diagrams are updated. 

 Diagrams deleted in zenon (XML files) are not deleted in the Analyzer. Diagrams can only be 
deleted in the database directly in zenon Analyzer. 

 For the adding or updating of diagrams, the following must apply to all required zenon variables: 

 Be selected via the Variables (on page 60) tab  
or 

 already be in the database 

If variables that are required for the Sankey diagram are not selected for export, the Sankey 
diagram is not exported. 

 If the Sankey diagram already exists, the metadata database tables are updated according to the 
changes. 

 Clicking on the Export button in the Finish tab starts the export of the Sankey diagrams from 
zenon in to zenon Analyzer.  
The diagrams are only exported once all other data such as projects or variables have been 
exported. The success of the export is shown in the message list of the Finish tab. 

  Attention 

The import of Sankey diagrams is carried out automatically in the background. There are 
no user interface or configuration options available. 

 
 

Install and call up wizard 

The wizard is automatically installed with zenon for each supported version of zenon Analyzer. 

STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 
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If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 

3. Select the Export Wizard for Analyzer 2.20. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
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Start window 

When the wizard is opened, you receive an overview page that lists all exportable objects. 

The individual objects are configured for the export on individual tabs. 

 

Click on the button with the arrow to navigate through the configuration (on page 41) of the export. 
 

Configuration 

When exporting with the Analyzer Export Wizard, all modules available for export are offered for 
detailed configuration. Only the selected data is exported. The export of Sankey diagrams (on page 38) is 
carried out in the background, without the possibility of configuration. You get to the next level by 
clicking on the button with the right arrow. You can also select individual tabs directly by clicking on the 
title of the tab. 

The following tabs are available for configuration of the export: 

 Settings (on page 43): Options for the export of metadata 

 Equipment models: (on page 47) Export of the equipment groups from the global project 
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 Event classes (on page 50): Alarm/Event classes from global project 

 Event groups (on page 52): Alarm/event groups from global project 

 Users (on page 54): User from global project 

 Projects (on page 55). Projects from workspace 

 Archives (on page 58): Archives of the selected projects 

 Variables (on page 60): Variables of the selected projects 

 Finish (on page 65): Start of the export and output of the result 

 

 
 

Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 
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Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Export Exports the data to the Analyzer database. 

Is only active if the Finish tab is opened. 

Cancel Closes the wizard without exporting. 

When closing, a dialog asks if the configuration is to be saved 

 Yes: Writes the settings set in the Settings (on page 43) tab to the 
registry and closes the wizard. The wizard is opened with this 
configuration the next time it is started. 

 No: Closes the wizard without saving the configuration 

The configuration is saved for each specific user. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
 

Settings 

In this tab: 

1. You define the database to which the wizard connects 

2. You define general options for exporting 
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3. You start the data readout 
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SETTINGS 

Option Description 

Settings Information and hints about current export processes. 

DATABASE SETTINGS 

Parameter Description 

Database settings Connection settings to the Analyzer server. 

DB host Computer on which the database is located. 

DB instance Instance of the database. 

DB name Name of the database. 

Authentication Type of authentication: 

 Windows Authentication: Windows login information is 
used. 

 SQL Server Authentication: Login with data from an SQL 
server user. 

User name Entry of the user name. 

Only for login with SQL Server Authentication.  

Display only for Windows Authentication. 

Password Entry of the password. 

Only for login with SQL Server Authentication.  

No input possible with Windows Authentication. 

Remember password Password is saved for next connection. 

Only for login with SQL Server Authentication.  

Inactive with Windows Authentication. 

PROJECTS 

Parameter Description 

Projects List of the available projects in the current zenon workspace. The 
checkbox shows whether the data of the project is used: 
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 Active: Project is used. 

Projects that are active in the memory are pre-selected. Inactive 
projects can be added by means of selection with a checkbox. 

OPTIONS 

Parameter Description 

Options General options for the export. 

Keep the existing data in the 

Analyzer database 
 Active: Only completely new entries from the workspace are 

written to the database. 
Note: If linkings from variables, archives etc. are changed or 
new ones are created, these are not transferred. If these are 
also transferred, the checkbox must be set to Inactive 

 Inactive: Entries in the database are also updated or deleted. 
New entries are created, amended entries are updated and 
deleted entries are removed. 
Exception: Projects and Sankey diagrams are not deleted. 

Preselect existing Analyzer 

database content 
 Active: Entries already present in the database are 

preselected in the individual areas. 

LOAD DATA 

Load Data Clicking on the button loads, depending on the Load every 

project of this workspace into the memory parameter - the data 
from the currently loaded project into the wizard. 

In doing so, a check is made to see if data is present in the 
Analyzer database. Pre-existing data is combined with the data 
from the workspace and loaded into the wizard. In the event 
of naming conflicts, a dialog to rectify the error is called up. 

If the loading of data has been successfully concluded, the 
export can be configured in the following tabs. 

RENAME OBJECT 

Objects must always be named the same in the Analyzer database and in zenon. If objects that are 
already present in the database are renamed in zenon, these changes can be accepted or rejected when 
the data is combined. Rejection of the changes leads to the wizard being closed, because only objects 
with identical names can be handled correctly. 
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DIALOG FOR RENAMING 

In the event of conflicts in the naming of objects, a dialog for dealing with the error is opened: 

 

Parameter Description 

List of amended objects Contains all objects that were changed. Previous name and new name 
are displayed. The following renamed objects are displayed in the list: 

 Name of the equipment models 

 Names of the alarm/event classes 

 Names of the alarm/event groups 

 Project name 

 Variable name 

Exceptions: 

 Users are always recreated 

 Archive names are only created once in the database as a Visualname 
and can be overwritten in the zenon Analyzer 

Rename Renames all objects listed in the database, closes the dialog and stops 
reading in data. 

Cancel Leaves the previous name in the database, finishes reading in data and 
closes the wizard. 

 
 

Equipment models 

Configuration of the model group which should be exported from the global project. 
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  Attention 

Each equipment group in zenon may only be assigned to one individual time model. 

If several time model groups are assigned, the Analyzer Wizard Export uses the first that 
it finds and exports this to the metadata of the Analyzer. Other time model groups are 
ignored. 
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Option Description 

Equipment models  Information and notes on exporting. 

Selection of equipment/medium Drop-down list to select a model that is offered in the Equipment 

models/media list for configuration. 

List of equipment models/media List field with the possibility to select equipment models and model 
groups or media. To select an entry, activate the check box in front 
of the entry. 

In the list field the name, as it is stored in the database, is always 
displayed in the individual nodes. If the name was changed, the 
original name from the zenon project is displayed in brackets. 

Equipment groups that were deleted in the global project are no 
longer displayed. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Clicking on the button selects all equipment groups 

Deselect all Clicking on the button deselects all equipment groups. 
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Alarm/event classes 

Configuration of the alarm/event classes which should be exported from the global project. 
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Option Description 

Event classes Information and notes on exporting. 

List of the alarm/event classes List field with the possibility to select the alarm/event classes. To 
select an entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Event groups 

Configuration of the alarm/event groups which should be exported from the global project. 
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Option Description 

Event groups Information and notes on exporting. 

List of the alarm/event groups List field in which you can select alarm/event groups. To select an 
entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Users 

Configuration of the user which should be exported from the global project. 
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Option Description 

Users Information and notes on exporting. 

User List  List field with selection possibility for users. To select an entry, 
activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

If a user was renamed in zenon they are considered new and 
recreated in the project. The previous user is deleted. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

 
 

Projects 

Configuration of the local projects which should be exported. The names for Server 1 and Server 2 can be 
changed here. 

To change the name of a Server or Standby Server: 

1. Highlight the project in the list of projects. 

2. Enter the desired name for Server 1 and Server 2. 
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If the name of Server 1 or Server 2 is changed in the zenon project, then this is only updated in th 
analyzer database if the Network active setting was activated in the project properties. 
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Option Description 

Projects Information and notes on exporting. 

Project list List field with selection possibility for projects. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for 
all selected lines. 

 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Server 1 Address of the Server 1 for the project selected in the list window. 

Server 2 Address of the Server 2 for the project selected in the list window. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Archives 

Selection of the archive from the selected projects (on page 55). Only base archives are displayed. 
Aggregated archives are not displayed in the list, but are also selected with the base archives and 
written to the database. 
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Option Description 

Archives Information and notes on exporting. 

Archive list  List field with possibility to select for archives. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for all 
selected lines. 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Variables 

Configuration of the variables to be exported from the selected local projects (on page 55). When 
selecting variables, the entries offered can be prefiltered. 
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Option Description 

Variables Information and notes on exporting. 

 

Display Selection of which variables are displayed, via the following option 
fields: 

 All: All variables are displayed. 

 Selected: Only variables that have already been selected are 
displayed. 

 Unselected: Only variables that have not yet been selected are 
displayed. 

Variable filter Selection of the variable filter using the following option fields: 

 All: All variables are displayed. 

 Archives: Only archive variables are displayed. 

 Equipment groups: Only variables are displayed which are 
part of the selected Equipment model (on page 47). 

Filter row Input of alphanumerical characters according to which the List of 

variables is to be filtered. 

List of variables List field with possibility to select variables. To select an entry, 
activate the check box in front of the entry. 

The following are displayed: 

 Name (Analyzer): Name in zenon Analyzer. 

 Name (Workspace): Can be issued from zenon 7.20 in the 
Editor by means of the Display name property. Must be 
unique in the project. See also chapter Visual name (on page 
64) 

 Meaning: Can be issued from zenon 7.20 in the Editor by 
means of the Meaning property. See also chapter Meaning 
(on page 64) 

 Ressource label: corresponds to the Resources label 
property in zenon. Is used for zenon up to and including 
version 7.11 for meaning (on page 64) and parameter 

waterfall diagram (on page 64). From version 7.20, there are 
separate properties available for this in zenon. 

 Identification: It corresponds to the Identification property 
in zenon. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 
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If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

RULES FOR THE EXPORT OF VARIABLES WITH REACTION MATRICES 

If linked variables are exported with reaction matrices, the limit value text, the limit value color and the 
status value of the reaction matrix statuses are also exported to the STATUSNAME table in the 
metadata database of the Analyzer. Because only certain states can be evaluated in the reports, they 
must be pre-sorted using the wizard. 

The following statuses of the reaction matrices can be exported or excluded: 
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Rema Rules 

Numeric  The default status is ignored. 

 If several statuses with the same status and limit value condition are set, then 
only the first status and its status text are exported. 

 Only statuses with a value that is equal to a limit value are exported (limit 
value condition). 

 The limit value conditions greater than, less than, as desired and 

range are ignored. 

Multi numeric  Correspond to the rules for numeric. 

 Substatuses are also ignored. 

Binary  

 

 Only statuses that have value bits set consistently from right to left in the bit 
mask (0 or 1) are set.  
For example: 
........ ....10.. 1 
........ .....100 . 
........ .....100 1 
The following are ignored, for example 
........ ........ 1 
........ ......00 1 
........ .10..100 1 

Multi binary  Correspond to the rules for Binary. 

 In addition, substatuses and statuses are also ignored with edge definitions in 
the bit mask. 

String   Are completely ignored and not exported. 

IMPORT OF VARIABLE INFORMATION FROM ZENON 

The following properties in the zenon  Analyzer variable properties group provide information for 
reports in the zenon Analyzer: 

 Display name: Entry of a display name of the variable in zenon Analyzer. This must be unique in 
the project. The check is not carried out when issued in zenon, but when imported into zenon 
Analyzer. If this property is changed after the first export to a zenon Analyzer, these changes are 
not applied in the zenon Analyzer. 

 Meaning: Entry of the (Meaning) of a variable in the zenon Analyzer. Entry is manual or by means 
of the Meaning and Waterfall Chart Wizard. Several meanings are separated by a comma. 
Syntax:[Meaning1],[Meaning2],…,[MeaningN] 

 Parameters for waterfall diagram: Parameters of a variable for a waterfall diagram in zenon 
Analyzer. Entry is manual or by means of the Meaning and Waterfall Chart Wizard. The 
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individual parameters are separated by a comma. Several waterfalls are divided by a semicolon. 
Syntax: [model name],[row index],[index in row],[color code];  

 
 

Visual name 

The wizard reads the Analyzer/Display name property when loading the zenon workspace from zenon 
7.20 and displays this for each variable in the Variables (on page 60) tab. The following applies for visual 
names: 

 The name must be unique for each project. 

 Names in a project that appear several tines are highlighted in red. 

 The Display name are entered when writing the data to the metadata database. 

 In the event of duplicated name within a project, the Display name is only entered for the first 
variable found. For the second variable, the Name of the variables is entered in zenon. 

 The Display name is only set when the variable is exported for the first time. If this is 
subsequently changed in the Editor, this change is no longer applied in the metadata database. 
Changes are of course applied to a new metadata database when exporting to a new database. 

 With a version of zenon before 7.20, the visual name is always taken from the zenon 
Identification property. 

 

Meaning 

From zenon 7.20, the wizard reads the Analyzer/Meaning property and displays this for each variable in 
the Variables (on page 60) tab.  
The following applies for meanings: 

 If there are entries for Meaning, the corresponding entries in the Resources label are ignored. 

 If there are no entries, corresponding entries from the Resources label are accepted. 

 The identification ME= is no longer necessary but can continue to be used. If a variable is 
assigned several meanings, a comma is used as a separator. 

 With a version of zenon before 7.20, the meaning is always taken from the zenon Resources label 
property. 

 

Parameter waterfall diagram 

The wizard reads the Analyzer/Parameters for waterfall diagram property when loading the zenon 
workspace from zenon 7.20 and displays this for each variable in the Variables (on page 60) tab. The 
following applies for waterfall: 
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 If there are entries for Parameters for waterfall diagram, the corresponding entries in the 
Resources label are ignored. 

 If there are no entries, corresponding entries from the Resources label are accepted. 

 The identification WF= is no longer necessary but can continue to be used. The individual 
elements of a model are separated by a comma. If several waterfall models are assigned to a 
variable, a semicolon is used as a separator. 

 With versions of zenon before 7.20, the waterfall parameters are always taken from the zenon 
Resources label property. 

 

Finish 

To export the configured data: 

1. In the Finish tab, click on the Export button. 

 

2. the export is started 

3. The exported elements are shown in the output window with the attendant success and error 
messages  
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In addition, the number of objects that have been added, replaced or deleted, and the number 
of errors that occurred are shown. 

 

4. Click the Close button to close the wizard 

RECONFIGURING THE WIZARD 

To reconfigure the wizard: 

1. Open the Settings (on page 43) tab. 

2. Click on the Load data button. 

3. Configure the tabs. 
 

Close wizard 

To close the wizard: 

 Click on the Cancel button . 

 A dialog prompts whether the configuration should be saved. 
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 Yes: Writes the settings set in the Settings (on page 43) tab to the registry and closes the 
wizard. The wizard is opened with this configuration the next time it is started. The 
configuration is saved for each specific user. 

 No: Closes the wizard without saving the configuration 
 

3.1.3 Export Wizard for Analyzer 3.00 

The zenon Export Wizard for Analyzer 3.00 supports the export of metadata from zenon from version 
7.11 SP0 for the zenon Analyzer 3.00. 

The following can be exported: 

 Data from the global project 

 Equipment models 

 Alarm/event classes 

 Alarm/event groups 

 User 

 Data from selected projects: 

 Archives 

 Variables, with: 

- Display name (see visual names (on page 95) section) 

- Meaning (see meaning (on page 95) section) 

- Parameters for waterfall diagram (see parameter waterfall chart (on page 69) section) 

 Sankeydiagrams (see Sankey diagrams (on page 68) section) 
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 Efficiency classes (on page 95) 

 

Note: The wizard is only available in English. 

COMPATIBILITY: 

The  Analyzer Export Wizard works, depending on the version, with different zenon Analyzer versions 
and different zenon versions. For details, read the Analyzer wizard compatibility chapter. 
 

Sankey diagrams 

The wizard automatically reads the definition for  Sankey diagrams from all activated projects (on page 
74) and the global project. These are in the zenon project folder \Files\Others.  
For this, the following applies: 

 Only valid XML files that were created for the zenon Analyzer are taken into account.  
Diagrams that have the Analyzer  and Valid attributes set to True in the Sankey XML file are 
valid. All other Sankey diagrams are ignored and not loaded. 

 All Sankey diagram definitions are written to the zenon Analyzer metadata database in the 
SANKEY_DIAGRAMM, SANKEY_OBJECT and SANKEY_VARIABLE tables. 
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 Diagrams deleted in zenon (XML files) are not deleted in the Analyzer. Diagrams can only be 
deleted in the database directly in zenon Analyzer. 

 For the adding or updating of diagrams, the following must apply to all required zenon variables: 

 Be selected via the Variables (on page 91) tab  
or 

 already be in the database 

If variables that are required for the Sankey diagram are not selected for export, the Sankey 
diagram is not exported. 

 If the Sankey diagram already exists, the metadata database tables are updated according to the 
changes. 

 Clicking on the Export button in the Finish tab starts the export of the Sankey diagrams from 
zenon in to zenon Analyzer.  
The diagrams are only exported once all other data such as projects or variables have been 
exported. The success of the export is shown in the message list of the Finish tab. 

  Attention 

The import of Sankey diagrams is carried out automatically in the background. There are 
no user interface or configuration options available. 

 
 

Waterfall chart 

A waterfall diagram can be used for either line-based reports or for machine-based reports. The 
parameters for the diagram are stored in the Analyzer/Parameters for waterfall diagram variable 
property from zenon 7.20. These can be entered manually or created with the Meaning and Waterfall 

Chart Wizard (on page 134). 

EXPORT 

The wizard reads the Parameters for waterfall diagram property when loading the zenon workspace. If 
there are correct entries, these these are exported in the background and written to the database of the 
zenon Analyzer. 

STRUCTURE OF THE ENTRIES 

Depending on the structure of the entries, a decision is made on whether it is entries for machine-based 
or line-based diagrams. 

 Machine based: Structure with 4 digits, separated by a comma; ended with a semicolon. 
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Syntax: [model name],[line index],[column index],[color code code]; 
Example: MyWaterfall,4,2,#80FF00; 

 Line-based: Structure with 7 digits, separated by a comma; ended with a semicolon. 

Syntax: [model name],[line index],[column index],[color code],[loss of auxiliary machine],[add 

loss of auxiliary machine],[subtract loss of auxiliary machine]; 
Example: MyLineAnlaysis,4,2, #80FF00,0,0,0; 

RULES FOR READING: 

The following is applicable for reading: 

 If there are entries for Parameters for waterfall diagram, corresponding entries in the Resources 

label field are ignored. 
The structure decides whether the entry can be evaluated as machine-based or line-based. 

 The identification WF= is not necessary but can to be used. The individual elements of a model 
are separated by a comma. If several waterfall models are assigned to a variable, a semicolon is 
used as a separator. 

 If there are no entries, corresponding entries from the Resources label are accepted. The 
identification WF= must be prefixed here. 

 With versions of zenon before 7.20, the waterfall parameters are taken from the zenon 
Resources label property. 

 

Install and call up wizard 

The wizard is automatically installed with zenon for each supported version of zenon Analyzer. 

STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 
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The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 

3. Select the Export Wizard for Analyzer 3.00. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
 

Start window 

When the wizard is opened, you receive an overview page that lists all exportable objects. 
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The individual objects are configured for the export on individual tabs. 

 

Click on the button with the arrow to navigate through the configuration (on page 72) of the export. 
 

Configuration 

When exporting with the Analyzer Export Wizard, all modules available for export are offered for 
detailed configuration. Only the selected data is exported. The export of Sankey diagrams (on page 68) is 
carried out in the background, without the possibility of configuration. You get to the next level by 
clicking on the button with the right arrow. You can also select individual tabs directly by clicking on the 
title of the tab. Entries already present in the database are preselected in the individual areas. 

The following tabs are available for configuration of the export: 

 Settings (on page 74): Options for the export of metadata 

 Equipment models (on page 79):  (on page 47)Export of the equipment groups from the global 
project 

 Event classes (on page 81): Alarm/Event classes from global project 

 Event groups (on page 83): Alarm/event groups from global project 

 Users (on page 85): User from global project 

H_30448
H_30448
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 Projects (on page 86): Projects from workspace 

 Archives (on page 89): Archives of the selected projects 

 Variables (on page 91): Variables of the selected projects 

 Efficiency classes (on page 95): Display of the efficiency classes to be exported. 

 Finish (on page 98): Start of the export and output of the result 

 

 
 

Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 
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Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Export Exports the data to the Analyzer database. 

Is only active if the Finish tab is opened. 

Cancel Closes the wizard without exporting. 

When closing, a dialog asks if the configuration is to be saved 

 Yes: Writes the settings set in the Settings (on page 43) tab to the 
registry and closes the wizard. The wizard is opened with this 
configuration the next time it is started. 

 No: Closes the wizard without saving the configuration 

The configuration is saved for each specific user. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
 

Settings 

In this tab: 

1. You define the database to which the wizard connects 

2. You define general options for exporting 
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3. You start the data readout 
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SETTINGS 

Parameter Description 

Settings Information and hints about current export processes. 

DATABASE SETTINGS 

Parameter Description 

Database settings Connection settings to the Analyzer server. 

DB host Computer on which the database is located. 

DB name Name of the database. 

Authentication Type of authentication: 

 Windows Authentication: Windows login information is 
used. 

 SQL Server Authentication: Login with data from an SQL 
server user. 

User name Entry of the user name. 

Only for login with SQL Server Authentication.  

Display only for Windows Authentication. 

Password Entry of the password. 

Only for login with SQL Server Authentication.  

No input possible with Windows Authentication. 

Remember password Password is saved for next connection. 

Only for login with SQL Server Authentication.  

Inactive with Windows Authentication. 

PROJECTS 

Parameter Description 

Projects List of the available projects in the current zenon workspace. The 
checkbox shows whether the data of the project is used: 

 Active: Project is used. 
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Projects that are active in the memory are pre-selected. Inactive 
projects can be added by means of selection with a checkbox. 

OPTIONS 

Parameter Description 

Options General options for the export. 

Don't modify existing data in the 

Analyzer metadata database 
 Active: Only completely new entries from the workspace are 

written to the database. 
Note: If linkings from variables, archives etc. are changed or 
new ones are created, these are not transferred. If these are 
also transferred, the checkbox must be set to Inactive 

 Inactive: Entries in the database are also updated or deleted. 
New entries are created, amended entries are updated and 
deleted entries are removed. 
Exception: Projects and Sankey diagrams are not deleted. 

Update Visual names Only available if the Don't modify existing data in the Analyzer 

metadata database option has been deactivated. 

 Active: In zenon, amended display names are overwritten 
when exporting to the metadata database of zenon Analyzer. 

 Inactive: Amended display names are not changed in zenon 
Analyzer. 

Default: Inactive 
The setting is not saved. The checkbox is set to deactivated 
each time the wizard is started. 

Behavior: 

If the checkbox is activated, display names amended in zenon are 
also amended in zenon Analyzer for: 

 Equipment models 

 Event classes 

 Event groups  

 Projects 

 Archives 

 Variables 

The visual names for Users cannot be changed. These are recreated 
in the event of changes. 

Changes to display names are displayed in the individual lists. 

Example: 

Initial situation: 
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 Display name in the zenon project: Z 

 Display name in the zenon Analyzer: A 

Action: 

 A = Z:  
nothing happens. 

 A <> Z:  
Z is applied if the name has not yet been issued in the metadata 
table. If Z is already present in the table, A remains unchanged 
and an error message is given. 

LOAD DATA 

Load Data Clicking on the button loads, depending on the Load every 

project of this workspace into the memory parameter - the data 
from the currently loaded project into the wizard. 

In doing so, a check is made to see if data is present in the 
Analyzer database. Pre-existing data is combined with the data 
from the workspace and loaded into the wizard. In the event 
of naming conflicts, a dialog to rectify the error is called up. 

If the loading of data has been successfully concluded, the 
export can be configured in the following tabs. 

RENAME OBJECT 

Objects must always be named the same in the Analyzer database and in zenon. If objects that are 
already present in the database are renamed in zenon, these changes can be accepted or rejected when 
the data is combined. Rejection of the changes leads to the wizard being closed, because only objects 
with identical names can be handled correctly. 
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DIALOG FOR RENAMING 

In the event of conflicts in the naming of objects, a dialog for dealing with the error is opened: 

 

Parameter Description 

List of amended objects Contains all objects that were changed. Previous name and new name are 
displayed. 

Exception: Users are always recreated. 

Rename Renames all objects listed in the database, closes the dialog and stops 
reading in data. 

Cancel Leaves the previous name in the database, finishes reading in data and 
closes the wizard. 

 
 

Equipment models 

Configuration of the model group which should be exported from the global project. 

  Attention 

Each equipment group in zenon may only be assigned to one individual time model. 

If several time model groups are assigned, the Analyzer Wizard Export uses the first that 
it finds and exports this to the metadata of the Analyzer. Other time model groups are 
ignored. 



Topics 

 

 

80 

 

 

 

Parameter Description 

Equipment models  Information and notes on exporting. 

Selection of equipment/medium Drop-down list to select a model that is offered in the Equipment 

models/media list for configuration. 

List of equipment models/media List field with the possibility to select equipment models and model 
groups or media. To select an entry, activate the check box in front 
of the entry. 

In the list field the name, as it is stored in the database, is always 
displayed in the individual nodes. If the name was changed, the 
original name from the zenon project is displayed in brackets. 

Equipment groups that were deleted in the global project are no 
longer displayed. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Clicking on the button selects all equipment groups 

Deselect all Clicking on the button deselects all equipment groups. 
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Event classes 

Configuration of the alarm/event classes which should be exported from the global project. 
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Parameter Description 

Event classes Information and notes on exporting. 

List of the alarm/event classes List field with the possibility to select the alarm/event classes. To 
select an entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Event groups 

Configuration of the alarm/event groups which should be exported from the global project. 
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Parameter Description 

Event groups Information and notes on exporting. 

List of the alarm/event groups List field in which you can select alarm/event groups. To select an 
entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Users 

Configuration of the user which should be exported from the global project. 
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Parameter Description 

Users Information and notes on exporting. 

User List  List field with selection possibility for users. To select an entry, 
activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

If a user was renamed in zenon they are considered new and 
recreated in the project. The previous user is deleted. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

 
 

Projects 

Configuration of the local projects which should be exported. The names for Server 1 and Server 2 can be 
changed here. 

To change the name of a Server or Standby Server: 

1. Highlight the project in the list of projects. 

2. Enter the desired name for Server 1 and Server 2. 
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Note: Changes here are only possible if, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option has been deactivated. The information that is displayed for the server 
depends on the settings in the project and the database. For details, see the Display of server settings 
section. 
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Parameter Description 

Projects Information and notes on exporting. 

Project list List field with selection possibility for projects. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for 
all selected lines. 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Server 1 Address of the Server 1 for the project selected in the list window.  
Source (project or database) depending on configuration. 

Server 2 Adress of the Server 2 for the project selected in the list window. 
Source (project or database) depending on configuration. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

DISPLAY OF SERVER SETTINGS 

The following is applicable for the display and configuration of the server in this tab: 

 In the zenon project, the Network active property is activated: 
Server 1 and Server 2 from the project are displayed. 

 In the zenon project, the Network active property is deactivated: 
Server 1 and Server 2 from the database are displayed. 

 In the zenon project, the Network active property is deactivated and there are no entries present 
for the server in the database: 
Empty entries are displayed for Server 1 and Server 2. 
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Archives 

Selection of the archive from the selected projects (on page 86). Only base archives are displayed. 
Aggregated archives are not displayed in the list, but are also selected with the base archives and 
written to the database. 
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Parameter Description 

Archives Information and notes on exporting. 

Archive list  List field with possibility to select for archives. To select an entry, activate the 
check box in front of the entry. 

 Name (Analyzer): Name of the archive in zenon Analyzer. 

 Name (Project): Name of the archive in the project. 

 Archive ID (Project): ID of the archive in the project. 

 Project: Project from which the archive comes. 

 Description: Individual description of the project. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for all 
selected lines. 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Variables 

Configuration of the variables to be exported from the selected local projects (on page 86). When 
selecting variables, the entries offered can be prefiltered. 
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Parameter Description 

Variables Information and notes on exporting. 

 

Display Selection of which variables are displayed, via the following option 
fields: 

 All: All variables are displayed. 

 Selected: Only variables that have already been selected are 
displayed. 

 Unselected: Only variables that have not yet been selected are 
displayed. 

Variable filter Selection of the variable filter using the following option fields: 

 All: All variables are displayed. 

 Archives: Only archive variables are displayed. 

 Equipment groups: Only variables are displayed which are 
part of the selected Equipment model (on page 79). 

Filter row Input of alphanumerical characters according to which the List of 

variables is to be filtered. 

Attention: The filter makes a distinction between upper-case and 
lower-case letters (it is case sensitive). 

List of variables List field with possibility to select variables. To select an entry, 
activate the check box in front of the entry. 

The following are displayed: 

 Name (Analyzer): Name in zenon Analyzer. 

 Name (Workspace): Can be issued from zenon 7.20 in the 
Editor by means of the Display name property. Must be 
unique in the project. See also chapter Visual name (on page 
95) 

 Meanings: Can be issued from zenon 7.20 in the Editor by 
means of the Meaning property. See also chapter Meaning 
(on page 95) 

 Project: Project from which the variable comes. 

 Identification: It corresponds to the Identification property 
in zenon. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
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objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

RULES FOR THE EXPORT OF VARIABLES WITH REACTION MATRICES 

If linked variables are exported with reaction matrices, the limit value text, the limit value color and the 
status value of the reaction matrix statuses are also exported to the STATUSNAME table in the 
metadata database of the Analyzer. Because only certain states can be evaluated in the reports, they 
must be pre-sorted using the wizard. 

The following statuses of the reaction matrices can be exported or excluded: 
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Rema Rules 

Numeric  The default status is ignored. 

 If several statuses with the same status and limit value condition are set, then 
only the first status and its status text are exported. 

 Only statuses with a value that is equal to a limit value are exported (limit 
value condition). 

 The limit value conditions greater than, less than, as desired and 

range are ignored. 

Multi numeric  Correspond to the rules for numeric. 

 Substatuses are also ignored. 

Binary  

 

 Only statuses that have value bits set consistently from right to left in the bit 
mask (0 or 1) are set.  
For example: 
........ ....10.. 1 
........ .....100 . 
........ .....100 1 
The following are ignored, for example 
........ ........ 1 
........ ......00 1 
........ .10..100 1 

Multi binary  Correspond to the rules for Binary. 

 In addition, substatuses and statuses are also ignored with edge definitions in 
the bit mask. 

String   Are completely ignored and not exported. 

IMPORT OF VARIABLE INFORMATION FROM ZENON 

The following properties in the zenon  Analyzer variable properties group provide information for 
reports in the zenon Analyzer: 

 Display name: Entry of a display name of the variable in zenon Analyzer. This must be unique in 
the project. The check is not carried out when issued in zenon, but when imported into zenon 
Analyzer. If this property is changed after the first export to a zenon Analyzer, these changes are 
not applied in the zenon Analyzer. 

 Meaning: Entry of the (Meaning) of a variable in the zenon Analyzer. Entry is manual or by means 
of the Meaning and Waterfall Chart Wizard. Several meanings are separated by a comma. 
Syntax:[Meaning1],[Meaning2],…,[MeaningN] 

 Parameters for waterfall diagram: Parameters of a variable for a waterfall diagram in zenon 
Analyzer. Entry is manual or by means of the Meaning and Waterfall Chart Wizard. The 
individual parameters are separated by a comma. Several waterfalls are divided by a semicolon. 
Syntax: [model name],[row index],[index in row],[color code];  
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Visual name 

The wizard reads the Analyzer/Display name property when loading the zenon workspace from zenon 
7.20 and displays this for each variable in the Variables (on page 60) tab. The following applies for visual 
names: 

 The name must be unique for each project. 

 Names in a project that appear several tines are highlighted in red. 

 The Display name are entered when writing the data to the metadata database. 

 In the event of duplicated name within a project, the Display name is only entered for the first 
variable found. For the second variable, the Name of the variables is entered in zenon. 

 The Display name is only set when the variable is exported for the first time. If this is 
subsequently changed in the Editor, this change is no longer applied in the metadata database. 
Changes are of course applied to a new metadata database when exporting to a new database. 

 With a version of zenon before 7.20, the visual name is always taken from the zenon 
Identification property. 

 

Meaning 

From zenon 7.20, the wizard reads the Analyzer/Meaning property and displays this for each variable in 
the Variables (on page 60) tab.  
The following applies for meanings: 

 If there are entries for Meaning, the corresponding entries in the Resources label are ignored. 

 If there are no entries, corresponding entries from the Resources label are accepted. 

 The identification ME= is no longer necessary but can continue to be used. If a variable is 
assigned several meanings, a comma is used as a separator. 

 With a version of zenon before 7.20, the meaning is always taken from the zenon Resources label 
property. 

 

Efficiency classes 

Selection and configuration of the efficiency classes to be exported. In doing so, zenon reaction matrices 
(REMAs) are displayed, the status of which correspond to the rules of the efficiency class structure. Only 
reaction matrices that meet certain conditions are read. 
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ZENON REACTION MATRIX REQUIREMENTS 

In order for a reaction matrix to be read as an efficiency class, it must meet the following conditions: 

 Numeric or multi-numeric type 

 Status configured correctly 

 Limit value text present 

STATUS CONFIGURATION 

The statuses to be configured must meet the following conditions: 

 The first status is less than a defined value. The area is open downwards. 

Status n1: <x 

 The last status is greater than the last value defined beforehand. This area is open upwards. 

Status n4: >z 

 Fixed ranges are defined between the first and last value. These areas must follow one another 
exactly. 

Status n2: x-y 

Status n3: y-z 

CONFIGURATION IN THE WIZARD 

To select efficiency classes for export: 

1. Select the desired efficiency classes. 

2. Configure the normalization. 
Attention: The None value is reserved for a subsequent expansion stage and must not be 
selected. 
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All pre-existing efficiency classes in the metadata database are deleted during export if they 
have been  created by the wizard. However, efficiency classes that come from the Metadata 

Editor are retained. All selected efficiency classes are then written to the metadata database. 

 

Parameter Description 

Efficiency Class Name Selection of the efficiency class to be exported by means of  
Activation of checkbox in front of the name. 

Normalisation Selection of the normalization from a drop-down list. 

 Minimum: 1 minute 

 Maximum: 1 year 

Default: 15 minutes 

Attention: None must not be selected. This value is reserved for 
a subsequent expansion level and leads to invalid 
configurations. 
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  Attention 

Reaction matrices are identified in zenon by means of their name. If the name of a 
reaction matrix is amended in zenon, the attendant efficiency class is recreated during 
export and the previous efficiency class is deleted. 

 
 

Finish 

To export the configured data: 

1. In the Finish tab, click on the Export button. 

 

2. the export is started 
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3. The exported elements are shown in the output window with the attendant success and error 
messages  
In addition, the number of objects that have been added, replaced or deleted, and the number 
of errors that occurred are shown. 

 

4. Click the Close button to close the wizard 

RECONFIGURING THE WIZARD 

To reconfigure the wizard: 

1. Open the Settings (on page 74) tab. 

2. Click on the Load data button. 

3. Configure the tabs. 
 

Close wizard 

To close the wizard: 

 Click on the Cancel button . 

 A dialog prompts whether the configuration should be saved. 
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 Yes: Writes the settings set in the Settings (on page 74) tab to the registry and closes the 
wizard. The wizard is opened with this configuration the next time it is started. The 
configuration is saved for each specific user. 

 No: Closes the wizard without saving the configuration 
 

3.1.4 Export Wizard for Analyzer 3.10 and 3.20 

The zenon Export Wizard for Analyzer 3.10 and 3.20 supports the export of metadata from zenon from 
version 7.20 SP0 for the zenon Analyzer 3.10 and 3.20. 

The following can be exported: 

 Data from the global project 

 Equipment models 

 Alarm/event classes 

 Alarm/event groups 

 Users 

 Data from selected projects: 

 Archives 

 Variables, with: 

- Display name (see visual names (on page 129) section) 

- Meaning (see meaning (on page 129) section) 

- Parameters for waterfall diagram (see Waterfall chart (on page 102) section) 

 Sankeydiagrams (see Sankey diagrams (on page 101) section) 

 Efficiency classes (on page 129) 
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 Shift calendar (on page 103) 

 

Note: The wizard is only available in English. 

COMPATIBILITY: 

The  Analyzer Export Wizard works, depending on the version, with different zenon Analyzer versions 
and different zenon versions. For details, read the Analyzer wizard compatibility chapter. 
 

Sankey diagrams 

The wizard automatically reads the definition for  Sankey diagrams from all activated projects (on page 

108) and the global project. These are in the zenon project folder \Files\Others.  
For this, the following applies: 

 Only valid XML files that were created for the zenon Analyzer are taken into account.  
Diagrams that have the Analyzer  and Valid attributes set to True in the Sankey XML file are 
valid. All other Sankey diagrams are ignored and not loaded. 

 All Sankey diagram definitions are written to the zenon Analyzer metadata database in the 
SANKEY_DIAGRAMM, SANKEY_OBJECT and SANKEY_VARIABLE tables. 
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 Diagrams deleted in zenon (XML files) are not deleted in the Analyzer. Diagrams can only be 
deleted in the database directly in zenon Analyzer. 

 For the adding or updating of diagrams, the following must apply to all required zenon variables: 

 Be selected via the Variables (on page 125) tab  
or 

 already be in the database 

If variables that are required for the Sankey diagram are not selected for export, the Sankey 
diagram is not exported. 

 If the Sankey diagram already exists, the metadata database tables are updated according to the 
changes. 

 Clicking on the Export button in the Finish tab starts the export of the Sankey diagrams from 
zenon in to zenon Analyzer.  
The diagrams are only exported once all other data such as projects or variables have been 
exported. The success of the export is shown in the message list of the Finish tab. 

  Attention 

The import of Sankey diagrams is carried out automatically in the background. There are 
no user interface or configuration options available. 

 
 

Waterfall chart 

A waterfall diagram can be used for either line-based reports or for machine-based reports. The 
parameters for the diagram are stored in the Analyzer/Parameters for waterfall diagram variable 
property from zenon 7.20. These can be entered manually or created with the Meaning and Waterfall 

Chart Wizard (on page 134). 

EXPORT 

The wizard reads the Parameters for waterfall diagram property when loading the zenon workspace. If 
there are correct entries, these these are exported in the background and written to the database of the 
zenon Analyzer. 

STRUCTURE OF THE ENTRIES 

Depending on the structure of the entries, a decision is made on whether it is entries for machine-based 
or line-based diagrams. 

 Machine based: Structure with 4 digits, separated by a comma; ended with a semicolon. 
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Syntax: [model name],[line index],[column index],[color code code]; 
Example: MyWaterfall,4,2,#80FF00; 

 Line-based: Structure with 7 digits, separated by a comma; ended with a semicolon. 

Syntax: [model name],[line index],[column index],[color code],[loss of auxiliary machine],[add 

loss of auxiliary machine],[subtract loss of auxiliary machine]; 
Example: MyLineAnlaysis,4,2, #80FF00,0,0,0; 

RULES FOR READING: 

The following is applicable for reading: 

 If there are entries for Parameters for waterfall diagram, corresponding entries in the Resources 

label field are ignored. 
The structure decides whether the entry can be evaluated as machine-based or line-based. 

 The identification WF= is not necessary but can to be used. The individual elements of a model 
are separated by a comma. If several waterfall models are assigned to a variable, a semicolon is 
used as a separator. 

 If there are no entries, corresponding entries from the Resources label are accepted. The 
identification WF= must be prefixed here. 

 With versions of zenon before 7.20, the waterfall parameters are taken from the zenon 
Resources label property. 

 

Export shift calendar 

The wizard automatically searches in all activated projects (on page 74) for SQL export shift calendar  
functions and reads out information to linked equipment groups. 
In doing so, the following applies: 

 A search is carried out in all available zenon projects. 

 Assigned equipment groups are created in the EquipmentShift table. 

 If the function has not been assigned to an equipment group, all equipment groups are created. 

 Only data from projects and equipment groups that have been selected in the wizard settings 
are exported. 

Reading and exporting is carried out in the background. 
 

Install and call up wizard 

The wizard is automatically installed with zenon for each supported version of zenon Analyzer. 
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STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 
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3. Select the Export Wizard for Analyzer 3.10 and 3.20. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
 

Start window 

When the wizard is opened, you receive an overview page that lists all exportable objects. 
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The individual objects are configured for the export on individual tabs. 

 

Click on the button with the arrow to navigate through the configuration (on page 106) of the export. 
 

Configuration 

When exporting with the Analyzer Export Wizard, all modules available for export are offered for 
detailed configuration. Only the selected data is exported. Sankey diagrams (on page 101) and 
equipment models for the shift calendar (on page 103) are exported without a configuration possibility 
in the background. You get to the next level by clicking on the button with the right arrow. You can also 
select individual tabs directly by clicking on the title of the tab. Entries already present in the database 
are preselected in the individual areas. 

The following tabs are available for configuration of the export: 

 Settings (on page 108): Options for the export of metadata 

 Equipment models (on page 113):  (on page 47)Export of the equipment groups from the 
global project 

 Event classes (on page 115): Alarm/Event classes from global project 

 Event groups (on page 117): Alarm/event groups from global project 

 Users (on page 119): User from global project 

H_30448
H_30448
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 Projects (on page 120): Projects from workspace 

 Archives (on page 123): Archives of the selected projects 

 Variables (on page 125): Variables of the selected projects 

 Efficiency classes (on page 129): Display of the efficiency classes to be exported. 

 Finish (on page 132): Start of the export and output of the result 

 

 
 

Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 

 



Topics 

 

 

108 

 

 

Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Export Exports the data to the Analyzer database. 

Is only active if the Finish tab is opened. 

Cancel Closes the wizard without exporting. 

When closing, a dialog asks if the configuration is to be saved 

 Yes: Writes the settings set in the Settings (on page 43) tab to the 
registry and closes the wizard. The wizard is opened with this 
configuration the next time it is started. 

 No: Closes the wizard without saving the configuration 

The configuration is saved for each specific user. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
 

Settings 

In this tab: 

 You define the database to which the wizard connects 

 You define general options for exporting 
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 You start the data readout 
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SETTINGS 

Option Description 

Settings Information and hints about current export processes. 

DATABASE SETTINGS 

Option Description 

Database settings Connection settings to the Analyzer server. 

DB host Computer on which the database is located. 

DB name Name of the database. 

Authentication Type of authentication: 

 Windows Authentication: Windows login information is 
used. 

 SQL Server Authentication: Login with data from an SQL 
server user. 

User name Entry of the user name. 

Only for login with SQL Server Authentication.  

Display only for Windows Authentication. 

Password Entry of the password. 

Only for login with SQL Server Authentication.  

No input possible with Windows Authentication. 

Remember password Password is saved for next connection. 

Only for login with SQL Server Authentication.  

Inactive with Windows Authentication. 

PROJECTS 

Option Description 

Projects List of the available projects in the current zenon workspace. The 
checkbox shows whether the data of the project is used: 

 Active: Project is used. 
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Projects that are active in the memory are pre-selected. Inactive 
projects can be added by means of selection with a checkbox. 

OPTIONS 

Option Description 

Options General options for the export. 

Don't modify existing data in the 

Analyzer metadata database 
 Active: Only completely new entries from the workspace are 

written to the database. 
Note: If linkings from variables, archives etc. are changed or 
new ones are created, these are not transferred. If these are 
also transferred, the checkbox must be set to Inactive 

 Inactive: Entries in the database are also updated or deleted. 
New entries are created, amended entries are updated and 
deleted entries are removed. 
Exception: Projects and Sankey diagrams are not deleted. 

Update Visual names Only available if the Don't modify existing data in the Analyzer 

metadata database option has been deactivated. 

 Active: In zenon, amended display names are overwritten 
when exporting to the metadata database of zenon Analyzer. 

 Inactive: Amended display names are not changed in zenon 
Analyzer. 

Default: Inactive 
The setting is not saved. The checkbox is set to deactivated 
each time the wizard is started. 

Behavior: 

If the checkbox is activated, display names amended in zenon are 
also amended in zenon Analyzer for: 

 Equipment models 

 Event classes 

 Event groups  

 Projects 

 Archives 

 Variables 

The visual names for Users cannot be changed. These are recreated 
in the event of changes. 

Changes to display names are displayed in the individual lists. 

Example: 

Initial situation: 



Topics 

 

 

112 

 

 

 Display name in the zenon project: Z 

 Display name in the zenon Analyzer: A 

Action: 

 A = Z:  
nothing happens. 

 A <> Z:  
Z is applied if the name has not yet been issued in the metadata 
table. If Z is already present in the table, A remains unchanged 
and an error message is given. 

LOAD DATA 

Option Description 

Load Data Clicking on the button loads, depending on the Load every 

project of this workspace into the memory parameter - the data 
from the currently loaded project into the wizard. 

In doing so, a check is made to see if data is present in the 
Analyzer database. Pre-existing data is combined with the data 
from the workspace and loaded into the wizard. In the event 
of naming conflicts, a dialog to rectify the error is called up. 

If the loading of data has been successfully concluded, the 
export can be configured in the following tabs. 

RENAME OBJECT 

Objects must always be named the same in the Analyzer database and in zenon. If objects that are 
already present in the database are renamed in zenon, these changes can be accepted or rejected when 
the data is combined. Rejection of the changes leads to the wizard being closed, because only objects 
with identical names can be handled correctly. 



Topics 

 

 

113 

 

 

DIALOG FOR RENAMING 

In the event of conflicts in the naming of objects, a dialog for dealing with the error is opened: 

 

Option Description 

List of amended objects Contains all objects that were changed. Previous name and new name are 
displayed. 

Exception: Users are always recreated. 

Rename Renames all objects listed in the database, closes the dialog and stops 
reading in data. 

Cancel Leaves the previous name in the database, finishes reading in data and 
closes the wizard. 

 
 

Equipment models 

Configuration of the model group which should be exported from the global project. 

  Attention 

Each equipment group in zenon may only be assigned to one individual time model. 

If several time model groups are assigned, the Analyzer Wizard Export uses the first that 
it finds and exports this to the metadata of the Analyzer. Other time model groups are 
ignored. 
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Option Description 

Equipment models  Information and notes on exporting. 

Selection of equipment/medium Drop-down list to select a model that is offered in the Equipment 

models/media list for configuration. 

List of equipment models/media List field with the possibility to select equipment models and model 
groups or media. To select an entry, activate the check box in front 
of the entry. 

In the list field the name, as it is stored in the database, is always 
displayed in the individual nodes. If the name was changed, the 
original name from the zenon project is displayed in brackets. 

Equipment groups that were deleted in the global project are no 
longer displayed. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Clicking on the button selects all equipment groups 

Deselect all Clicking on the button deselects all equipment groups. 
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Event classes 

Configuration of the alarm/event classes which should be exported from the global project. 
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Option Description 

Event classes Information and notes on exporting. 

List of the alarm/event classes List field with the possibility to select the alarm/event classes. To 
select an entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Event groups 

Configuration of the alarm/event groups which should be exported from the global project. 
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Option Description 

Event groups Information and notes on exporting. 

List of the alarm/event groups List field in which you can select alarm/event groups. To select an 
entry, activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

Alarm/event classes that were deleted in the global project are no 
longer displayed here. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Users 

Configuration of the user which should be exported from the global project. 
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Option Description 

Users Information and notes on exporting. 

User List  List field with selection possibility for users. To select an entry, 
activate the check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
objects in the database are deleted or updated. 

If a user was renamed in zenon they are considered new and 
recreated in the project. The previous user is deleted. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

 
 

Projects 

Configuration of the local projects which should be exported. The names for Server 1 and Server 2 can be 
changed here. 

To change the name of a Server or Standby Server: 

1. Highlight the project in the list of projects. 

2. Enter the desired name for Server 1 and Server 2. 
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Note: Changes here are only possible if, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option has been deactivated. The information that is displayed for the server 
depends on the settings in the project and the database. For details, see the Display of server settings 
section. 
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Option Description 

Projects Information and notes on exporting. 

Project list List field with selection possibility for projects. To select an entry, activate the 
check box in front of the entry. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for 
all selected lines. 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Server 1 Address of the Server 1 for the project selected in the list window.  
Source (project or database) depending on configuration. 

Server 2 Adress of the Server 2 for the project selected in the list window. 
Source (project or database) depending on configuration. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

DISPLAY OF SERVER SETTINGS 

The following is applicable for the display and configuration of the server in this tab: 

 In the zenon project, the Network active property is activated: 
Server 1 and Server 2 from the project are displayed. 

 In the zenon project, the Network active property is deactivated: 
Server 1 and Server 2 from the database are displayed. 

 In the zenon project, the Network active property is deactivated and there are no entries present 
for the server in the database: 
Empty entries are displayed for Server 1 and Server 2. 

 



Topics 

 

 

123 

 

 

Archives 

Selection of the archive from the selected projects (on page 120). Only base archives are displayed. 
Aggregated archives are not displayed in the list, but are also selected with the base archives and 
written to the database. 
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Option Description 

Archives Information and notes on exporting. 

Archive list  List field with possibility to select for archives. To select an entry, activate the 
check box in front of the entry. 

 Name (Analyzer): Name of the archive in zenon Analyzer. 

 Name (Project): Name of the archive in the project. 

 Archive ID (Project): ID of the archive in the project. 

 Project: Project from which the archive comes. 

 Description: Individual description of the project. 

Sorting: Clicking on the column identifier sorts the entries after this column 
upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection applies for all 
selected lines. 

If, in the Settings tab, the Don't modify existing data in the Analyzer 

metadata database option is deselected, amended objects in the database are 
deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 
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Variables 

Configuration of the variables to be exported from the selected local projects (on page 120). When 
selecting variables, the entries offered can be prefiltered. 
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Option Description 

Variables Information and notes on exporting. 

 

Display Selection of which variables are displayed, via the following option 
fields: 

 All: All variables are displayed. 

 Selected: Only variables that have already been selected are 
displayed. 

 Unselected: Only variables that have not yet been selected are 
displayed. 

Variable filter Selection of the variable filter using the following option fields: 

 All: All variables are displayed. 

 Archives: Only archive variables are displayed. 

 Equipment groups: Only variables are displayed which are 
part of the selected Equipment model (on page 113). 

Filter row Input of alphanumerical characters according to which the List of 

variables is to be filtered. 

Attention: The filter makes a distinction between upper-case and 
lower-case letters (it is case sensitive). 

List of variables List field with possibility to select variables. To select an entry, 
activate the check box in front of the entry. 

The following are displayed: 

 Name (Analyzer): Name in zenon Analyzer. 

 Name (Workspace): Can be issued from zenon 7.20 in the 
Editor by means of the Display name property. Must be 
unique in the project. See also chapter Visual name (on page 
129) 

 Meanings: Can be issued from zenon 7.20 in the Editor by 
means of the Meaning property. See also chapter Meaning 
(on page 129) 

 Project: Project from which the variable comes. 

 Identification: It corresponds to the Identification property 
in zenon. 

Sorting: Clicking on the column identifier sorts the entries after 
this column upwards or downwards. 

Multiple selection: If several lines are highlighted, the selection 
applies for all selected lines. 

If, in the Settings tab, the Don't modify existing data in the 

Analyzer metadata database option is deselected, amended 
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objects in the database are deleted or updated. 

Select all Selects all entries in the list and activates the checkboxes. 

Deselect all Selects all entries in the list and deactivates the check boxes. 

RULES FOR THE EXPORT OF VARIABLES WITH REACTION MATRICES 

If linked variables are exported with reaction matrices, the limit value text, the limit value color and the 
status value of the reaction matrix statuses are also exported to the STATUSNAME table in the 
metadata database of the Analyzer. Because only certain states can be evaluated in the reports, they 
must be pre-sorted using the wizard. 

The following statuses of the reaction matrices can be exported or excluded: 
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Rema Rules 

Numeric  The default status is ignored. 

 If several statuses with the same status and limit value condition are set, then 
only the first status and its status text are exported. 

 Only statuses with a value that is equal to a limit value are exported (limit 
value condition). 

 The limit value conditions greater than, less than, as desired and 

range are ignored. 

Multi numeric  Correspond to the rules for numeric. 

 Substatuses are also ignored. 

Binary  

 

 Only statuses that have value bits set consistently from right to left in the bit 
mask (0 or 1) are set.  
For example: 
........ ....10.. 1 
........ .....100 . 
........ .....100 1 
The following are ignored, for example 
........ ........ 1 
........ ......00 1 
........ .10..100 1 

Multi binary  Correspond to the rules for Binary. 

 In addition, substatuses and statuses are also ignored with edge definitions in 
the bit mask. 

String   Are completely ignored and not exported. 

IMPORT OF VARIABLE INFORMATION FROM ZENON 

The following properties in the zenon  Analyzer variable properties group provide information for 
reports in the zenon Analyzer: 

 Display name: Entry of a display name of the variable in zenon Analyzer. This must be unique in 
the project. The check is not carried out when issued in zenon, but when imported into zenon 
Analyzer. If this property is changed after the first export to a zenon Analyzer, these changes are 
not applied in the zenon Analyzer. 

 Meaning: Entry of the (Meaning) of a variable in the zenon Analyzer. Entry is manual or by means 
of the Meaning and Waterfall Chart Wizard. Several meanings are separated by a comma. 
Syntax:[Meaning1],[Meaning2],…,[MeaningN] 

 Parameters for waterfall diagram: Parameters of a variable for a waterfall diagram in zenon 
Analyzer. Entry is manual or by means of the Meaning and Waterfall Chart Wizard. The 
individual parameters are separated by a comma. Several waterfalls are divided by a semicolon. 
Syntax: [model name],[row index],[index in row],[color code];  
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Visual name 

The wizard reads the Analyzer/Display name property when loading the zenon workspace from zenon 
7.20 and displays this for each variable in the Variables (on page 125) tab. The following applies for 
visual names: 

 The name must be unique for each project. 

 Names in a project that appear several tines are highlighted in red. 

 The Display name are entered when writing the data to the metadata database. 

 In the event of duplicated name within a project, the Display name is only entered for the first 
variable found. For the second variable, the Name of the variables is entered in zenon. 

 The Display name is only set when the variable is exported for the first time. If this is 
subsequently changed in the Editor, this change is no longer applied in the metadata database. 
Changes are of course applied to a new metadata database when exporting to a new database. 

 With a version of zenon before 7.20, the visual name is always taken from the zenon 
Identification property. 

 

Meaning 

From zenon 7.20, the wizard reads the Analyzer/Meaning property and displays this for each variable in 
the Variables (on page 125) tab.  
The following applies for meanings: 

 If there are entries for Meaning, the corresponding entries in the Resources label are ignored. 

 If there are no entries, corresponding entries from the Resources label are accepted. 

 The identification ME= is no longer necessary but can continue to be used. If a variable is 
assigned several meanings, a comma is used as a separator. 

 With a version of zenon before 7.20, the meaning is always taken from the zenon Resources label 
property. 

 

Efficiency classes 

Selection and configuration of the efficiency classes to be exported. In doing so, zenon reaction matrices 
(REMAs) are displayed, the status of which correspond to the rules of the efficiency class structure. Only 
reaction matrices that meet certain conditions are read. 
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ZENON REACTION MATRIX REQUIREMENTS 

In order for a reaction matrix to be read as an efficiency class, it must meet the following conditions: 

 Numeric or multi-numeric type 

 Status configured correctly 

 Limit value text present 

STATUS CONFIGURATION 

The statuses to be configured must meet the following conditions: 

 The first status is less than a defined value. The area is open downwards. 

Status n1: <x 

 The last status is greater than the last value defined beforehand. This area is open upwards. 

Status n4: >z 

 Fixed ranges are defined between the first and last value. These areas must follow one another 
exactly. 

Status n2: x-y 

Status n3: y-z 

CONFIGURATION IN THE WIZARD 

To select efficiency classes for export: 

1. Select the desired efficiency classes. 

2. Configure the normalization. 
Attention: The None value is reserved for a subsequent expansion stage and must not be 
selected. 
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All pre-existing efficiency classes in the metadata database are deleted during export if they 
have been  created by the wizard. However, efficiency classes that come from the Metadata 

Editor are retained. All selected efficiency classes are then written to the metadata database. 

 

Option Description 

Efficiency Class Name Selection of the efficiency class to be exported by means of  
Activation of checkbox in front of the name. 

Normalisation Selection of the normalization from a drop-down list. 

 Minimum: 1 minute 

 Maximum: 1 year 

Default: 15 minutes 

Attention: None must not be selected. This value is reserved for 
a subsequent expansion level and leads to invalid 
configurations. 
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  Attention 

Reaction matrices are identified in zenon by means of their name. If the name of a 
reaction matrix is amended in zenon, the attendant efficiency class is recreated during 
export and the previous efficiency class is deleted. 

 
 

Finish 

To export the configured data: 

1. In the Finish tab, click on the Export button. 

 

2. the export is started 
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3. The exported elements are shown in the output window with the attendant success and error 
messages  
In addition, the number of objects that have been added, replaced or deleted, and the number 
of errors that occurred are shown. 

 

4. Click the Close button to close the wizard 

RECONFIGURING THE WIZARD 

To reconfigure the wizard: 

1. Open the Settings (on page 108) tab. 

2. Click on the Load data button. 

3. Configure the tabs. 
 

Close wizard 

To close the wizard: 

 Click on the Cancel button . 

 A dialog prompts whether the configuration should be saved. 
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 Yes: Writes the settings set in the Settings (on page 108) tab to the registry and closes the 
wizard. The wizard is opened with this configuration the next time it is started. The 
configuration is saved for each specific user. 

 No: Closes the wizard without saving the configuration 
 

3.1.5 Meaning and Waterfall Chart Wizard 

The Meaning and Waterfall Chart Wizard helps you prepare a zenon project for the processing of 
variable information in the zenon Analyzer. 

Note: The wizard is only available in English. 

  Attention 

If the Meaning and Waterfall Chart Wizard is used with a project with distributed 
engineering (Multi-User), then Enable changes must be activated in the zenon 
Editor for: 

 The project (context menu of the project) 

 The variables (context menu of the variables or the Variables module) 

Otherwise the changes made by the Meaning and Waterfall Chart Wizard cannot be 
applied. These are then discarded. 

The Meaning and Waterfall Chart Wizard helps you, when engineering projects in zenon, to configure: 

 Meanings (Meaning) 

 Waterfall Charts charts for machine-based reports and line-based reports. 

The wizard writes the configuration in the corresponding properties of the variables selected in the 
wizard. The target properties depend on the version of zenon that is used. 

  Attention 

Only equipment models from the global project are available. 

FROM ZENON 7.20 

 Meanings: 

The Meanings are written in the Analyzer/Meaning property. Several entries are separated by a 
comma (,). 

 Waterfall: 
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The parameters for waterfall diagrams are written in the Analyzer/Parameters for waterfall 

diagram property. The parameters for a diagram are separated by a comma (,). Several diagrams 
are separated by a semi colon (;) 

 Syntax machine-based: [model name],[line index],[column index],[color code code]; 

 Syntax line-based: [model name],[line index],[column index],[color code],[loss of auxiliary 

machine],[add loss of auxiliary machine],[subtract loss of auxiliary machine]; 

The following applies for both properties: If there are still entries in the General/Resources label property 
from previous versions of  zenon, these are deleted and entered in the corresponding properties for 
zenon 7.20. 

UP TO ZENON 7.11: 

Meanings and parameters for waterfall diagrams are written to the Resources label variable property. In 
doing so, the prefix WF= is added for meanings and the prefix WF= is added for waterfall parameters. 

For further information, see the Analyzer Wizards chapter. 
 

Install and call up wizard 

The wizard is automatically installed together with zenon. 

STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 
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The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 

3. Select the Meaning and Waterfall Chart Wizard. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
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Start window 

When opening the wizard, you receive an overview that lists and explains all objects that can be 
configured. Configuration starts with the Settings (on page 140) tab. 

 

MEANING 

zenon variables often receive technically-orientated names in the project. This naming is often not 
meaningful enough for display in a zenon Analyzer report. The variables can be given an unique name 
for display in the zenon Analyzer report. This name is saved to the corresponding variable property 
depending on the zenon version. Target property and entry are automatically selected by the wizard. 

After import into zenon Analyzer, this name is used for reports without the existing variable name 
needing to be changed. For details, see the Analyzer Wizards chapter in the online help. 

WATERFALL CHART 

Some zenon Analyzer reports can display a waterfall diagram using zenon variables. To do this, 
information on the appearance of the diagram must already be present in the resource label of the 
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selected variable. The structure and appearance of a waterfall diagram for machine-based reports or 
line-based reports can be defined with a wizard. The waterfall information is saved to the corresponding 
variable property depending on the zenon version. Target property and entry are automatically selected 
by the wizard. For details, see the Analyzer Wizards chapter in the online help. 

NAVIGATION 

Click on the button with the arrow to navigate (on page 139) through the configuration (on page 138) of 
the export. 
 

Configuration 

The Meaning and Waterfall Chart Wizard is configured with the following tabs: 

 Settings (on page 140): Loading the data from the projects.  
Only once the data to be loaded is selected are other tabs available for meanings or waterfall 
diagrams. 

 Meaning filter (on page 142): Filter settings for meanings. 

 Meaning (on page 144): Selection and assignment of the meanings. 

 Waterfall filter: Filter settings for machine-based waterfall diagram (on page 148) or line-based 
waterfall diagram (on page 152). 

 Waterfall charts: Selection of variables and configuration of  machine-based waterfall diagram 
(on page 150) or line-based waterfall diagram (on page 154). 

 Finish (on page 159): Acceptance of configuration and configuration by the wizard. 
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The tabs that can be shown depend on the configuration of the Settings (on page 140) tab. 

 

 
 

Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 

 

Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Finish Writes all changes to the zenon variable in the Editor and closes the 
wizard. 

Cancel Ends the wizard without making changes. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
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Settings 

Selection and loading of the tabs to be configured. 
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Option Description 

Settings Setting for which tabs are to be loaded. 

Load every project of this 

workspace into the memory 
 Active: When loading, projects from the workspaces that are not 

in the memory are also taken into account. Once the wizard has 
been ended or once the Finish action has been executed, these 
are removed. 

Define Meanings   Active: The Meaning filter (on page 142) and Meaning (on 
page 144) tabs are loaded. 

Define Waterfall Chart Selection of waterfall chart: 

 Active: A waterfall chart is created. 

Selection of the waterfall type by means of the radio button: 

 Machine: A machine-based waterfall chart is created. The 
Waterfall filter (on page 148) und Waterfall (on page 150) tabs 
are loaded. 

 Line: A line-based waterfall chart is created. The Line Analysis 

filter (on page 152) and Line Analysis (on page 154) tabs are 
loaded. 

Load data Clicking on the button searches through the variables of all projects 
loaded in the workspace and loads the required information for the 
filter and editing the variables. The corresponding tabs are displayed in 
the wizard. 

A progress bar is displayed during the loading process. 

After loading, the tabs are available for the selected data, for configuration. 



Topics 

 

 

142 

 

 

 

 
 

Meanings 

Configuration of the meanings using the Meaning filter and Meaning tabs. 
 

Meaning filter 

The variables to be edited are pre-filtered with this tab. If an object is not selected in any group, all 
variables are available in the Meaning (on page 144)  tab. 

  Attention 

Only equipment models from the global project are available. 
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Option Description 

List of equipment groups Filtering for individual models by activating the respective checkboxes. 

No selection: Variables of all equipment models are selected. 

List of projects Filtering for individual checkboxes by activating the respective 
checkboxes. 

No selection: Variables of all projects are selected. 

List of archives Filtering for individual archives by activating the respective checkboxes. 

No selection: Variables of all archives are selected. 
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Meaning 

The meanings of the variables are edited in this tab. Variables can be selected and given new meanings, 
and existing meanings can be removed. 
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VARIABLE SELECTION 

Option Description 

Search meaning  Input of a search term lists all variables with their corresponding 
meanings. 

The list is immediately updated with the entry of a character. 
Placeholders cannot be used. 

List Variablen List of the variables available after filtering. 

Selection of variables for editing: Activation of the checkbox 
before the variables. 

Existing meanings of the variables are shown in the Meanings 
column. In doing so, only meanings are displayed. Other entries or 
entries for the waterfall chart are hidden or ignored when editing. 

The variables can be sorted by clicking on a column label. 

Select all  Clicking this selects all variables for editing. 

Deselect all Clicking this deselects all variables. 

Display statistics Display how many variables: 

 Are present in the list 

 Have been selected 

 Have been changed 

Reset  Resets all changes that have been made by clicking on Update 

meaning. 

Note: Changes are only accepted finally after clicking on Finish. 

ADD MEANINGS 

Option Description 

Add new meanings  Allows meanings to be added to variables. 

New meanings are entered in the input field, added to the list and 
assigned to the selected variables using the Update meaning button. 

Eingabefeld Entry of a new meaning. 

Maximum length: 50 characters 

Liste Meanings Lists all meanings that have been created. 

Add to list Adds entry from text field to the list of meanings. 

Remove from list  Deletes selected entry from the list of Meanings. 

Remove all Deletes all entries from the list of Meanings. 
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Update meaning Clicking this assigns a new meaning to all entries in the list ofMeanings. 
The meanings to be added are displayed in the Meanings (preview) 
column; the row with the variables has a green background. 

REMOVE MEANINGS 

Option Description 

Remove existing meanings  Allows meanings to be removed from variables. 

If a variable is selected, all assigned meanings are displayed in the list of 

Meanings. Meanings that are to be retained are deleted from the list by 
clicking on the Remove from list button. Clicking on the Update 

meaning button removes the meanings from the selected variables. 

List Meanings Lists all of the meanings assigned to the selected variables. 

Remove from list  Deletes selected entry from the list of Meanings. 

Remove all Deletes all entries from the list of Meanings. 

Update meaning Clicking this removes all entries in the list of Meanings from the 
selected variables. The row with the variables has a red background. 

Attention: Changes and new entries are only written to the zenon variable once the Finish action in the 
Finish tab has been executed. 
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EXAMPLE OF COLOR IDENTIFICATION 

 

 Red: All Meanings of the variable have been deleted. 

 Green: Variable has received a new  Meaning. 
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Machine 

Configuration of a waterfall model for machine-based reports using the Waterfall chart filter and 
Waterfall chart tabs. 

 
 

Waterfall chart filter 

You define the machine-based waterfall diagram in this tab. To do this, all variables must be assigned to 
the same equipment group. If variables from an archive are used, the archive and the variables must be 
assigned to the same equipment group. 

  Attention 

Only equipment models from the global project are available. 
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Option Description 

List of equipment groups Selection of an equipment group. 

List of projects Selection of a project. 

List of archives Select an archive. 

An equipment group and a project must be selected. As a option, it is also possible to select an archive 
from the appropriate equipment group. 

No variables can be displayed in the Waterfall (on page 150) tab: 

 No project was selected 

 No equipment group was selected 

 Objects were selected that are not assigned to the same equipment group 
 



Topics 

 

 

150 

 

 

Waterfall chart 

Waterfall definitions can be created and edited on this tab: 

 

Option Description 

New Active: A new waterfall definition is created. 

Update Active: An existing waterfall definition is edited. Select from drop-down list. 

Chart Entry of a name for a new waterfall definition. 

Save Clicking on the button saves the entries. 

Note: All changes are only written to the zenon variable once the 
Finish action in the Finish tab has been executed. 

Variablenliste Lists all variables that correspond to the configuration on the Waterfall filter 
(on page 148) tab. Bool and String variables are not displayed. 

The list can also be sorted by clicking on the column heading. Existing waterfall 
definitions are displayed in the Waterfalls column. New or amended waterfall 
definitions are displayed in the Waterfalls (preview) column. 

Chart Waterfall definitions can be created or amended here by dragging & dropping. 

Note: All changes are only written to the zenon variable once the Finish action in the Finish tab has 
been executed. 
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CREATING A WATERFALL DEFINITION 

To create a new waterfall definition: 

1. Select New. 

2. Move the desired variable by drag&drop in sequence in the Chart area 

3. Arrange the bar according to the rules 

4. Enter a name in the Chart input field 

5. Click on Save. 

6. The configuration is saved in the Waterfalls (preview) column 

7. Switch to tab Finish. 

8. Click on Finish. 
 

Line 

Configuration of a waterfall model for line-based reports using the Waterfall chart filter and Waterfall 

chart tabs. 
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Waterfall chart filter 

You define the line-based waterfall diagram in this tab. To do this, all variables and archives must be 
assigned to the same equipment group. 

  Attention 

Only equipment models from the global project are available. 
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Parameter Description 

Main machine Configuration of the main machine. 

Equipment List of the existing equipment models. 

Selection of a model by activating the checkbox. The selection defines the 
archives that can be used. 
Only one model can be selected. 

Project Existing projects.  
The list of archives can be filtered using the selection of projects. The 
selection is optional. 

Archive List of existing archives. 

Selection of an archive by activating the checkbox.  
Only one archive can be selected. 

Side machines Configuration of the auxiliary machines 

Equipment List of the existing equipment models. 

Selection of a model by activating the checkbox. The selection defines the 
archives that can be used. 
As many models as desired can be selected. 

Project Existing projects.  
The list of archives can be filtered using the selection of projects. The 
selection is optional. 

Archive List of existing archives. 

Selection of an archive by activating the checkbox.  
As many archives as you want can be selected. 

RULES 

The following is applicable for the selection of the main machine: 

 Precisely one equipment group must be selected. 

 The archive selection can be prefiltered using the Project filter.  
Only one project can be selected. 

 Precisely one archive can be selected. 

The following is applicable for the selection of the auxiliary machines: 

 Several equipment groups can be selected. However these must be from the same level as the 
main machine. 

 If an equipment group has been selected for the main machine, only equipment groups at the 
same level as the main machine can be selected for the auxiliary machines. The equipment 
group of the main machine is precluded in the process. 
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 The archive selection can be prefiltered using the Project filter.  
Several projects can be selected. 

 At least one archive must be selected. If a variable is already used in the archive of the main 
machine, it is not available for the auxiliary machine. 

  Attention 

In order for variables to be available for the diagram, they must always be linked to 
the same equipment group as the archive in which the variables are located. This 
applies to main machines and auxiliary machines. 

 

 
 

Waterfall chart 

Waterfall definitions can be created and edited on this tab: 

Note the rules for filtering on the Line Analysis filter tab: Precisely the same variable filter settings 
must be set for main and auxiliary machines. 
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Option Description 

New Active: A new waterfall definition is created. 

Update Active: An existing waterfall definition is edited. Select from drop-down list. 

Chart Entry of a name for a new waterfall definition. 

Save Clicking on the button saves the entries. 

Note: All changes are only written to the zenon variable once the 
Finish action in the Finish tab has been executed. 

Legend Key for the assignment of the variables: 

 Sub: Losses of auxiliary machines are subtracted from the main machine. 

 Add: Losses of auxiliary machines are added to the main machine. 

 SMa: Auxiliary machines . 

Variables main machine Lists all variables available for the main machine. 

The list can also be sorted by clicking on the column heading. 

Variables side machine Lists all the variables available for the auxiliary machines. 

The list can also be sorted by clicking on the column heading. 

Chart Waterfall definitions can be created or amended here by dragging & dropping. 

Note: All changes are only written to the zenon variable once the Finish action in the Finish tab has 
been executed. 

CREATING A WATERFALL DEFINITION 

To create a new waterfall definition: 

1. Select New. 

2. Move the desired variable by drag&drop in sequence in the Chart area 

3. Arrange the bar according to the rules 

4. Enter a name in the Chart input field 

5. Click on Save. 

The configuration is displayed in the list in the Waterfall def. preview (preview) column. 

6. Switch to tab Finish. 

7. Click on Finish. 

EDITING A WATERFALL DEFINITION 

To edit an existing waterfall definition: 
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1. Select Update. 

2. Select the desired definition from the drop-down list. 

The existing definition is displayed in the diagram field. 

3. Edit the definition. 

4. Click on Save. 

5. The configuration is displayed in the list in the Waterfall def. preview (preview) column. 

6. Switch to tab Finish. 

7. Click on Finish. 

RULES WHEN DRAWING THE DIAGRAM: 

When drawing, the following rules are applicable, in contrast to a machine-based diagram: 

Position Rule Definition Code 

Last line, first 
column 

Entries for main 
machines only. 

SUBTRACT_SIDE_MACHINE_LOSSES Sub 

n-column, 
last line and 
not 1st 
column. 

Main machine entries. 

 

 

Default:  
ADD_SIDE_MACHINE_LOSSES  = 0 

 

(none) 

  Alternative:  
Clicking on the cell with the right mouse button 
opens, after the dialog, a further dialog to select 
colors.  
Confirmation with Yes changes the definition to: 
 ADD_SIDE_MACHINE_LOSSES = 1 

Add 

n-column, 
last line and 
not 1st 
column. 

Auxiliary machine 
entries. 

LOSS_FROM_SIDE_MACHINE = 1 SMa 

DIALOG: ADD AUXILIARY MACHINE LOSSES 

Under the following conditions, after the color selection dialog has been closed, an additional dialog to 
add losses from auxiliary machines is displayed: 

 Click on the right mouse button in the diagram 

 On a variable of the main machine 

 In the last line 
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 From the second column 

 

Option Description 

Add side machine losses Query of whether losses from auxiliary machines are to be added. 

Yes The value for DD_SIDE_MACHINE_LOSSES is set to 1. The losses of the 

auxiliary machine are added. 

No The value for DD_SIDE_MACHINE_LOSSES is set to 0. The losses of the 

auxiliary machine are subtracted. 

Cancel The status remains as it was before the dialog was called up. 

 
 

General rules for waterfall diagrams 

The following rules apply when creating and editing waterfall definitions: 

1. For the first bar, the variable in the upper left corner of the character area must be dragged. 

2. The second bar can only be inserted below the first bar. 

3. All other bars can be inserted either below the existing bar or to the right of an existing bar. 

 The first row can only contain one bar. 

 If a bar is inserted to the right of an existing bar, the bar above this is extended. 

4. The selected variable is displayed in green. 

5. Each variable can only be used once. 

6. The bar contains an index: 

 First number: Row index 

 Second number: Column index 

7. The name of the selected variable is displayed in the tooltip of the bar. 

8. For line-based diagrams only: Variables of auxiliary machines can only be entered in the last line. 

Note: Note the rules for filtering (on page 152) and diagram design (on page 154) for line-based 
diagrams. 
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SAVING A WATERFALL DEFINITION 

To save a waterfall definition: 

1. Enter a name in the Chart input field 

2. Click on the Save button. 

3. The definition is saved in the variable list and the new entry is displayed in the Waterfall def. 

preview (preview) column 

4. The new waterfall definition is only written to the zenon variable after clicking on the  Finish 
button in the Finish tab. 

EDITING A WATERFALL DEFINITION 

To edit a new waterfall definition: 

1. Select Update. 

2. Select the desired waterfall definition from the drop-down list. 

Attention: Only definitions that correspond to the configuration in the Waterfall filter (on page 
148) tab are offered 

3. The waterfall definition is displayed in the Chart area 

4. Change the definition in accordance with the rules: 

 Adding a bar: Move the variable to the desired position: The variable is colored green. 

 Deleting a bar: Drag the bar to the deletion area. The variable is displayed again without a 
highlighting color. 

 Moving a bar: Move the bar to the desired location. 

 Changing the color: Assign the bar the desired color with a right-click. 

5. Click on Save. 

6. All changes are displayed in the list in the Waterfall def. preview (preview) column 

7. Switch to tab Finish. 

8. Click on Finish. 

DELETING A BAR 

Bars can be deleted if: 

 It is a short bar 

 There is no other bar below or to the right 

To delete a bar, drag & drop it to a free location outside the Chart field (but not in the variable list). 
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THE BAR IS DELETED. ALL OTHER BARS ARE MOVED ACCORDINGLY. MOVING THE BAR 

Bars can be moved if: 

 It is a short bar 

 The movement is within a row 

To move a bar, drag & drop it to the new position. All other bars between the old and the new position 
are moved by one place. 

CHANGING THE COLOR OF A BAR 

To change the color of a bar: 

1. Right-click on the bar 

2. The dialog to select the color opened: 

3. select the desired color 

4. Click on OK. 
 

Finish 

In this tab, the changes are written to the variables in zenon and the result is displayed in the output 
field. 
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Clicking on the 'Finish' button writes the changes to the zenon variable in the Editor. 

The changes made are displayed in the output field: 

 Update MEANINGS definition variable: Changes to the variables that are carried out and that 
concern the meanings. 

 Update WATERFALL definition variable: Changes to the variables that have been carried out and 
that concern the waterfall definition 

 Notes on new and deleted entries, warnings and error messages. 

When importing into zenon, the length of the entry is checked for the corresponding properties. 
This must not consist of more than 250 characters If the entry is longer, the sequence is cut off 
after the 250th character and an error message is written in the output field of the 'Finish' tab. 

 

3.1.6 Sankey Wizard 

A Sankey diagram is a graphic display of quantity flows. The quantities are displayed by arrows with a 
thickness proportional to the quantity. Sankey diagrams are important aids for the visualization of 
energy and material flows, as well as inefficiencies and potential for saving when using resources. 

The Sankey Wizard supports you when creating Sankey diagrams that you can see in zenon Runtime and 
in zenon Analyzer. 

The following scenarios are possible: 

 Create a new Sankey diagram. 

 Use a pre-existing Sankey diagram as a template. 

 Edit an existing Sankey diagram. 

 Delete an existing Sankey diagram. 

The Sankey diagram is saved in an XML file. 

Note: The wizard is only available in English. 
 

Installing the Sankey wizard 

The wizard is automatically installed together with zenon. 

 
 

Starting the Sankey Wizard 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 
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EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Navigate to the node Analyzer. 

3. Select the Sankey Wizard. 
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4. Click on OK. 

The wizard starts with the welcome page. 
 

Start window 

When opening the wizard, you receive an overview that lists and explains all objects that can be 
configured. Configuration starts with the Action tab. 

 

Click on the button with the arrow or on the title of the tab to navigate through the configuration of the 
export. 
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Sorting and filtering lists 

SORTING OF LISTS 

All lists in the Action and Variables tabs can be sorted. 

The sorting is alphabetical by default, which can however be inverted. 

To sort: 

1. Click on the corresponding header of the column according to which sorting is to take place. 

The list is displayed sorted according to this column. 

2. A further click inverts the sorting. 

FILTERING OF LISTS 

You can filter all lists in the Action and Variables tab according to certain criteria. Several filters can also 
be combined with one another. 

Note: To reset a filter, delete the filter text from the header. 

Engineering: 

1. Click in the desired list, with the left mouse button, in the input field for the corresponding filter 
symbol. 

2. Enter the term according to which filtering is to take place. 

3. Click on the corresponding filter symbol in the desired list with the left mouse button. 

The context menu is opened. 

4. Make your choice by clicking on the desired filter possibility with the left mouse button. 

The choices are: 

 No filter: no filter set 

 Contains: contains 

 Does not contain: does not contain 

 Starts with: starts with 

 Equals: is equal to 

 Not equal to: is not equal to 

The list is filtered according to your selection. 

Note: The filter is set to "Contains" by default. 
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Navigation 

Navigation through the tabs is carried out by means of the navigation bar in the lower area of the wizard 
window: 

 

Button Description 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process. 

Finish Writes all changes to the zenon variable in the Editor and closes the 
wizard. 

Cancel Ends the wizard without making changes. 

Individual tabs can also be selected by clicking directly on the title of the tab. 
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Action - select action 

Select, in the Action tab, the desired action by activating it. 

 

There are the following three possibilities: 

Option Description 

Create diagram Creates a new diagram. 

Use existing diagram as template Uses an existing diagram as a template. 

Note: In this case, variables must be linked to node 
connections again. The variable linkings of existing 
diagrams are not shown in the template. 

Edit or delete diagram Allows the editing or deletion of an existing diagram. 

The diagram to be edited or deleted can be selected 
from the list of the created diagrams. 
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SORTING AND FILTER POSSIBILITIES 

You can sort the list in the Action tab and filter according to certain criteria. You can find details on this 
in the Sort and filter lists (on page 163) chapter. 

LIST OF THE DIAGRAMS THAT HAVE BEEN CREATED 

The window in the middle shows a list with the diagrams that have already been created. The entries 
are grayed out if Create_Diagram has been selected. The following information for this is visible: 

Option Description 

Project Name of the project in which the diagram is saved 

Diagram Shows the name of the diagram. 

Description Shows the description of the diagram. 

Analyzer Active:  
The diagram can be used in the Analyzer and in 
Runtime. 

Inactive:  
The diagram can only be used in Runtime. 

Valid Active:  
The diagram is valid. 

Inactive:  
The diagram is not valid. You cannot use the 
diagram in either the Analyzer or in Runtime. 

Note: In this case, edit the diagram and amend it 
until it is valid. 

Delete Deletes the selected diagram. 

A dialog requesting confirmation is called up before 
the selected diagram is deleted. 

PROJECT SETTINGS 

You can change the following settings for the project in this area: 
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Option Description 

Name Enter a name for the project here. 

Note: The name must be unique. Otherwise a warning 
dialog will make you aware of this. A newly-created 
program with a name that already exists would replace 
the existing one if the warning dialog is confirmed. 
However if you click on No in the warning dialog, _1 is 
automatically added to the name. 

Save into project Here you select the project in which your diagram is to be 
saved. 

Description Enter a description here. 
Note: This is optional. 

Create diagram for Analyzer Active: Only variables that are in archives are 
shown. 
Note: The variables that you want to use must first 
be exported with the Analyzer Export Wizard. 

Inactive: Selection of the variables is possible 
without limitations, however the diagram cannot be 
used in zenon Analyzer, only in zenon Runtime. 

Note: Once this tab is left, it is no longer possible to edit the settings that have been made. 

DIALOG: DELETE DIAGRAM 

A dialog requesting confirmation is called up before the selected diagram is deleted. 

 

Option Description 

Ja Deletes the selected diagram. 

Nein The deletion process is canceled. The dialog is closed and 
the selected diagram is not deleted 
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Variables - select variables 

You can select variables for your project in this tab. 

 

SORTING AND FILTER POSSIBILITIES 

You can sort the lists in the Variables tab and filter according to certain criteria. You can find details on 
this in the Sort and filter lists (on page 163) chapter. 
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SELECT PROJECT 

Option Description 

Select project List of all active zenon projects. 

Select the project(s) from which you want to select 
variables for your diagram here. 

Note: Multiple selection is possible. 

SELECT DATA SOURCE 

Option Description 

Select data source Select the data source here (archives). 
Note: The Online Data option is available for all other 
variables that do not come from archives. This option can 
only be selected if you have not activated the create for 

Analyzer option in the Action tab. Live values, i.e. 
online values, are used for Runtime. Historical values are 
used for zenon Analyzer. 

 Short name 
Short identification of the archive 

 Long name 
Full name of the archive 

 Project 
Project name of the archive 

 Parent archive 
Version of the archive used 

VARIABLES 

Option Description 

Project variables Select the variables that you want to link to your 
diagram here. Multiple selection is possible. 

Possibilities for this: 

 Double-click on the desired variable. 

 Highlight the desired variable and then click 
on Add->. 

 Hold down the Ctrl key, highlight several 
variables, click on Add->. 

 Click on Add all-> to select all variables. 
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Variable list: 

 Name 

Variable name 

 Project 
Name of the project of the variable 

 Archive: 
Short identification of the archive 

 Aggregation: 
Aggregation type of the archive 

 AVG (Average) 

 Max (Maximum value) 

 Min (Minimum value) 

 Sum (Sum) 

 RAW (Raw data format - without 
aggregation) 

Button Add -> Adds selected variable(s) to the list of Diagram 

variables. 

Button Add all -> Adds all variables to the list of Diagram variables. 

Button <- Delete Removes selected variable(s) from the list of the 
Diagram variables. 

Button <- Delete all Removes all variables form the list of Diagram variables. 

DIAGRAM VARIABLES 

Option Description 

Diagram variables You can see all selected variables here. These are relevant 
for the next tab when creating the diagram. 

To delete variables again: 

 Highlight the variable that you want to 
delete and click on <-Delete. 

 Hold down the Ctrl key, highlight several 
variables that you want to delete at the 
same time and click on <-Delete. 

 Click on <-Delete all to delete all selected 
variables again. 

Variable list: 

 Name 
Variable name 
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 Project 
Name of the project of the variable 

 Archive: 
Short identification of the archive 

 Aggregation: 
Aggregation type of the archive 

 AVG (Average) 

 Max (Maximum value) 

 Min (Minimum value) 

 Sum (Sum) 

 RAW (Raw data format - without 
aggregation) 

Note: Once you have left this tab, changes to the settings that have been made here are possible. 
 

Diagram - create diagram 

You are able to draw a diagram in this tab. 

Note that: 

 You can create a maximum of 26 start or end nodes. 

 The start nodes cannot overlap. 
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 The end nodes cannot overlap. 

 

DRAWING AREA 

You position your nodes and connections in the drawing area. 
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NODE 

Option Description 

Name Node name 

Color Color of the node. Displays the last selected color. 
Clicking on the button opens the color selection dialog. 

Create Creates nodes and positions these on the drawing area. 

Delete Deletes selected nodes from the drawing area. 

Only active if at least one node in th drawing area has 
been selected. 

DIAGRAM 

Option Description 

Validate Checks whether all nodes have been linked and/or 
whether the links are occupied with a variable. 

The result of the validation is displayed in a dialog. 

 Node xx is not connected! 
The node is not connected to another node. 

 A connection of node xx has no variable 
linked! 

The linking of the node does not have an assigned 
variable. 

Save Saves the current project configuration. A check is also 
carried out before saving. 

Reset Deletes all nodes and previously-configured connections. 

DIAGRAM SETTINGS 

Option Description 

Loss detection Automatic loss detection with an additional connection 
that visualizes the differential flow. 

 activated: The automatic loss detection is 
calculated. 

 deactivated: No automatic loss detection is 

calculated. 

Default: deactivated 

Unknown Loss If, for a node, the quantity of inflows exceeds the 
quantity of outflows, a differential flow in the 
selected color is displayed. 
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Only active if Loss detection is active. 

Note: This differential flow is only displayed in 
zenon Runtime or in zenon Analyzer. 

Undefined Input If, for a node, the quantity of outflows exceeds the 
quantity of inflows, a differential flow is displayed in 
the selected color. 

Only active if Loss detection is active. 

Note: This differential flow is only displayed in 
zenon Runtime or in zenon Analyzer. 

CONNECTIONS (VARIABLES) 

Option Description 

Connections (Variables) List of all the variables available for linking.  
If a variable is already linked to a connection, this variable 
is shown in green in the selection list. 
Note: These variables are provided in the Variables tab. 

Link variable Links the selected variable to the selected connection. 

Not active if no connection is selected. 

Note: If a second node and a variable is selected, the 
connection is also drawn in addition to the linking. 

Delete Deletes selected connection. 
Multiple selection of connections is possible. 

Not active if no connection is selected. 
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Create diagram 

This is how you create a Sankey diagram with the Sankey wizard: 

 

CREATING NODES AND CONNECTIONS: 

Note that: 

 You can create a maximum of 26 start or end nodes. 

 The start nodes cannot overlap. 
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 The end nodes cannot overlap. 

 

Engineering: 

1. Enter, in the Node window, under the Name field, a name for the node to be created. 

2. Select a color for the node by clicking on the Color field. 

3. Then click on Create. 

4. Create the required nodes and arrange these as you wish. 

5. Connect the nodes by dragging a node output (to the right of the node) to a node input (to the 
left of the node). 

Note: A node can have connections to several nodes or several nodes can have connections to one 
node. The size of the output node changes depending on how many connections there are. Nodes that 
are only connected on one side are displayed as round or oval. Nodes that have connections on both 
sides are shown as angular. 

There are the following possibilities with regard to node connections: 

Back-coupling: Establish a connection from the output of a node to its input 

To do this: 

 Double-click on the node on which you want to create the back-coupling. 

or 

 Drag the connection from the output of the node to its input. 

Establish a connection between 2 nodes and link a variable to it at the same time: 

To do this: 

1. Highlight both nodes that you want to connect and the variable that you want to link to it. 

2. Click Link Variable. 
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LINKING VARIABLES TO CONNECTIONS: 

There are several possibilities for linking variables to connections: 

 

Drag&Drop 

 Drag the desired variable from the Connections (Variables) window to the desired node 
connection. 

Note: Provided that you have already established the connection between the nodes. 

Button Link Variable 

1. Highlight the desired node connection 

2. Highlight the variable that you want to link to the connection. 

3. Click on the Link Variable button. 

Note: You can only link one variable to each connection. 

Linking a variable to several node connections: 

1. Hold down the Ctrl key and highlight several node connections. 

2. Highlight the desired variable 

3. Click on Link Variable 

or 

4. Drag the variable to the highlighted node connections. 

Note: In order to see the name of the variable that is linked to the connection, move the mouse to 
above the connection. 

DIAGRAM SETTINGS : 
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If you activate the Loss Detection option, loss detection is calculated automatically. An additional 
connection then visualizes the differential flow. 

You can select the colors that are to be used for the display of the differential flows in the Unknown Loss 
and Undefined Input fields. To select a color, click in the field. The color palette for selecting a color is 
opened 

CONCLUDING THE DRAWING OF THE DIAGRAM: 

 

Once you have finished drawing your diagram, 

 Click on the button   Validate: 

If all your connections are correct, a dialog appears informing you that the diagram is valid. Otherwise a 
dialog appears informing you that there are still nodes that are not connected or that variables are not 
linked to the connections.  
In order for a diagram to be valid: 

 All nodes must be connected 

 All connections must be occupied with a variable 

 No nodes can overlap if they are moved towards inputs (left) or outputs (right) 

To save your diagram, 

 Click on the Save button. 

The diagram you have created is validated. The diagram is saved and marked as valid or invalid. You are 
shown the project in which it is saved. 

To redraw the diagram, 

 Click on the Reset button. 

All the nodes you have drawn and your connections are thus deleted. 
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  Information 

Clicking on the Validate  or Save  buttons orientates the nodes to the right and left 
side of the drawing area. 

Note: Nodes must not overlap in the process. 

EDITING NODES: 

Once you have created some nodes, you can 

Issue several nodes with the same name: 

1. Hold down the Ctrl key. 

2. Highlight the nodes that you want to name. 

3. Enter a name. 

Select the same color for several nodes: 

1. Hold down the Ctrl key. 

2. Highlight the nodes that you want to color. 

3. Then select a color. 

Moving several nodes at the same time: 

1. Hold down the Ctrl key. 

2. Select the node that you want to move. 

3. Move the nodes. Your connections are also moved. 

Note: You can also edit a node individually by highlighting it and make the desired change. 

DELETING NODES: 

1. Highlight the node that you want to delete. 

2. Click, in the Node window, on Delete or use the Delkey. 

Deleting several nodes at the same time: 

1. Hold down the Ctrl key and highlight the node that you want to delete. 

2. Click, in the Node window, on Delete or use the Delkey. 

Note: When the node is deleted, its connections are also deleted. 

DELETING CONNECTIONS: 

1. Highlight the connection that you want to delete. 
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2. Click, in the Connections (Variables) window, on Delete or use the Delkey. 

Deleting several connections at the same time: 

1. Hold down the Ctrl key and highlight the connections that you want to delete. 

2. Click, in the Connections (Variables) window, on Delete or use the Delkey. 
 

Display of Sankey diagram in zenon Analyzer 

The nodes are always rearranged in zenon Analyzer and do not follow the exact positioning in the wizard 
in the process. The display of the Sankey diagram is automatically optimized in zenon Analyzer for 
legibility and clarity. 

The width of the connection is taken into account specially for this arrangement. This width is 
dependent on the respective values shown (the more there are, the thicker it is). 

HORIZONTAL ARRANGEMENT 

Nodes are distributed horizontally over the whole width in proportion to their number. 

Example: With three nodes, the display of the first connection will end in the middle of the display. 

VERTICAL ARRANGEMENT 

The vertical arrangement of the nodes is always carried out in a vertical line in zenon Analyzer. This 
means that the first level is always arranged in a vertical line, regardless of the project configuration in 
the wizard. 

The end nodes are automatically arranged from top to bottom at equal distances. 

  Information 

Note the following examples of views. 
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Examples of views: Wizard - zenon Analyzer 

EXAMPLE OF HORIZONTAL ARRANGEMENT 

SANKEY WIZARD CONFIGURATION 

 

VIEW ZENON ANALYZER 
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EXAMPLE OF VERTICAL ARRANGEMENT 

SANKEY WIZARD CONFIGURATION 

 

VIEW ZENON ANALYZER 
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EXAMPLE OF MIXED ARRANGEMENT 

SANKEY WIZARD CONFIGURATION 

 

VIEW ZENON ANALYZER 

 

Finish - complete 

In the Finish tab, you can see whether the diagram you have created is valid and the location where the 
diagram you have created has been saved. 
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 Click on the Finish button. 

 

To close the Sankey wizard: 

 Click on the Close button. 

  Information 

The configuration of your Sankey diagram is saved in an XML file. 

This is in the project manager of the selected project in the Files node in the Other 
folder. 

With the Analyzer Export Wizard, you can accept the modeled Sankey diagram for use in 
zenon Analyzer. 

You can read details of this export in the Analyzer Export Wizard. (on page 38) manual 
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3.2 Energy 

Wizards for the energy industry. 
 

3.2.1 Driver Simulation 

The wizard creates an own zenon Logic program for each driver in the zenon project for which a driver 
simulation project is created. This zenon Logic program simulates for all variable pairs of the driver, for 
which a substitution rule applies, a direct allocation from command variable to response variable. 

EXAMPLE 

 zenon variables: 

 Test_CO : USINT 

 Test_RV : USINT 

 Switch_CO: USINT 

 Switch_RV: LREAL 

 Rules for substitutions: 

 *_CO -> *_RV 

 Result in zenon Logic: 

 

 

  Attention 

This wizard does not support distributed engineering and is not available in multiuser 
projects. 
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Starting the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Energy. 

3. There select the Driver Simulation Wizard. 

 

4. Click on OK. 

The wizard starts with the welcome page. 
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Welcome 

The tab Welcome informs you about performance and use of the wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys. 

Click on Close to close the wizard. 
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Settings 

On this tab the substitution rules are created. 

 

Parameter Description 

Execute wizard when compiling 

straton project 
Active: As soon as action Create Runtime files is executed 
in zenon, the wizard is also executed. 

Note: The logic for creating the straton project is running in 
the background. The user interface of the wizard is not 
displayed. 
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Drivers with simulation project Lists all drivers of the zenon project currently active in the zenon 
Editor for which a driver simulation project was created. If a driver 
is selected in this list, the defined substitution rules for this driver 
are displayed in area Replacement pattern. 

Replacement pattern Substitution rules. 

COMMAND Variable Command variable. 

Only one wildcard (*) is allowed. 

RESPONSE Variable Response variable. 

Only one wildcard (*) is allowed. 

Add Adds rules to List of rules. 

Modify Makes it possible to change selected rules. 

Remove Removes selected rules from the List of rules. 

List of rules Lists the defined rules. 

Arrow keys Moves to the previous or next tab. 

Close Closes wizard. 

If rules are changed, the recreation of the simulation project is offered when you close the dialog. For 
this a dialog is opened: 

 

Note: Confirm this dialog with Yes if all substitution rules are deleted for a driver. Simulation projects 
without substitution rules are not considered at the automatic creation of the Runtime files in zenon. 
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Rebuild 

On this tab you can trigger a rebuild of all straton simulation projects. 

 

Click on button Rebuild in order to start the recreation of the driver simulation project for all 
corresponding drivers in the project. 
 

3.2.2 IEC 61850 SSD Import 

The IEC 61850 SSD Import Wizard makes it possible to read project configurations from an SSD file and 
to transfer these to a zenon screen including ALC-compliant project configuration. The position of the 
individual devices is calculated from the content of the SSD files. 

The size of the symbols can be configured. Country-specific templates of symbols can be used for 
visualization. The use of your own symbols is also supported. 

The variables must still be assigned manually for complete project configuration. 

  Information 

It is recommended that you use the SSD import wizard with a licensed zenon Energy 
Edition. 
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ZENON MODULES AND CONTENT 

The wizard uses the following zenon modules and content. For further detailed information, click on the 
link to the respective manuals and chapters: 

 Screens 

 Screen elements 

 Combined element 

 Frames 

 Symbols and element groups 

 Automatic Line Coloring 

 Editor 

 Visibility levels 

 Worldview 
 

Starting the wizard 

The IEC 61850 SSD Import Wizard is automatically installed as part of the zenon standard installation. 

STARTING THE WIZARD 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 
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2. Select the folder Energy. 

3. Then click on IEC 61850 SSD Import. The selection window with the available wizards opens. 

 

4. Click on OK. 

The wizard starts with the dialog IEC 61850 SSD Import. 

  Information 

The IEC 61850 SSD import wizard is only available in English. 
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Configuration dialog 

In this dialog, you configure the parameters for the configuration of a zenon screen including ALC 
connections. 
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SELECTION 

Parameter Description 

File Input field for the selection of the SSD import file. 

Clicking on ... opens the dialog to select the SSD file. 

Default: empty 

Default path C:\Public\Documents 

Supported file formats: 

 *.SCD 

 *.ICD 

 *.CID 

 *.IID 

 *.SED 

List of available symbols List of all symbols available in the project. 
The wizard checks to see whether there are the symbols 
for the supported types. 

Available symbols are visualized with a green tick. 

If a symbol for a supported type is missing, this is shown 
in the list with a red warning signal. 

Default: No Symbols Found 

Symbols Drop-down list for selection of the symbols: 

 local 
The symbols of the project configuration of the 
active project are used. 

 [Dateiname] 
The symbols are imported from an XML file. All XML 
files from the following directory are displayed: 
C:\ProgramData\COPA-DATA\zenon800\Te

mplates\IEC850Import\ 

Default: local 

Clicking on ... imports the content of the selected 
XML file to the Symbolbibliothek in the Bilder node 
in the current project. 

If there are symbols missing, this is shown by means 
of a red warning triangle. 

Note: You can find further information in the Symbols for 
SSD import (on page 199) chapter. 

Import Symbols Imports selected symbols from the drop-down list of 
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Symbols in the symbol library. 

Grayed out if no selection has been made in the 
drop-down list. 

AVAILABLE ZENON SCREENS 

List of all configurable screens of the active project in the zenon Editor. The list can be sorted and 
filtered. 

 

 Click a column heading to sort. Another click reverses the sorting sequence. 
The sorting direction is visualized with an arrow. 
Use the context menu for sorting (on page 205) for enhanced sorting possibilities. 

 Click the filter list to filter. The filter is set to "Contains" by default. 
Use the context menu for filters (on page 208) for enhanced filter possibilities. 
An active filter is visualized with a yellow filter symbol. 



Topics 

 

 

196 

 

 

IMPORT TO SCREEN 

Parameter Description 

Name Name of the configured screen in the active zenon 
project 

Type Screen type of the configured screen. 

Note: the configured screen type is listed with the prefix 
tp. 

Frame Name of the frame that is assigned to the screen. 

Size Configured size of the screen. 

SCALE AND LAYOUT 

Parameter Description 

Global scaling factor Basic size of a symbol for automatic configuration in a 
zenon screen. Denoted in pixels. This enlargement factor 
applies for the complete project configuration. 

Input range: 1 to 1000 
Default: 40 

Note: In principle, symbols with a size of 1x1 are 
assumed. This is multiplied by the value in the Global 

scaling factor input field. 

Example: With a Global scaling factor  of 40, the 
symbol is portrayed as 40 x 40 pixels. 

A configuration of less than 1 is not permitted. This 
incorrect configuration is automatically corrected to 1. 

CBR Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

CTR Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 
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DIS Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

DISG Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

REA Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

IFL Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

PTR Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

Note: it is recommended that PTR symbols are always 

configured in double size. 

VTR Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 
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 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

CAP Enlargement factor for the element, based on the value 
configured in the Ratio field. 

 x = horizontal enlargement 

 y = vertical enlargement 

Input range: 1 bis 20 

Default: 1 

LAYOUT 

Parameter Description 

Bay name position Position of the labeling of the bay: 

 Top 
Bay labeling in positioned in the zenon screen above 
a bay. 

 Bottom 
Bay labeling is positioned in the zenon screen below 
a bay. 

Default: Top 

CLOSE DIALOG 

Parameter Description 

Cancel Closes the wizard and discards all configurations. 

Import Draws the project configuration, including ALC 
connections, on the selected screen. 

A warning (on page 212) appears if there are already 
elements on the screen. The configuration process is 
started by clicking on the OK button. Clicking on the 
Cancel button returns to the wizard. 

Note: not active if no SSD file is selected. 

 
 



Topics 

 

 

199 

 

 

Symbols for the SSD import 

To draw a zenon screen, the SSD Import Wizard reads the selected SSD file. In doing so, the wizard 
recognizes the types of the ConductingEquipments (according to the standard) and uses the 
corresponding configured symbols. 

Supported file formats: 

 *.SCD 

 *.ICD 

 *.CID 

 *.IID 

 *.SED 

In order for this process to work without problems, the corresponding symbols must be present in the 
project configuration in the zenon. 

You can find a detailed description of the required elements in the Supported types (on page 200) 
chapter. 

  Attention 

Note capitalization when naming the elements. 

MISSING SYMBOLS 

 

If there is a symbol missing in the current zenon project configuration, this is visualized in the SSD 
Import Wizard with a red warning signal. This warning dialog always appears in the wizard next to the 
Symbols drop-down list. If the symbols are imported from an XML file, this warning message is only 
shown once the import has been carried out. 

 No Symbols Found 
No elements are present in the local symbol library. 

 Missing [Element name] 
Not all required elements are present in the local symbol library. The missing symbols are 
displayed in the list. 
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Note: The warning messages are only available in English. 

IMPORTS SYMBOLS FROM AN XML FILE.  

 Select the desired file from the drop-down list 
All XML files from the following directory are displayed: 
C:\ProgramData\COPA-DATA\zenon800\Templates\IEC850Import\.  

 Click on the ... button to import the elements of the XML file. 
Note: Once imported successfully, the selection of the drop-down list returns to local again. 

 Check the naming of the imported symbols. 

A new file import overwrites pre-existing symbols. 

 
 

Supported types 

The following types of the standard are supported: 
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Type Description Element name 

CBR Circuit Breaker 
 

You can find further information on the 
configuration of the screen for the circuit 
breaker 

CBR_H 

CBR_V 

 

Combined element with different states 

Switch 

CTR Current Transformer 
 

CTR_H 

CTR_V 

 

Transparent lines "through" the symbol connect 
external lines 

 

Switch 

 

### Do not translate ### 

DIS Disconnector or earthing switch 
 

DIS_H 

DIS_V 

 

Combined element with different states 

 

DISG Disconnector grounded 
 

DIS_grounded_DOWN 

DIS_grounded_L 

DIS_grounded_R 

DIS_grounded_UP 

 

Consists of two combined elements 

- suspected empty part in turn contains symbols 
for all states 

- transparent line 

 

Color from ALC 

REA Reactor REA_DOWN 
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### Do not translate ### 

### Do not translate ### 

 

### Do not translate ### 

 

 

IFL Infeeding line 
 

IFL 

### Do not translate ### 

 

### Do not translate ### 

PTR Power Transformer 
 

PTR 

### Do not translate ### 

### Do not translate ### 

 

### Do not translate ### 

 

### Do not translate ### 

### Do not translate ### ### Do not translate 
###Transformer 

 

### Do not translate ### 

 

### Do not translate ### 

 

### Do not translate ### 

 

PTR_3_DOWN 

 

VTR Voltage Transformer 
 

VTR_L 

VTR_R 

VTR_UP 

VTR_DOWN 

 



Topics 

 

 

203 

 

 

### Do not translate ### 

### Do not translate ### 

### Do not translate ### 

 

### Do not translate ### 

CAP Capacitor 

Capacitor 

 

 Vertical line LINE_V 

 

Color from ALC 

Size: 100 x 2 

Thicknesses: 2 

 Horizontal line LINE_H 

DESC Description 
Description of the element 

DESC 

 

Textbox 

EXCEPTIONS FROM THE STANDARD 

 DIS_grounded (DISG) 
DIS_grounded Is not present in the standard. DIS_grounded is a ConductingEquipment with the 
DIS type and a terminal with ConnectivityNode "grounded" 

 PowerTransformer (PTR) 
PTR is not ConductingEquipment but nevertheless has a type and symbol and is also drawn. This 
is the recommended procedure in the standard. 

  Attention 

Note capitalization when naming the elements. 

Symbols that are not present are visualized as a red square. 
 

Requirements for a symbol 

How to configure correctly 
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Symbol size - examples 

The size of the symbols with automatic configuration by the SSD Import Wizard is determined by two 
sizes: 

 Global scaling factor 
Basic size of all symbols on the zenon screen. 
The size is stated in pixels. 

 Enlargement factor per element 
This calculates the respective multiple of the configured ratio. 
The enlargement factor can be given for: 

 x = horizontal enlargement 

 y = vertical enlargement 

EXAMPLE 1 

Global scaling factor: 20 

Size of element: 5 (x and y) 

Result: Symbol size 100 pixels 

EXAMPLE 2 

Global scaling factor: 50 

Size of element: 1 (x and y) 

Result: Symbol size 50 pixels 

EXAMPLE 3 

Global scaling factor: 25 

Size of element x: 2 

Size of element y: 1 

Result: Symbol size 50 x 25 pixels 

EXAMPLE 4 

Global scaling factor: 5 

Size for element CBR x: 6 



Topics 

 

 

205 

 

 

Size for element CBR y: 6 

Size for element PTR x: 10 

Size for element PTR y: 10 

Size for element REA x: 2 

Size for element REA y: 6 

 

Result: 

Symbol size for element CBR: 30 x 30 pixels 

Symbol size for element PTR: 50 x 50 pixels 

Symbol size for element REA: 10 x 30 pixels 

 
 

Sorting context menu 

The list of available zenon screens can be sorted, filtered and amended with the context menu. To apply 
these enhanced sorting possibilities, navigate to a column heading and click the right mouse button. 

These settings are not remanent. The standard view is available again after the wizard has been 
restarted. 

  Information 

The content of the context menu is only available in English. 
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Parameter Description 

Sort Ascending Ascending sorting of the selected column (A - Z). 

Note: The sorted column is visualized with a small arrow 
above the column heading. 

Sort Descending Descending sorting of the selected column (A - Z). 

Note: The sorted column is visualized with a small arrow 
above the column heading. 

Clear Sorting Cancels active sorting. 

Not active if no sorting is active. 

Conditional Formatting Opens the dialog to configure a view filter. Conditions for 
display can be configured in this filter. 

Group by this column Switches to grouped display. 

The column heading is shown in the first line of the 
available zenon screen. 

Cancel the grouping by clicking on the X button in group 
view. 

Column Chooser Opens dialog to show or hide columns. 

Columns that are not displayed are offered in this dialog 
and can be moved using Drag&Drop into the list of the 
available zenon screens. 

Displayed columns can be hidden using Drag&Drop (back 
to this dialog). 

Hide Column Hides the selected column. 

To display the column again, execute Column Chooser 
and drag the desired column using Drag&Drop into the 
list of available zenon screens. 

Not available if only one column is displayed. 

Pinned state Moves selected column: 

 Unpin column 
column can be freely moved to the position using 
Drag&Drop. 

 Pin at left 
Moves the selected column to the far left. 
The selected column thus becomes the first column 

 Pin at right 
Moves the selected column to the far right. 
The selected column thus becomes the last column 
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Best Fit Determines the "optimum width" for the selected 
column. The width of the column is - if possible - changed 
so that all content can be read. 

GROUPED DISPLAY 

 

The columns can be displayed as grouped in the list of available zenon screens. 

You get the grouped display: 

 by moving the column headings with Drag&Drop into the heading area  
(Drag a column here to group by this column.) 

 by selecting the Group by this column  entry from the context menu. 

In the grouped display, you can expand or reduce the view by clicking on the upward or downward 
arrow. 

By clicking on the x button next to the name of the grouped column, you cancel the grouped display 
again (for this column). 

  Information 

The screens can also be filtered in the grouped view. 
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Filtering context menu 

Context menu for filtering in the list of available zenon screens. To activate, click on the filter symbol in 
the respective column. 

 

Parameter Description 

No filter No filter 
Cancels selected filter. 

Contains Contains 

Filters for entries that contain the criterion entered. 

Does not contain Does not contain 
Filters for entries that do not contain the criterion entered. 

Starts with Starts with 
Filters for entries that start with the criterion entered. 

Ends with Ends with 

Filters for entries that end with the criterion entered. 

Equals Equals 

Filters for entries that are exactly the same as the criterion entered. 

Not equal to Does not equal 
Filters for entries that do not correspond to the criterion entered. 

Is null Is empty 
Filters according to empty entries. 

Is not null Is not empty 

Filters for any desired entries that are present. 

Custom Opens the dialog for the configuration of a user-defined filter. 

Note: With certain monitor resolutions, it is possible that the dialog for the 
configuration of the user-defined filter is "hidden" behind the window of the 
wizard. The wizard then no longer reacts to entries and mouse clicks. 

Press the Esc key once in order to be able to use the wizard again. 
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Configuration of an ALC-compliant zenon screen 

POSITIONING OF THE TYPE - CONTEXT DISPLAY 

The wizard uses the coordinates of the enhanced standard. This means that for the positioning of the 
types, the coordinates (SCLcoordinates), as stated in the SSD file, are used: 

 X describes the horizontal orientation 

 Y describes the vertical orientation 

SCL is a hierarchical data model. This does not contain the complete coordinates. The X and Y 
coordinates are each given hierarchically to the prior element. 

Each node knows its relative position in relation to its superordinate nodes. Substations  are always 
accepted as root nodes. The absolute position is calculated from the addition of all superordinate nodes. 
This calculation is carried out automatically by the SSD Import Wizard. 

NAMING OF THE LINES 

The ConnectivityNode of the SSD file is used for naming the connection lines. 

VISIBILITY LEVEL 

The automatic screen configuration by the wizard uses visibility levels: 

 Visibility level 8 
Elements and connection lines 

 Visibility level 0 
Description (DESC) 

As a result of this, complex configurations can be displayed clearly for editing in the Editor. 
 

Engineering in the Editor 

Before you start the wizard in the zenon Editor, you should have already carried out the following 
configuration: 

 Create a zenon screen 
The wizard supports all zenon screen types. An evaluation for the appropriateness of the screen 
type used is not made. 
Ensure that the size of the screen is sufficient with comprehensive descriptions in the selected 
SSD file. 

 Create corresponding symbols in the symbol library (optional). 
When creating symbols, ensure that the elements are labeled correctly (on page 200). 
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Symbols can also be added to the symbol library of the active project in the started wizard by 
means of import from an XML file. 

 Configure the ALC settings in the project properties  
Configure the behavior of automatic line coloring for your project. 

CONFIGURATION IN THE WIZARD 

Configure the following settings in the SSD Import Wizard: 

 Selection of an SSD file. 

 Import or selection of the symbols (optional) 

 Selection of a pre-configured zenon screen 

 Selection of the position of the labeling 

 Configuration of the basic size (Global scaling factor) of the symbols 

 Configuration of the enlargement factor of an element 
 

Preparation of the zenon screen 

SCREEN SIZE 

The SSD Import Wizard ignores the configured screen size when drawing the screen. The symbols are 
arranged according to the configured Global scaling factor  and element size, as well as according to the 
content of the SSD file. 

You should nevertheless ensure that you stipulate a sufficient size when configuring the screen. This size can 
also be amended once the wizard has been closed. 

WORLDVIEW 

If screens are defined as larger than the frame, they become a world view. In this worldview screen, the 
screen can be moved with the mouse or touch control. 

For navigation and scrolling in Worldviews, a Worldview overview screen, the Touch control and the 
mouse can be used. 

CONFIGURATION SPEED 

Close the screen used in the Editor while the drawing process is being carried out by the SSD Import 
Wizard. However if the screen is nevertheless open for editing in the Editor, the automatic drawing will 
require a multiple of the time! 
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Screen elements - ALC-compliant project configuration 

Screen element CBT 

Configure the screen element for the circuit breaker in accordance with the following requirements: 

 

Project configuration view in the zenon Editor 

 

Examples of views in zenon Runtime: 

 
 

ALC engineering 

Configure your settings for the behavior of the ALC in the project properties: 

1. To do this, select the active project in the Workspace. 

2. Select the Automatic Line Coloring property group in the project properties. 

3. Click the ... button in the ALC configuration property 

4. The dialog for configuration is opened. 

5. Configure the properties for 

 Sources 

 Interlockings 

 Screen marker 

  Information 

You can find further information on configuration in the Automatic Line Coloring (ALC) 
manual in the Configuration chapter. 

 
 

Combined elements 

### Do not translate ### 

 

Configuration tips for the symbols used: 
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Name the symbols correctly 

Configure symbols with the help of the combined element for different ALC states 

### DO NOT TRANSLATE ### 

### Do not translate ### 

 
 

Warning dialog when configuration has already been carried out 

Once the necessary configuration has been completed in the wizard, click on the Save button to draw 
the project configuration on the selected zenon screen. 

If you execute this configuration on a screen that already has content, the elements contained therein 
are validated. If an element is already present, you are informed of this by a warning dialog. 

If this configuration takes place on a screen that already has a configuration, you are notified of this by a 
warning dialog. 

WARNING DIALOG: 

There are already [number of symbols] elements on [screen name] 
Do you want to continue? 

 

CLOSE DIALOG 

Option Description 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

The screen is drawn again by clicking on the OK button. Existing configurations are replaced in the 
process. If an element is placed again during the drawing process, the following notice dialog appears: 

 

Confirm this dialog by clicking on the OK button to continue drawing. 
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  Hint 

If you have started the new configuration of your zenon screen in error and 
confirmed the warning dialog with the OK, you can suppress the individual 
subsequent dialogs it with the following step: 

1. Position the mouse pointer over the Cancel button. 

2. Do not confirm the notice dialog that appears with a mouse click. 
Use the Enter key to confirm. 

3. Hold down the Enter key. 

4. At the same time, click on the Cancel button with the mouse pointer. 

Then delete the content in the zenon screen and restart the SSD Import Wizard. 

 
 

3.2.3 IEC850 Driver Configuration Wizard 

The IEC850 Driver Configuration Wizard supports you when configuring reporting. The correct RCBs can 
be selected in a graphic user interface and assigned to the IEC850 driver using drag&drop. 

Variables that supply the IED to the driver using the selected RCBs can be created in the wizard. IEC850 
drivers can also be created in the zenon Editor due to the wizard. These are also configured in the 
wizard on the basis of an existing SCL file, such as TCP/IP addressing. 

Example: An SCD file contains the description of the substation. In the zenon Editor, all required IEC850 
drivers are configured using this SCD file. If the driver is still not present in the project, this can be 
created in the wizard. 

Step by step, content from from several SCL files (such as ICD) can also be transferred consecutively into 
the driver configuration. 

The configuration steps are carried out in the wizard by means of drag&drop and the context menu. 

Note in relation to output: RCBs that are already in the configuration and are read from the text file are 
displayed without the [dataset name]. Only RCBs that have been added by means of dragging & 
dropping in the wizard have the dataset name as a suffix.   

  Information 

The IEC850 Driver Configuration Wizard is only available in English. 
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REQUIREMENTS 

There must be a SCL file (*.scl, *.icd, *.cid, *.scd, *.ssd) available to use the wizard. 

 
 

Starting the wizard 

The IEC850 Driver Configuration Wizard is automatically installed as part of the zenon Energy Edition 
installation. 

STARTING THE WIZARD 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Energy. 
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3. Then click on IEC850 Driver Configuration. 

 

4. Click on OK. 

The wizard starts with the page Configuration. 

  Information 

The IEC850 Driver Configuration Wizard is only available in English. 

 
 

Configuration 

The IEC850 driver is configured in this dialog. 
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If there is already one or more IEC850 drivers configured in the zenon project, these drivers are 
displayed on the right-hand side of the dialog in a tree view. In addition, further drivers can be created 
directly in the wizard. 

 

FILE SELECTION 

Selection of the SCL file. Click on the ... button to open the file selection dialog 

 Once a file has been selected, it is loaded into the wizard. The file content is displayed in a tree 
structure in the left area of the wizard in the List of IEDs. 

 There is also be an evaluation of the data content when loading. Non-supported content is 
displayed in the preview window. 
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Parameter Description 

File name Display of the selected SCL file. 

If a file is selected, the complete path is visualized in the display field. This 
field cannot be filled actively. 

Default: empty 

The file that was selected last is preselected if the wizard is called up 
again. 

Note: If the wizard was previously started and a file was selected that is 
no longer available, there is a time delay when restarting the wizard or 
when selecting a file again by clicking on the ... button. 

This may then be the case if the file is on a computer in the network that is 
no longer available at the current time. 

CONFIGURATION 

The view is divided into the following areas: 

 Left column with content from the selected SCL file. Content is shown in a tree view. 

 Buttons in the middle that correspond to the available drag&drop functionality. 

 Buttons for the administration of driver project configurations. 

 Right column with content of the existing IEC850 driver configuration of the current zenon 
project. The content is shown in a tree view. 
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WIZARD - DIVISION OF AREAS 

Parameter Description 

List of IEDs 
[file content] 

In the left column, the content of the assigned SCL file is listed in a tree 
structure. 

Content that has already been assigned is displayed as grayed out. 

Clicking on [+] expands the view. 
Node structure: 

 [Server IP-Adresse]_[IED-Name] 

 Reports 

 [RCB-Name]_[Dataset-Name] 

 [ClientLN.iedName] 

List of drivers 
[project content] 

In the right column, all IEC850 drivers created in the project and in the 
wizard are listed with their connections. Drivers can be added or deleted 
in the wizard directly using the context menu. Connections are allocated 
by dragging & dropping (on page 226) and can be deleted via the context 
menu (on page 221). 

Default: Configuration of the IEC850 driver in the zenon Editor. Empty if 
there is still no IEC850 driver created in zenon. 

Note: Further connections can be added to drivers that have already been 
created in zenon. Connections or drivers that already exist in zenon cannot 
be deleted. 

Settings that cannot be changed with the wizard are already grayed out. 

Output window LOG, information and status texts for the IEC850 driver configuration 
wizard. 

BUTTONS FOR THE ADMINISTRATION OF DRIVER PROJECT CONFIGURATIONS 

Parameter Description 

New Driver Creates a new driver. 

Import Quality Imports the template for the 850-quality reaction matrix. 
You can link this reaction matrix to variables that 
correspond to the data attributes */q[ST|MX]. 
A pre-configured template file is supplied. 

Save location: 
%ProgramData%\COPA-DATA\zenon8.00\Templates\Ener
gyWizard\IEC_61850_Quality.XML 

Note: This template is implicitly loaded in the Variables in 
dataset (on page 242) dialog. 
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Create Supervision Variable Creates a connection monitoring variable in the current 
zenon project. 

A reaction matrix is automatically created and linked for 
this variable. 

You can find further information in relation to this in the 
IEC850 driver manual, in the Establishing a connection 
and detecting a connection failure chapter: 
Connection State-Variable. 

Save location: 
C:\ProgramData\COPA-DATA\zenon8.00\Templates\Ener
gyWizard\IEC_61850_Connection_State.XML 

Attention: If the driver is not yet present in the current 
project, no connection monitoring variable can be 
created. This is primarily the case if a driver is created in 
the wizard but this has not yet been applied to the 
project configuration with the Apply button. 

New Connection Creates a new connection to the server and calls up the 
New connection (on page 232) dialog for the 
configuration of the connection. 

You can get further information in the Manage drivers (on 
page 229) chapter 

Note: Only available if a driver has been selected. 

Import Variables Opens Variables in Dataset (on page 242) dialog to 
create variables that are present in datasets of the 
selected RCBs. 

These variables are created in the current zenon project. 

MIDDLE BUTTON GROUP 

As an alternative to assignment of connections by means of drag&drop, the assignment can also be 
carried out with buttons. With buttons, content from the loaded file can be applied to the driver 
parameter settings. When applying this, the content that has already been applied is taken into account. 
Dual application is thus prevented. 
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Parameter Description 

IEDs Buttons for the application of IEDs with the connections 
contained in these and reports in new drivers. 

> Only accepts selected IED into the driver project 
configuration. 

In doing so, a new driver with the connection to the 
selected IED is created. 

>> Applies all available IEDs as new drivers in the driver 
configuration. 

Connections Button to apply connections and reports in existing 
drivers. 

The buttons of this section are only available if a driver is 
selected in the list of drivers. If a subnode is selected in 
the driver, these buttons are also not available. 

> Creates a connection to the IED in the existing driver. 

>> Applies all available IEDs as connections in the existing 
driver. 

Reports Button to apply RCBs in an existing connection. 

The buttons in this section are only available if a 
connection is selected in the list of drivers. 

> Applies the selected RCBs in the driver project 
configuration. 

> Applies all RCBs of the IED s in driver configuration. 

CLOSE DIALOG 

Parameter Description 

Apply Applies settings. The dialog remains open and other 
project configurations are possible. 

Note: Only active if there are unsaved project changes in 
the wizard. 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

Before closing the wizard, a dialog is opened requesting 
confirmation. 
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CONFIRMATION REQUEST WHEN CLICKING ON CANCEL 

 

Parameter Description 

OK The wizard is ended. 
Unsaved changes are lost 

Cancel Cancels the ending of the wizard. 

 
 

Context Menu 

There are different versions of the context menu. The content of the context menu depends on the 
position of the node on which it is used. 
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CONTEXT MENU 

Parameter Description 

Create all connections Creates several new IEC850 drivers. A separate new driver is created 
for each IED. 

New corresponding entries are created in the list of drivers. 

Driver name: The driver is created with the name of the IED. 

You can get further information in the Manage drivers (on page 227) 
chapter. 

New Driver Creates a new IEC850 driver.  
A new entry is created in the list of drivers. 

Default driver name: Edit (must be changed). 

You can get further information in the Manage drivers (on page 227) 
chapter. 

Rema Supervision Creates a connection monitoring variable and links this to the reaction 
matrix. 

New Connection... A new connection or a new host is created, depending on the position 
in the tree view: 

 Driver 
Creates a new connection to the server and calls up 
the New connection (on page 232) dialog for the 
configuration of the connection. 
You can get further information in the Administer 
connection (on page 229) chapter. 

 Connection or Report 
Creates a new host in the driver configuration and 
calls up the New connection (on page 232) dialog 
for the configuration of the host. 
You can get further information in the Administer 
host (on page 233) chapter. 

Edit Calls up the dialog to configure the connection (on page 232). Different 
project configurations can be amended depending on the position in 
the tree view: 

 Driver 

 Connection settings 

 Host settings 

 Report settings 

 Connecten & node Report 

 Net address 
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 IP address  

 Name of connection. 

You can get further information in the administer 
connection (on page 229) chapter. 

 Host 

 Host settings 

You can get further information in the administer hosts 
(on page 233) chapter. 

 Report 

 Report settings 

You can get further information in the administer report 
assignments (on page 237) chapter. 

Delete Deletes selected node without requesting confirmation. 

Create Variables... Selective creation of new variables. 
Opens Variables in Dataset (on page 242) dialog. 

Create all Variables Creation of new variables. 

Variable for all entries of the datasets of the RCBS are created in the 
zenon Editor. 

Expand all All nodes are expanded. 

Collapse all All nodes are collapsed. 

 
 

Nodes - Context menu entry 

The entries of the context menu depend on the position from which the context menu is called up. In 
this chapter, you can find an overview of which context menu entries are available in which node. 

LIST OF IEDS 

 There is no context menu available for the list of IEDs. 

LIST OF DRIVERS 

 No selection 
The following context menu entries are available if no node is selected: 

 New Driver 
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 Expand all 

 Collapse all 

 Driver 
The following context menu entries are available if the node of a driver is selected: 

 Create all Connections 

 New Driver 

 Rema Supervision 

 New Connection... 

 Edit 
(only available if the node was created in the wizard directly and the wizard has not been 
restarted. If the wizard is restarted, this entry is not available for existing project 
configurations). 

 Delete 
(only available if the node was created in the wizard directly and the wizard has not been 
restarted. If the wizard is restarted, this entry is not available for existing project 
configurations). 

 Create Variables... 

 Create all Variables 

 Expand all 

 Collapse all 

 Connection 
The following context menu entries are available if the node of a connection is selected: 

 New Driver 

 Rema Supervision 

 New Conncection... 

 Edit... 
(only available if the node was created in the wizard directly and the wizard has not been 
restarted. If the wizard is restarted, this entry is not available for existing project 
configurations). 

 Delete 

 Create Variables... 

 Create all Variables 

 Expand all 

 Collapse all 

 Reports node 
The following entries are available if the Reports node is selected: 

 New Driver 
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 Rema Supervision 

 New Connection... 

 Edit... 
(only available if the node was created in the wizard directly and the wizard has not been 
restarted. If the wizard is restarted, this entry is not available for existing project 
configurations). 

 Delete 

 Create Variables... 

 Create all Variables 

 Expand all 

 Collapse all 

 Host 
The following nodes are available if if the node of a host is selected: 

 New Driver 

 Edit... 

 Delete 

 Create Variables... 

 Create all Variables 

 Expand all 

 Collapse all 

 Report 
The following context menu entries are available if a report is selected: 

 New Driver 

 Edit... 

 Delete 

 Create Variables... 

 Create all Variables... 

 Expand all 

 Collapse all 
 

Working with the wizard 

The configuration steps are carried out in the wizard by means of drag&drop and the context menu. 

The buttons can also be used as an alternative to drag&drop. 
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Configuration in the wizard 

To configure drivers: 

1. Select the desired SCL file. 
To do this, click on the ... button in File selection. 
The following are possible files: 

 SCD file with description of the substation 

 ICD file with the configuration of an individual IEC61850 server. 

 Other files: *.scl, *.cid, *.ssd 

If the selected file does not contain all required elements, this is shown with a message in the 
output window. The list of IEDs in the wizard remains empty. 

2. In the list of drivers, create new drivers (on page 227) or hosts (on page 233) if necessary. 
This step is optional. You can also carry out this project configuration in the zenon Editor and 
then restart the wizard. 
Changes that are configured in the wizard are transferred to the zenon Editor project 
configuration. 

3. From the left-hand list of IEDs, select the desired connection to the server (on page 229). 
Drag this using drag&drop to the desired driver in the right-hand list. 

4. Select, from the left List of IEDs, the desired reports (on page 237). 
Highlight the reports that you want to assign to the host of a driver. 
Multiple selection is possible in the process. 

5. Drag & drop the selected reports to the desired driver in the right-hand list.  
If your selection is dragged over a host, these reports are automatically applied to the list of the 
respective host. 
Note: If no host has been created for a connection, no assignment is possible. Carry out step 2 
and create corresponding hosts with the context menu. 

 

6. Close the wizard by clicking on the OK button. 

ALLOCATION RULES 

For the allocation of reports from a file to the drivers of a project configuration in zenon, each report of 
a file can only be allocated a driver once in zenon. 

Each report from the list of IEDs can only be assigned to a host of the list of drivers once. With multiple 
selection, reports that have already been assigned are ignored if there is a reassignment by means of 
drag&drop. Only the reports that have not been used are taken into account in the process and the new 
host is added. 
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DELETE REPORTS 

To release a report: 

1. Highlight the desired report in the node of the host that is allocated to the reports. 

2. Select the Delete command in the context menu. 

3. The allocation of the report to a host is removed. 

Note: Deletion using multiple selection is not possible. Several reports are highlighted. However only 
the last report highlighted is deleted. 

ACCEPT DRIVER CONFIGURATION IN THE PROJECT 

To apply the new configuration, click on the OK or Apply button. 

 The configuration is checked. 

 New drivers are created in zenon. 

 New connections are created in zenon. 

 The RCB configurations are created or updated in the driver configuration. 

 The result is displayed in the output window. 

 

 The wizard is closed by clicking on the OK button. 
 

Administer driver 

IEC850 drivers that are already present in the active zenon project when the wizard is started are 
displayed in the wizard and can be configured. 

New drivers can also be created in the wizard directly. Drivers that have been created in the wizard and 
have not yet been transferred to a zenon project with Apply or OK can be removed again. 

ADDING A DRIVER 

To add a driver: 

1. Select the New Driver command in the context menu of the driver list. 

2. The driver is shown in the list with the default entry Edit.  
This entry remains active until it is replaced with a proper driver description. 
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3. Give it a unique name. 
The driver name entered is evaluated to see that it is unique and has valid characters. If the 
driver already exists or an invalid character has been entered for the name, an error dialog is 
called up. 

4. The driver is created in zenon by clicking on the Apply button or when closing the wizard by 
clicking on OK. 

DELETE DRIVER 

Drivers can only be deleted in the wizard directly if the driver has been created as a new driver in the 
wizard directly. Existing drivers from a project configuration in the zenon Editor are grayed out and 
Delete is not available.  
To delete a driver: 

1. Highlight the desired driver in the list of drivers. 

2. Select the Delete command in the context menu. 

3. The driver is deleted without requesting confirmation. 

Note: Only drivers that have not yet been created in zenon can be deleted. 

WIZARD AND ZENON EDITOR 

If the name of a driver is changes, a new driver is created after clicking on the Apply button. 

  Example 

A new driver is created in the IEC850 Driver Configuration wizard. 

By clicking on the Apply button in the wizard, this new driver is transferred to the zenon 
Editor. 

This driver is then deleted in the wizard with the context menu. 

 

The configuration is transferred to the zenon Editor by clicking on the Apply button 
beforehand. 

This means that the driver created in the wizard and then deleted there again is is listed 
in the list of drivers again when the wizard is restarted. 
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THERE IS AN ERROR DIALOG IF THERE ARE DUPLICATED DRIVER NAMES 

If the driver name is already present in the zenon project configuration, the following dialog is called up: 

 

ERROR DIALOG WITH INVALID CHARACTERS IN THE DRIVER NAMING 

If invalid characters are entered for the driver names, the following dialog is called up: 

 

 
 

Configuration 

The connection denotes the server to which the driver establishes a connection. A driver can have 
connections to several servers. 

Connections can be created in the wizard with the context menu or with drag&drop of content. These 
connections can then only be edited if they were also created in the wizard. 

You edit configurations that already exist in the zenon Editor directly, in the driver settings. 

ADD CONNECTION WITH DRAG&DROP 

To add a connection to a driver via drag&drop: 

1. Select, in the (left) list of IEDs, the desired connection with a mouse click. 

2. Drag this connection with drag&drop into the list of drivers, above the desired driver. 

3. In the list of drivers, a new subnode for the connection is created for the selected connection. 

a) The naming of the subnode is taken from the list of IEDs: 
[Net address]_[IP address]_[Name] 

b) A new Reports subnode is created in this subnode. 
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c) A new Host 0 subnode is created in this subnode. 

  Information 

The reports already assigned in the list of IEDs are not transferred by this process. 
Only the corresponding connection with an empty host is created. 

ADD CONNECTION USING THE CONTEXT MENU 

To add a connection with the context menu: 

1. In the list of drivers, click on the desired driver for which you want to create a connection. 

2. In the context menu of the node of the selected driver, select the New Connection command. 
The dialog to configure a connection (on page 232) is opened. 

3. Configure the following in this dialog: 

a) Net address: 
Net address of the connection 

b) IP address: 
IP address of the connection 

c) Name: 
Freely definable name of the connection Is used for the name of the variable on variable 
import. 
Corresponds to the Server name property of the driver configuration. 

4. Confirm your input by clicking on the OK button. 
The dialog is closed. In the list of drivers, a new subnode for the connection is created for the 
selected driver. 

a) The naming of the subnode: 
[Net address]_[IP address]_[Name] 

b) A new Reports subnode is created in this subnode. 

5. The driver is transferred to the zenon Editor configuration by clicking on the Apply button or 
when closing the wizard by clicking on OK. 

AVAILABILITY AND BEHAVIOR FOR "DELETE CONNECTION" AND "EDIT CONNECTION" 

Connections can only be deleted or edited in the wizard directly if the wizard has been newly-created in 
the wizard. Existing drivers from a project configuration in the zenon Editor are grayed out and 
Delete/Edit  is not available. 

Connections that were already present in the Editor before the start of the wizard are not deleted! 

Command to delete and edit are only possible if: 

1. The Connection is created in the wizard directly: 
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a) via context menu 

b) was transferred using drag&drop. 

DELETE CONNECTION 

To delete a connection: 

1. Highlight the desired connection entry in the list of drivers. 

2. In the context menu of the node of the selected connection, select the Delete command. 

3. The connection is deleted without requesting confirmation.  
All of the hosts and reports already assigned to this connection are deleted without a request for 
confirmation. 

4. The driver is transferred to the zenon Editor configuration by clicking on the Apply button or 
when closing the wizard by clicking on OK. 

if the wizard is restarted, all connections are grayed out because they have already been created in the 
Editor. 

EDIT CONNECTION 

To edit a connection with the context menu: 

1. Click on the connection that you want to edit in the list of drivers. 

2. Select the Edit... command in the context menu of the node of the selected connection. 
The dialog to configure a connection (on page 232) is opened. 

3. Configure the following in this dialog: 

a) Net address: 
Net address of the connection 

b) IP address: 
IP address of the connection 

c) Name: 
Freely definable name of the connection Is used for the name of the variable on variable 
import. 
Corresponds to the Server name property of the driver configuration. 

d) Confirm your input by clicking on the OK button. 
The dialog is closed. The changes are accepted in the wizard. 

4. The driver is transferred to the zenon Editor configuration by clicking on the Apply button or 
when closing the wizard by clicking on OK. 
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Configuration 

Not all properties of the dialog are available for the configuration of the connection to the IEC61850 
server. Properties that are not available are grayed out. Incorrect project configurations are visualized 
with a warning signal (exclamation mark in red circle) next to the input field. 
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CONNECTION SETTINGS 

Parameter Description 

Net address Corresponds to the Net address property in variable 
configuration. 

Note: If the configured Net address has already been 
issued in the driver configuration, the next-highest 
available number is issued. 

Maximum value: 65535 

IP address IP address of the server to which a connection is to be 
made. 

Name Freely definable name. Is used for the names of variables 
when variables are imported. 

It is recommended that this name is kept short but 
unique. 
If this name is read from an SCL file, the name consists of 
IED+LDevice. This read-in name can be shortened 
with this property as desired. 

NAVIGATION 

Parameter Description 

OK Applies settings and closes the wizard. 

Cancel Discards all changes and closes the wizard. 

 
 

Manage hosts 

A host is the name of a computer on which the driver in zenon Runtime is started. 

Example: 

 Computer name of the Primary Server 

 Address of the Standby Server. 

Hosts can be created in the wizard with the context menu or with drag&drop of content. All hosts can 
be newly-created, edited and deleted in the wizard. These changes in the wizard are transferred to the 
driver configuration in the zenon Editor. 

ADD HOST - DRAG&DROP 

If a connection from the list of IEDs is added to the list of drivers using drag&drop, a host is created. 
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When creating a connection with drag&drop, a neutral entry for a host is created. This host is created in 
the list of drivers by default with Host0 under the respective selected driver. 

ADD HOST - CONTEXT MENU 

To add a host using the context menu: 

1. In the list of drivers, click on the desired driver for which you want to create a host. 

2. Expand the tree view of the driver until you can select the Reports level of the connection. 

3. Click on the Reports node. 

4. Select the New Connection in the context menu of the node of the selected connection. 
The dialog to configure a host  (on page 235) is opened. 

5. Configure the host names in this dialog: 
Enter the desired host name in the input fieldHostname (RT computer Name). 

6. Confirm your input by clicking on the OK button. 
The dialog is closed. A new subnode is created for the host in the list of drivers. 

7. The host is transferred to the zenon Editor configuration by clicking on the Apply button or when 
closing the wizard by clicking on OK. 

DELETE HOST 

To delete a host: 

1. Highlight the desired host in the tree view of the list of drivers. 

2. Expand the tree view of the list of drivers if required. 

3. Select the Delete command in the context menu of the node of the selected host. 

4. The host is deleted without requesting confirmation.  
All report assignments that are allocated to this host are also deleted without requesting 
confirmation. 

5. The driver is transferred to the zenon Editor configuration by clicking on the Apply button or 
when closing the wizard by clicking on OK. 

EDIT HOST 

To edit a host using the context menu: 

1. In the list of drivers, click on the desired driver for which you want to amend a host. 

2. Expand the tree view of the list of drivers if required. 

3. Select the Edit... command in the context menu of the node of the selected host. 
The dialog to configure a host (on page 235) is opened. 
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4. Edit the existing entries in the input fieldHostname (RT computer Name). 

5. Confirm your input by clicking on the OK button. 
The dialog is closed. The host is displayed with the new name in the list of drivers in the 
corresponding subnode . 

6. The host is transferred to the zenon Editor configuration by clicking on the Apply button or when 
closing the wizard by clicking on OK. 

 
 

Manage hosts 

Not all properties of the dialog are available for the configuration of the hosts. Properties that are not 
available are grayed out. Incorrect project configurations are visualized with a warning signal 
(exclamation mark in red circle) next to the input field. 
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HOST SETTINGS 

Parameter Description 

Hostname (RT computer name) Name of the computer on which the driver is running that 
receives the reports: 

 For standalone projects: 
$SCADA_SERVER1 Or computer name of the 
computer on which the zenon Runtime is running 

 In the zenon network: 
$SCADA_SERVER1 Or computer name of the 

project server Server 1 
$SCADA_SERVER2 or computer name of the 
project standby server Server 2 
Computer name of the network client for the 
determination of orIdent. This is only taken into 
account if option Use SCADA network client 

orIdent in dialog Server is activated. 

Note: Do not use "localhost"; use the computer 
names from the operating system instead. 

The Hostname must not be empty if at least one of the 
following configuration settings has been configured. 

Default: empty 

Client IED name IED name of the IEC61850 clients as stated in the  SCD 
file and given there under RCB.RptEnabled.ClientLN. 

This input field is only for display and cannot be edited in 
the wizard. Therefore the Client IED name in this dialog 
is always grayed out. 

You can find additional information on the client IED in 
the Manage recipe assignments chapter. 

 

CLOSE DIALOG 

Option Description 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

 
 



Topics 

 

 

237 

 

 

Manage recipe assignments 

Reports can be assigned in the wizard using drag&drop. RCBs hosts can be assigned in the wizard. The 
host - an IEC850 driver that has been started on a certain computer - thus knows which RCBs it should 
use. 

As an option, the middle group of buttons can also be used for assignment. 

RCBs transferred from an SCL file can be assigned, edited and deleted. These changes in the wizard are 
transferred to the driver configuration in the zenon Editor. They are not written to the SCL file. 

ADD REPORT - DRAG&DROP 

Reports can be assigned to a connection in the list of drivers using drag&drop from the list of IEDs! 

1. Highlight the desired RCB in the tree view of the list of IEDs. 
To do this, expand the tree view of the connections if necessary. 
Multiple selection is possible. 

2. Hold down the mouse button and drag&drop the selected reports to above the desired host of 
the desired driver in the list of drivers. 
A host must be present in order to be able to assign reports to a driver. 

DELETE REPORT 

To assign a report to a connection: 

1. Highlight the desired report in the tree view of the list of drivers. 
To do this, expand the tree view of the connections if necessary. 
Multiple selection is possible, but only the last entry highlighted is edited. Editing or deletion of 
several reports is not possible. 

2. In the context menu of the node of the selected connection, select the Delete command. 

3. The report is deleted without requesting confirmation. 

4. The driver configuration is transferred to the zenon Editor configuration by clicking on the Apply 
button or when closing the wizard by clicking on OK. 

EDIT REPORT 

To edit the configuration of a report with the context menu: 

1. In the list of drivers, click on the desired report for which you want to change the assignment 
configuration. 

2. Expand the tree view of the list of drivers if required. 

3. Select the Edit... command in the context menu of the node of the selected host. 
The dialog to configure the report settings (on page 239) is opened. 
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4. Edit the existing entries in the input field Report settings. 

5. Confirm your input by clicking on the OK button. 
The dialog is closed. 

6. The driver configuration is transferred to the zenon Editor configuration by clicking on the Apply 
button or when closing the wizard by clicking on OK. 

CLIENT IED NAME - HOST NAMING 

If an instance of the RCB has been configured for a Client IED name the host naming is supplemented 
accordingly in the list of drivers. This Client IED name cannot be edited in the wizard. The Client IED 

name is visualized between two brackets next to the host name. Configuration of this name is not 
possible in the wizard. 

[Host name] (client IED name as configured in SCL file) 

 Example 

Example configuration of the Client IED name in an SCL file: 

<RptEnabled max="4"> 

<ClientLN iedName="SCADA_Standby_CLIENT" ldInst="LD0" lnClass="ITCI" 

lnInst="1"/> 

</RptEnabled> 

According to Edition 2 of the standard, the client with the corresponding ClientLN name is obliged to use 
the instance of the RCB if it is defined as such in an SCL file. RCBs of other clients are to be avoided. 

As soon as a host has been assigned a report with ClientLN, the host accepts this ClientLN name as its 
own. From this time on, this host can only be assigned reports without ClientLN or with the same 
ClientLN. 
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Dialog - manage reports 

Not all properties are available for the configuration of the dialog. Properties that are not available are 
grayed out. 

 

REPORT SETTINGS 

The form of the Use preconfigured (SCL) options property depends on the content of the SCL file. Find 
out more information in the chapter RCB attributes (on page 241). 
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Parameter Description 

Use preconfigured (SCL) options active:  
The driver activates a report without overwriting the data 
attributes of the RCB. The content of the SCL file of the 
server is defined as a result of this. The following data 
attributes are affected by this: 

 IntgPd 

 BufTime 

 TrgOps 

 OptFields 

Inactive:  
The driver writes the data attributes of the RCB during 
activation. 

 

Trigger options You can activate/deactivate the following trigger options 
regardless of one another. 

 TrgOp: data-change 

 TrgOp: quality-change 

 TrgOp: data-update 

 TrgOp: integrity 

 TrgOp: general-interrogation 

Note: Not all servers support TrgOps data-change and 
data-update together. TrgOp intergity can also lead to an 
unnecessary overload of communication if a an IntgPd 
(Integrity Period)  that is too short was defined in the 
server for RCB. In case of doubt, set TrgOps: data-change 
+ quality-change + general-interrogation. 

Note: not active if Use preconfigured (SCL) options is 
activated. 

Optional fields The Optional Fields are written on the server when a 
report is activated. These correspond to the bits in 
the OptFlds data attribute of the RCB. 

It is recommended that you activate "Sequence 

number", "Data set name", "Reason for inclusion" and 
"Entry ID". 

"Data set name" must be activated, because without 
this option the driver cannot evaluate the reports 
received. 

Note: not active if Use preconfigured (SCL) options is 
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activated. 

TIME OPTIONS 

Parameter Description 

Integrity period Time interval (IntgPd) in milliseconds in which the 
server sends an Integrity Report. 

Note: not active if TrgOp integrity is deactivated 
or Use preconfigured (SCL) options is activated. 
Because an Integrity Report does not normally 
contain value changes, it is expressly recommended 
that only one single report on the server is activated 
with TrgOp: integrity. With an activated 
integrity report, the server can detect a connection 
failure more quickly. zenon does not need this 
report. 

Note: not active if Use preconfigured (SCL) options is 
activated. 

Buffer time Time interval (BufTime) in milliseconds in which the 
server collects the data for a report. 

Note: not active if Use preconfigured (SCL) options is 
activated. 

 

  Information 

You can find a more detailed description of the Trigger options in the IEC850 driver 
documentation in the statically assigned RCB chapter. 

 

 
 

RCB attributes 

The RCB properties of an SCL file are transferred from the SCL file to the driver configuration by means 
of drag&drop. 
In doing so, the wizard checks the "IED.Services.ReportSettings" section of the SCL file and determines 
whether the following options exist:  

 optFields („Optional Fields") 
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 bufTime („Buffer Time") 

 trgOps („Trigger options") 

 intgPd („Integrity period") 

In addition, a check is carried out to see whether these options are defined as dynamic ("Dyn"). 

If the options are not defined in the SCL file, this is defined as ("Fix"). 

ALL RCB ATTRIBUTES ARE DYNAMIC 

If all these corresponding options are dynamic ("Dyn") the dialog is as follows: 

 

In this case, the "Use preconfigured (SCL) options" property is not active. 
The notice text underneath provides corresponding information. 

NON-DYNAMIC RCB ATTRIBUTES 

If the options are not just "Dyn" but also "Fix" or "Conf", the dialog is as follows: 

 

In this case, the "Use preconfigured (SCL) options" property is active and the RCB attributes (Trigger 

options, Optional fields, Time options) cannot be edited. 
The notice text below provides corresponding information on which RCB attributes a client should not 
exceed whilst they activate the report on the server. 
 

Dialog - Variables in dataset 

This dialog shows the content of the selected dataset. Selected datasets are those that are present in 
the RCBs that are currently assigned to the driver in the wizard. 

This content can be filtered and preselected. 
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Variables for the current zenon project can be created due to the pre-selection. 

 

VARIABLE PREFILTERING 

All content of the selected dataset is displayed in the preview window. 

By clicking on the buttons, the variables that are applied by clicking on the add or add all buttons in the 
list of variables to be created are prefiltered. A combination of the checkboxes and input field 
is possible. 

Parameter Description 

Functional Constraints (FC) The content available in the report is prefiltered on 
the basis of the selected Functional Constraints and 
displayed in the preview window. 

Prefilitering is activated by clicking the respective 
checkbox. Multiple selection is possible. 

Quality Variables Checkbox for prefiltering according to quality 
variables that correspond to the */q[ST|MX] data 
attribute. 

If the checkbox is activated, only quality variables 
are shown in the preview window. 

A combination with Functional Constraints (FC) is 
possible. 

Variable Search Input field for filter text. Only variables that contain 
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the text entered are displayed in the upper preview 
window. 

Prefiltering is already updated during entry in real 
time. 

ACTION BUTTONS 

Parameter Description 

Create Variables in the current zenon project configuration are 
created for selected entries. 

The dialog is then closed. 

Select all This button has no function and is not used in the current 
version of the wizard. 

Cancel Discards all settings and closes the dialog. 

PREVIEW WINDOW - LIST OF THE VARIABLES TO BE CREATED 

This area visualizes, in the lower area, a preview of the content of the selected dataset for which 
variables in the current zenon project are created by clicking on the Create button. 

Content from prefiltering can be be applied or removed by clicking on the buttons. 

Parameter Description 

add The selected entry is added to the list of 

variables to be created. 

add all All (pre-filtered) entries offered are added to the list 

of variables to be created. 

remove The selected entry is removed from the list of 

variables to be created. 

remove all All entries in the list of variables to be 

created are removed. 

Quality-REMA Linking of variables to a reaction matrix. 

If activated, the quality reaction matrix is linked to the 
variables that correspond to a */q[ST|MX] data 

attribute. 
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Configuration of the driver 

In the Editor, the driver saves its configuration in the TXT file as defined in Configuration file name. In 
Runtime, the driver gets its configuration from the copy of the file that the editor has provided. 



Topics 

 

 

246 

 

 

STRUCTURE OF A CONFIGURATION FILE OF THE DRIVER 

Line Description 

1 Number of configured servers 

2 – (m-1) Server configuration (see server configuration) 

m – n Possible further server configuration(s) 

SERVER CONFIGURATION 

Line Description Example 

1 Start of a server configuration (= *** SERVER ***) *** SERVER *** 

2 Number of items in this server configuration, 
abbreviated: CNTSRVITEMS 

44 

3 Net address 1 

4 Server name  RELAY1 

5 Primary IP address 192.168.250.22 

6 Primary IP port 102 

7 Polling rate 

Read interval in milliseconds 

1000 

8 Calling AE qualifier 12 

9 Called AE qualifier 12 

10 Calling AP title[0] 1 

11 Called AP title[0] 1 

12 Calling AP title[1] 1 

13 Called AP title[1] 1 

14 Calling AP title[2] 1 

15 Called AP title[2] 999 

16 Calling AP title[3] 999 

17 Called AP title[3] 1 

18 Calling AP title[4] -1 

19 Called AP title[4] 1 

20 Calling AP title[5] -12851 

21 Called AP title[5] -1 

22 Calling AP title[6] -12851 
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23 Called AP title[6] -12851 

24 Calling AP title[7] -12851 

25 Called AP title[7] -12851 

26 Calling AP title[8] -12851 

27 Called AP title[8] -12851 

28 Calling AP title[9] -12851 

29 Called AP title[9] -12851 

30 Max. auto used URCBs 

Maximum number of Unbuffered Reports (URCBs) that the driver 
activates with automatic assignment per Logical Device  

10 

31 * - in newer configurations 

With old configuration: names of the assigned  Buffered Reports 
(BRCBs), separated with commas 

* 

32 Use preconfigured (SCL) options 

0 = subsequently configured RCB settings (TrgOps, OptFlds, IntgPd, 
BufTm) are used 

1 = the RCB settings that have already been preconfigured in the 
IEC61850 server - in its SCL file - are used 

0 

33 Use Report-ID for RCB assignment 

0 = The RCB instances of the server are identified by name. 

1 = Report ID that is used instead of the report name in the dialog 
for  RCB assignment. 

0 

34 Use Authentication 

0 = no ISO-Authentication used 

1 = If active, the driver sends the Authentication String at 
establishing the connection. 

0 

35 Authentication String  

36 Alternative IP address  

37 Alternative IP port 0 

38 TrgOp data-change: 0 = inactive ; 1 = active 1 

39 TrgOp quality-change: 0 = inactive ; 1 = active 1 

40 TrgOp data-update: 0 = inactive ; 1 = active 0 

41 TrgOp integrity: 0 = inactive ; 1 = active 0 

42 TrgOp general-interrogation: 0 = inactive ; 1 = active 1 

43 GetNameList on DO 0 
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0 = Normal GetNameList 

1 = The driver reads the object model by requesting data objects 
(DO) for each Logical Node available in the server and each 
Functional Constraint (FC) defined in the IEC61850 standard. 

This option has been removed from the configuration dialog in 
version 8.00 and replaced with an automated method. 

44 Integrity Period 7000 

45 Buffer Time 500 

46 OptFlds  
Optional fields of the RCB 

73 

47 RCBs enable reties 

Cycle in seconds in which an attempt is made to activate RCBs that 
were not activated successfully again. Only present if CNTSRVITEMS 
>= is 45 

7 

48 Automatic Watchdog 1 

49 Data consistency scan 300 

50 Use SCADA network orIdend 0 

51 Number of client configurations  

52 – 
(m-1) 

Client configuration (see Client configuration)  

m – n Possible further client configurations  

CLIENT CONFIGURATION 

Line Description Beispiel 

1 Start of a client configuration (= *** CLIENTCFG ***) *** CLIENTCFG 
*** 

2 Number of Items in this client configuration 1 

3 Hostname (RT computer name) 

Name of the computer on which the driver is running that receives the reports 

WKS007 

4 ClientLN.iedName SCADA_Server1 

5 orIdent  

6 Number of RCB configurations 2 

7 – (i-1) RCB configuration (see RCB configuration)  

i – (j-1) Possible further RCB  configurations  

y Number of dynamic dataset configurations  
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k – (l-1) Dynamic dataset configuration (see dynamic dataset configuration)  

l – m Possible further dynamic dataset configuration  

RCB CONFIGURATION 

Line Description Example 

1 Start of a RCB configuration  
(= *** RCBCFG ***) 

*** RCBCFG *** 

2 Number of items in this RCB configuration 2 

3 RCB name or ID UP_CTRL/LLN0/urcb_QxCSWI1_Pos02[RP] 

4 Name of the dynamic data set. NEW_DYN_DATASET 

DYNAMIC DATASET CONFIGURATION 

Line Description Example 

1 Start of a dynamic dataset (= *** DATASET ***) *** DATASET *** 

2 Number of items in this dynamic dataset configuration 1 

3 Name of the dynamic data set NEW_DYN_DATASET 

4 Number of Object References of the dynamic dataset 2 

5 Object Reference UPCTRL/Q1CSWI1$CF$Pos 

6 – n Possible further Object Reference. UPCTRL/Q1CSWI1$ST$Pos 

 

3.3 Import - Export 

Wizards for export and import of data. 
 

3.3.1 FactoryLink import wizard 

The FactoryLink Import Wizard ports FaktoryLink projects into a zenon project configuration. 

The following FactoryLink components are supported for porting: 

 Variables 
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 Graphics files (*.bmp, *.png, *.gif, etc.) 

 Templates (incl. standard elements) 

 Mimics (incl. standard elements) 

  Information 

The current FactoryLink Import Wizard was implemented with VSTA for FactoryLink 
7.5 for zenon 7.50. This wizard replaces the previous VBA FactoryLink wizard. 

 
 

Install and call up wizard 

The FactoryLink Import Wizard is automatically installed as part of the zenon standard installation. 

WIZARD DISPLAY IN THE ZENON EDITOR 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

STARTING THE WIZARD 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 
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. 

2. Select the folder Export/Import. 

3. There, click on FactoryLink Import Wizard. 

 

4. Click on OK. 

The wizard starts with the start window. 

  Information 

The FactoryLink Import Wizard is only available in English. 
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Multi-user project 

The current project is checked after starting the FactoryLink Import Wizard. A warning dialog is 
displayed if the project is detected as being a multi-user project. 

 

Note: This dialog is only available in English.  
The buttons are displayed in the system language of the computer. 

Ensure that these requirements are met before you continue with the wizard. 

Parameter Description 

OK Confirms the warning dialog and starts the wizard with 
the Welcome start dialog (on page 254). 

Cancel Closes the wizard without requesting confirmation. 

REQUIREMENTS 

With a multi-user project, the Check out setting is active for the following node in the zenon Editor: 

 Variables 

 Screens 

 Frames 

  Attention 

If the Check out setting is not activated, the import will be unsuccessful. 

 
 

Preparation for export of project data from FactoryLink 

FactoryLink project data is exported in the FactoryLink program using the Display - Library Converter 
menu in the ClientBuilder application. Here, the desired libraries all all project data to be converted 
must be selected. 
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In addition, access to the bitmaps used in the project must be guaranteed. All files must remain in the 
folder structure that has been created and prescribed by FactoryLink . 

SCREEN AND MIMICS EXPORT FROM FACTORYLINK 

 

  Attention 

ASCII must be selected as a target format of the screens (Mimics). 
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Project import 

Welcome 

When opening the wizard, you get an overview page with a summary of the wizard functionality. 

 

NAVIGATION 

 

Navigation through the wizard is by clicking on the individual tabs, or with the mouse clicking on the 
arrow keys. 

Clicking on the Close button closes the wizard. The folder and files that have previously been set are not 
saved. 
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Import 

In the Import tab, you select the files and folders of the FactoryLink configuration. 

The labels in brackets correspond to the file or folder name of a standard FactoryLink configuration. A 
file selection dialog opens if the respective "..." button is clicked on. 

Note: It is not absolutely necessary to select all folders and files. 
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Parameter Description 

Language definitions (MLANG.DAT) File with language information of the FactoryLink 
configuration. 

The stating of this file is optional for multi-language 
FactoryLink project content. 

Once the file has been selected, the available languages 
can be selected in the Language for Import. 

An initial evaluation result is shown after the file has been 
selected in the output window: 

n languages found in the language file. 

Default: empty 

FactoryLink Standard: 

\FactoryLinkProjektName\Config 

Files\MLANG.DAT 

(from FactoryLink Client Builder) 

Variables (object.asc) File for variable definition(s). 

Individual variables are selected here. The object.asc 

file contains the definition of the variables used. 

Default: empty 

FactoryLink Standard: 

\FactoryLinkProjektName\Variables\asc\o

bject.asc 

(from FactoryLink Configuration Server - OPC Server 
Export) 

Graphics (Bitmap Files) Selection of the folder of the graphics used. 

Default: empty 

FactoryLink Standard: 

\FactoryLinkProjektName\Bitmap Files 

(from FactoryLink Client Builder) 

Templates (Templates Files) Default: empty 

FactoryLink Standard: 

\FactoryLinkProjektName\Template Files 

(from FactoryLink Client Builder) 

Mimics (Mimic Files) Default: empty 

FactoryLink Standard: 

\FactoryLinkProjektName\Mimic Files 

(from FactoryLink Client Builder) 
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IMPORT 

Parameter Description 

Language for import Drop-down list with the languages available. 

The drop-down list visualizes the available languages as 
contained in the Language definitions (MLANG.DAT) 
property. The drop-down list is empty if no MLANG.dat 
file has been selected. 

The number of languages read does not necessarily need 
to match the number of languages available in the 
mimics/templates for text elements. If the selected 
language is not available for elements in a 
mimic/template, it cannot be imported successfully. 

Default: 

 [empty] 

If no MLANG.DAT file is given. 

 DEFAULT 

Language(s) 

If a MLANG.DAT file is given. 

Note: If no language definition file is selected, or the 
"DEFAULT" value is selected, multilingual text 
information is not taken into account for the import. 

Import Starts the import from the configured files and folders. 

Not active if at least one .asc file or folder has been 
selected. 

OUTPUT WINDOW 

Evaluation results, errors and import steps are shown in the output window. 
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Output window 

The individual actions carried out by the wizard are listed in the output window. 

 

The list can be sorted by clicking on the respective column heading. A further click reverses the sorting 
order. 
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Parameter Description 

Action symbol Graphic symbol of the action: 

Timestamp Time stamp of the action carried out by the wizard. 
Format: DD.MM.YYYY hh:mm:ss 

Source Identifier or origin of the action carried out: 

 Import: 
Detailed description of the individual step, for example: 

 Adding file for import 

 Starting the import of the Templates. 

 Screen creation: 
Import steps for zenon screens. 

 Element creation: 

Notes for creating an element, for example: 

 An Element with the name [element name] 

already exists in the screen [screen name] 

 Graphics import:  
Searches through project configurations 

 Languages: 
Evaluation of the language definition (Language definitions) 

Message Short description of the action carried out. 

GRAPHIC SYMBOLS 

 

Parameter Description 

 General information about the current stage in the wizard. 

 Successful result for the action carried out 

 Error notice 

 Warning notice 
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Import 

Please note the following points in zenon when executing the wizard: 

 For the import of a FactoryLink project configuration, it is recommended that a new, empty 
zenon project is created in the Editor. This therefore precludes names of screens and frames 
being present twice before import. 

 No existing project configurations are overwritten in the zenon Editor during import! If there is 
already a corresponding projecting, a corresponding message is shown in the output window. 

 The variables are automatically mapped to the internal driver of the zenon project on import. 

 This way, the data types can be assigned to the available data types of the real driver first by 
means of multiple selection. 

 You then assign the imported variables to the desired real driver. 

 If variables are renamed in the zenon Editor, these are imported with the original names when 
the wizard is restarted. 

  Attention 

zenon symbols are not created. 

TEMPLATES AND MIMICS: 

Templates in FactoryLink must not be mixed up with frames in zenon. FactoryLink Templates 
correspond to screen templates in zenon. The FactoryLink Import Wizard treats Templates and 
Mimics the same, and creates screens and frames from this for the zenon project configuration, 
including standard elements. 

The following elements are supported in the process: 

 Text element 

 Circle/ellipse 

 Rectangle  
(including rounding) 

 Line 

 Polygon 

 Bitmap  
(becomes button with graphics) 
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List of importable objects 

The import from FactoryLink projects supports the following objects: 

 Variables 

 Names 

 Identification 

 Data type 

 Drivers 

 Always internal - Driver for internal variables 

 The import and creation of FactoryLink templates and mimics. 

 Import and creation of static picture elements: 

 Text element 

 Circle/ellipse 

 Rectangle  
(including rounding) 

 Line 

 Polygon 

 Bitmap  
(becomes button with graphics) 

 Import of MultiLang texts from text elements (for static text elements) 
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3.3.2 Welcome to COPA-DATA help 

ZENON VIDEO-TUTORIALS 

You can find practical examples for project configuration with zenon in our YouTube channel 
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an 
initial insight into working with different zenon modules. All tutorials are available in English. 
 

GENERAL HELP 

If you cannot find any information you require in this help chapter or can think of anything that you 
would like added, please send an email to documentation@copadata.com. 

 

PROJECT SUPPORT 

You can receive support for any real project you may have from our Support Team, who you can contact 
via email at support@copadata.com. 

 

LICENSES AND MODULES 

If you find that you need other modules or licenses, our staff will be happy to help you. Email 
sales@copadata.com. 
 

3.3.3 PDiag Import Wizard 

The zenon PDiag Import Wizard supports PDiag messages during import. This wizard can also serve as a 
template for your own expansions in this context. 

The PDiag Import Wizard is only available in English. 

  Attention 

This wizard does not support distributed engineering and is not available in multi-user 
projects. 

https://www.copadata.com/tutorial_menu
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Requirements 

The wizard imports an XML file exported from the Prozess Diagnose (PDiag) Simatic module. This 
export can be carried out in the Simatic Manager/process diagnosis with the Process diagnosis | Export 

menu item. 

The XML file created in this way is imported with the wizard in zenon. In doing so, variables that are 
based on the S7-TCP driver are created with the Alarm-S driver object type. Each message and each 
accompanying value corresponds to a zenon variable. 

Only UINT variables are imported as an accompanying value. In doing so, the message text is analyzed 
for the Simatic PDiag identifier "@1X%2d@", "@1X%3d@" und "@1X%4d@" and adapted for zenon 
accordingly. Use of the language table for dynamic text is also possible. In doing so, the texts outside the 
wizard are to be transferred to the zenon. 

This wizard also imports S7 graph messages that are automatically generated by PDiag and are thus also 
included in the XML file. 
 

Settings 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Open the Export/Import node. 
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3. Select PDIAG Wizard. 

4. Click on OK. 

The wizard starts with the welcome page. 

The wizard has the following tabs 

 Welcome (on page 265) 

 Settings (on page 266) 

 Finish (on page 268) 

To import an XML file. 
 

Welcome 

The Welcome tab contains a short explanation on how the wizard works and what is required. 

 

In order to get the the Settings (on page 266) tab, click on the Settings menu selection or on the arrow 
at the bottom left. 
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Settings 

You can adjust the import settings in the Settings tab. 
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Setting Description 

Driver Selection of the S7-TCP driver from the active project for 
which the import is to be carried out. 

PDIAG XML File Selection of the XML file to be imported. 

Identification Optional entry for variable identification. This entry can 
be filtered in the variable list. 

Net Adress Defines the net address for the zenon variable 
addressing. You can see the valid net address in the driver 
configuration. 

Alarm Group Sets the alarm/event group of the messages to be 
imported. 

Attention: The wizard does not create alarm/event 
classes in zenon independently. These must be manually 
created before the import. 

In IPA Active: Sets the Save in IPA database property for the 
variables. This transfers the messages to the industrial 
performance analyzer. 

use Identification also as prefix for variable Active: For the variable names of the alarm variables, 
the variable detection given in the wizard is used as a 
prefix for the variable names. This option supports unique 
variable names for projects with several drivers. 

Get Alarm Class Active: The message priority set in Simatic Manager is 

interpreted as zenon alarm/event class. 

Attention: The wizard does not create alarm/event 
groups in zenon independently. These must be manually 
created before the import. 

The import is started with click on Finish. This button is only active in the Finish (on page 268) tab. Click on 
Finish in the menu or on the arrow at the bottom left. 
 



Topics 

 

 

268 

 

 

Finish 

To start the import, click on the Finish button. 
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Import of messages 

Notices are given during the import: 

 

After the import has finished, there is a note stating how many variables were imported. 

IMPORTANT MESSAGES 

Message Description 

message text too long The alarm text is too long and will be cut to the valid length 
in zenon. 

creating attribute variable for dynamic 

limit text 
In addition to the message variable, an accompanying value 
variable for the dynamic limit value text is created. 
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3.3.4 Welcome to COPA-DATA help 

ZENON VIDEO-TUTORIALS 

You can find practical examples for project configuration with zenon in our YouTube channel 
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an 
initial insight into working with different zenon modules. All tutorials are available in English. 
 

GENERAL HELP 

If you cannot find any information you require in this help chapter or can think of anything that you 
would like added, please send an email to documentation@copadata.com. 

 

PROJECT SUPPORT 

You can receive support for any real project you may have from our Support Team, who you can contact 
via email at support@copadata.com. 

 

LICENSES AND MODULES 

If you find that you need other modules or licenses, our staff will be happy to help you. Email 
sales@copadata.com. 
 

3.3.5 WinCC Import Wizard 

The WinCC Import Wizard imports selected parts of an existing WinCC project to the currently loaded 
zenon project. 

  Attention 

 

The import of the WinCC project data is carried out using two programs: 

https://www.copadata.com/tutorial_menu
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 WinCC Graphics Converter (on page 275): exports WinCC screens, frames and symbols from 
WinCC in an XML file 

 WinCC Import Wizard (on page 278): imports 

 Data blocks (Structure TAGs), TAGs, alarms and archives directly 

 Screens, frames and symbols via XML files which were previously created with the help of 
the WinCC Graphics Converter (on page 275) 

 
 

Installation 

To execute the WinCC Import Wizard, you must first install all components. 

  Information 

You should NOT install zenon on the same computer as WinCC. 

INSTALLATION WINCC GRAPHICS CONVERTER 

In order to access the WinCC information, the WinCC Graphics Converter must be installed on the 
computer on which the WinCC project runs. The program is located on the zenon installation medium in 

folder \AdditionalSoftware\COPA-DATA WinCC Graphics Converter. 

After the installation you can find the converting tool for different WinCC versions under Start - All 

Programs - COPA-DATA - WinCC Graphics Converter. Always start the tool for matching version. 
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  Information 

For using the converter, .NET Framework 3.5 must be installed. When installing the 
converter, it is checked whether it is available. If the framework is missing, the 
installation is canceled. In this case first install .NET Framework 3.5 and then start the 
installation of the converter again. 

INSTALLATION OF THE WIZARD FOR ZENON 7.0  AND HIGHER 

The wizard is automatically installed together with the zenon Editor. No separate settings are needed. 
You can start the wizard right away in the zenon Editor under File - Wizards... and there under 
Export/Import. 

INSTALLATION OF THE WIZARD FOR ZENON 6.51 

As the wizard is not a part of 6.51 SP0, you must carry out the following steps for the installation: 

 Install at least Build 6 of zenon 6.51. You can request Build 6 from your sales representative. 

 Install the wizard together with the WinCC Graphics Converter. This setup installs the WinCC 
Graphics Converter tool and also the wizard if zenon 6.51 SP0 is installed. You can request the 
setup from your sales representative. 
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 After the installation, start the zenon Editor. The dialog for updating the wizard is displayed. The 
wizard is added to the VSTA workspace by starting the update. 
If you want to carry out this step later, you can return to this dialog in the zenon Editor via menu 
File - Update wizards.... To get to this dialog at any time. 

 

 Start the VSTA Editor in the zenon Editor in the File - Open VSTA Editor... and select, in the 
Project Explorer window, the References node. Carry out menu item Add Reference... in 
the context menu in order to add two missing references: 

 MSDASC: In the Add Reference dialog, you switch to the COM tab and add the Microsoft 
OLE DB Service Component 1.0 Type Library component to the project. 
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 ADODB: In the Add Reference dialog, switch to the Browse tab. Navigate to the folder 
C:\Program Files (x86)\Microsoft.NET\Primary Interop Assemblies 
and select file adodb.dll. 

 

Note: This screenshot is only available in English. 

 Now, in the Project Explorer window in the VSTA Editor, you can select the  WorkspaceAddin 
node and compile the add-in using the Buildcommand in the context menu. 

After the compiling was successful, the wizard is available in the zenon Editor under File - Wizards... and 
there under Export/Import. 
 

WinCC Graphics Converter 

The WinCC Graphics Converter makes it possible to select screens, frames and symbols in WinCC 
projects and export them as XML files. 

  Information 

At the moment XML files can be created from WinCC projects of versions 7.0 and 7.0 

SP1. 
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Welcome 

With the help of the WinCC Graphics Converter you can convert WinCC graphics files (PDL) to an XML 
format which the WinCC Import Wizard can read. Existing graphics information are saved as PNG files 
and WMF files together with the XML files and stored in a selected folder. 

To execute the converter: 

1. Click on Start. 

2. Go to COPA-DATA -> WinCC Graphics Converter 

3. Start the WinCC Graphics Converter. 

4. Follow the instructions of the wizard. 

 
 

Select .pdl files 

On this tab you select the PDL files which should be exported from the WinCC project. To do this: 

1. Click on the Select .pdl files button. 

2. Navigate to the project folder which contains the PDL files. 

Note: In order that the files can be selected, the WinCC project must be loaded on the 
computer! 

3. Select the desired files. 
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All selected PDL files are displayed in the preview window. 

 
 

Select output folder 

On this tab you select the folder in which the export files should be saved. To do this: 

1. Click on the Select output folder button. 

2. Navigate to the folder in which the export files should be saved. 
Note: You can create a new folder in the selection dialog 

 
 

Convert 

On this tab you can carry out the conversion. 

After the successful export copy the folder to the computer with the zenon project in which the data 
should be imported or make sure that the computer with the zenon project has access to the export 
folder. 
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WinCC Import Wizard 

The WinCC Import Wizard is started via the wizard dialog of the Editor and can be used to import the 
following WinCC elements: 

 Import of the Screens (on page 290) (the XML files created with the WinCC Graphics Converter 
(on page 275) are converted to frames, screens and symbols in zenon) 

 Import of the WinCC TAGs (on page 285) (only S7 TCP) 

 Import of the WinCC Structure TAGs (on page 283) (only S7 TCP) 

 Import Alarm Limits (on page 286) 

 Import Archive TAGs (on page 288) 

STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 
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2. Navigate to the node Export/Import. 

3. Select the WinCC Import Wizard. 

 

4. Start the wizard by clicking on OK 

The wizard is divided into areas: 

 Welcome (on page 280): Overview over the wizard. 

 Settings (on page 281): Settings for the connection to the WinCC project. After the connection 
has been established successfully, the tabs for the direct import are displayed: 

 Data Blocks (on page 283): Structure TAGs from WinCC 

 TAGs (on page 285): TAGs from WinCC 

 Alarm Limits (on page 286): Alarm classes and alarms from WinCC 

 Archive TAGs (on page 288): Archive files from WinCC 

 Screens (on page 290): Import of the screens from WinCC via the WinCC Graphics Converter (on 
page 275) 

 
 



Topics 

 

 

280 

 

 

Welcome 

The start page of the wizard informs you about all other import steps: 

 

The direct import of data is only possible after you have configured the connection to the WinCC project 
on tab Settings. 
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Settings 

On this tab you configure the connection to the WinCC project whose data should be imported. 

 

Parameter Description 

WinCC DB connection Configuration of the connection to the WinCC database. 

Connected with Display of the active connection. 

Connect Establishes a connection. 

New Connection Opens the dialog for configuring a new connection. 

Driver selection (S7 TCP) Configuration of the zenon drivers. 

Driver Selection of a zenon driver from the drop-down list. 

Create new Driver Opens the dialog for creating a new driver. 
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  Attention 

In order that the connection can be established, the WinCC project must be active or 
opened in the WinCC Explorer on the PC with which the connection should be established. 

CONFIGURATION OF THE CONNECTION 

To establish a connection: 

1. Click on the button New connection  

2. The dialog for the connection settings is opened 

 

3. On the Provider tab, select the provider Microsoft OLE DB Provider for SQL Server 

4. On the Connection tab: 

a) For server name enter the instance of the SQL server in which the WinCC project is located. 
For example: HOSTNAME\WINCC 
Important: The WinCC SQL server instance (sqlsrv.exe) must be enabled in the firewall. 
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b) For logon information enter your access data. At first you must create the access data with 
the help of SQL Server Management Studio in the SQL server instance. 
Important: Activate the option Allow saving password 

c) For database select the WinCC Editor project. This is the database name without the suffix _R 
Note: The project must be loaded and running in the WinCC Editor. Otherwise the project is 
not available in the SQL server. 

d) Test the connection 

5. Close the configuration dialog with OK 

6. after that you can establish the connection to the WinCC project in the wizard via button 
Connect. 

7. select a zenon driver 

 

After a successful connection and the selection of a zenon driver, the tabs for the direct import are 
displayed. 

 
 

Data Blocks 

On this tab you select the data blocks which are displayed in the WinCC Explorer under Data Blocks and 
then imported as data types to zenon. 
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The WinCC data blocks are grouped according to drivers and are displayed sorted according to block 
type and name. 

 

To import data blocks: 

1. select the desired data blocks 

2. click on Import Data Blocks 

RESULT 

Data blocks in WinCC: 

 

Data types in zenon 
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TAGs 

On this tab TAGs (S7) are selected and imported as zenon variables, which are displayed as Tag 

Management in the WinCC Explorer. The export can be carried out directely to zenon or to a CSV file. 

 

To import tags: 

1. select the desired TAGs 

2. Click on Import Tags or Export to CSV 

RESULT 

Tags in WinCC: 

 

Variables in zenon: 
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Alarm Limits 

On this tab alarm classes and limit values are imported: 

 Import Alarm Classes:  
Imports alarm classes to an existing global project. 

 Import Alarms:  
Imports alarm classes and groups to the local zenon project and creates variables for the limit 
values. 

IMPORT ALARM CLASSES 

Imports alarm classes from WinCC to a global project in zenon. The global project must already exist and 
must be active in zenon. 

 

To import alarm classes: 

1. select the desired alarm classes 

2. click on Import Alarm Classes 

RESULT 

Alarm classes in WinCC: 
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Alarm classes in zenon: 

 

IMPORT ALARMS 

With this kind of import all alarm classes and alarm groups are imported to the zenon project. The 
WinCC limit texts are replaced by limit value variables. 

 

To import alarms: 

1. select the desired alarms 

2. click on Import Alarms 

RESULT 

Alarms in WinCC: 
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Alarms in zenon: 

 
 

Archive TAGs 

On this tab TAGs which are entered under Tag Logging in the WinCC Explorer can be selected and 
imported. The import is carried out in one of the two newly created archives BINARY or ANALOG in the 
zenon project. 

  Attention 

TAGs are only created in the zenon archive if they were imported as TAGs beforehand. 

 

To import Archive Tags: 

1. select the desired Archive TAGs 

2. click on Import Archiv Tags 
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RESULT 

Archive TAGs in WinCC: 

 

Archives in zenon: 
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Screens 

In this tab you can import the XML files which were created with the WinCC Graphics Converter (on 
page 275) to the active zenon project. In zenon frames, screens and standard screen elements are 
created based on the information stored in the XML files and based on the WMF and PNG files which 
are stored in the folder. 

 

Parameter Description 

List of files Shows all existing files in the selected folder. 

Select Folder Opens the dialog for selecting the folder with the import 
files. 

Select All Selects all existing files on the screen. 

Import XML Starts the import. 

To import screens: 

1. select the desired XML files 

2. click on Import XML 
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RESULT 

Screens in WinCC: 

 

Screens in zenon: 

 

WHICH WINCC SCREEN ELEMENTS ARE AUTOMATICALLY CREATED IN THE ZENON 
EDITOR? 

STANDARD SCREEN ELEMENTS 

 Line 

 Polygon 

 Polyline 

 Ellipse 

 Circle 

 Elipse Segment 

 Pie Segment 
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 Elipse Arc 

 Circular Arc 

 Rectangle 

 Rounded Rectangle 

 Static Text 

TUBE OBJECTS 

 Polygon tube 

 T-piece 

 Double T-piece 

 Tube bend 

SMART OBJECTS 

 I/O Field 

 Graphic Object 

 Windows Objects 

 Button 

For all other WinCC objects a placeholder is created in zenon. 

ERROR HANDLING 

Errors when importing screens are displayed in the zenon output window when the Runtime files are 
created. 

Error message Error handling 

The symbol "could not be 

found in the symbol library"! 
A placeholder for non-interpretable elements has been placed in the 
screen. 

Background: For each non-interpretable element, a symbol is created in 
the screen using the wizard. This is not in the symbol library however. 
You therefore have the opportunity to check to see if elements 
(placeholders) in a screen still need work carried out on them. 

WRN:(FDV_RECETTE_TUNNE

L_TPOS_DETAILS_FOU2->(ZO

NE_CNS0)Variable: could not 

be found in the project! 

Signifies variable names, that are stored in WinCC in I\O Field Element 
but are not (including in WinCC) created as variables. 
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3.3.6 Welcome to COPA-DATA help 

ZENON VIDEO-TUTORIALS 

You can find practical examples for project configuration with zenon in our YouTube channel 
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an 
initial insight into working with different zenon modules. All tutorials are available in English. 
 

GENERAL HELP 

If you cannot find any information you require in this help chapter or can think of anything that you 
would like added, please send an email to documentation@copadata.com. 

 

PROJECT SUPPORT 

You can receive support for any real project you may have from our Support Team, who you can contact 
via email at support@copadata.com. 

 

LICENSES AND MODULES 

If you find that you need other modules or licenses, our staff will be happy to help you. Email 
sales@copadata.com. 
 

3.3.7 XML export wizard VSTA 

You export all desired modules of a project into a folder of your choice with the XML export wizard. An 
independent XML file is created for each module. 

  Attention 

 

The wizard is only available in English. 
 

https://www.copadata.com/tutorial_menu
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Starting the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Export/Import. 

3. There select the XML Export Wizard  

4. Click on OK. 

The wizard starts with the welcome page and displays: 

 brief instructions 

 the zenon version 

 the name of the project from which the export is taking place 

 Project GUID 
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 Project path 

 

 The arrow key takes you through the wizard step by step  
Alternatively, a click on the tab opens the respective setting 

 to activate the Export button, the Export XML progress page must be open 
 



Topics 

 

 

297 

 

 

Select XML files 

Select which module of the project is to be imported: 

 

 Click on Select Directory to define the folder for export 
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 Select the modules and elements that are to be exported by ticking the checkboxes (scroll down 
if necessary) 

 
 

Export 

To start the export: 

 Click on the button  Export 

 the desired modules are exported 

 The output window displays which modules are exported with what success 
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 The wizard closes automatically three seconds after the end of the export 

 
 

3.3.8 XML Import Wizard 

This wizard helps with importing variables, functions, screens and scripts from a XML file. 

  Attention 

This wizard does not support distributed engineering and is not available in multi-user 
projects. 

 
 

3.4 Language Table 

Wizards for language switching. 
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3.4.1 Language Table Wizard 

This wizard 

 Searches the active projects for translatable texts or key words (text marked with a @). 

 Writes key words that are found 

 either to the selected language table in the active project or 

 Optional in the global project. 

For reference purposes, at least on table (ZENONSTR.TXT) must be selected for the import. 

If texts without as @ character are found, these can be set as a key word in a project. To do this, a @ is 
written at the start of the text. 

Note: The wizard is only available in English. 

The Language Table Wizard replaces the Language Change Wizard (VBA). 
 

Calling up the wizard 

The wizard can also be selected directly in the dialog for starting wizards. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Language Table. 
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3. There select the Language Table Wizard. 

 

4. Click on OK. 

The wizard starts with the welcome page (on page 302). 
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Start window 

When opening the wizard, you get an overview page with English-language documentation for the 
wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys.  

Click on Cancel to close the wizard.  
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Settings 

 

IMPORT OPTIONS 

It is possible to select the following in the Import options group: 

 whether existing texts are to be overwritten in the selected language table, 

 whether translatable texts found are to be set as key words in the project (texts are marked in 
the project with a @) and 

 whether the language tables are to be used by the global project. 

SELECT LANGUAGE TABLES 

In the "Select language tables", depending on the setting of the "Add keywords to language table 
global project" option, the language tables of the active project or the global project are displayed. 
The key word is entered in the selected language tables as a text. At least one table must be selected. 
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PROJECT OPTIONS 

In the "„Project options" grouping, it is possible to select which project-related texts of key words are to 
be searched for. 

SCREEN ELEMENTS 

In the "„Screen elements" grouping, it is possible to select which screen elements are to be searched. 

 
 

Finish 

You start the search for translatable text and key words on this tab.  

 

To start the search, click on the Finish button.  

Depending on the options set in the settings, translatable text is searched for and written in the selected 
language tables. 
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3.4.2 Language Translation Wizard 

This wizard is for the preparation of data for the Project Translation Interface, a translation tool. 

In doing so, all relevant data for translation is prepared and compressed into a ZIP file. This ZIP file can 
then be unzipped in the Project Translation Interface and the language tables can be edited or 
supplemented. After editing, the ZIP file can be loaded into the wizard and the edited language tables 
can be reimported into the project. 

  Attention 

 

Note: The wizard is only available in English. 

 
 

Starting the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Language Table. 

3. There select the Language Translation Wizard 

4. Click on OK. 

The wizard starts with the welcome page (on page 306). 
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Start window 

When opening the wizard, you get an overview page with English-language documentation for the 
wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys.  

Click on Cancel to close the wizard.  
 

Export 

When carrying out the export, the wizard evaluates all texts from screen elements, limits and other 
project objects, which are marked as translatable text with a @.  
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These texts are prepared into an XML file and exported with the selected language tables as a ZIP file. In 
addition, a screenshot of all screens is created and also provided in the ZIP file. The ZIP file also contains 
the font lists of the selected project and those of the global project.  
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Button Description 

Zip Name: Name of the export file 

C:\ Save location of the export file. Click on button ... 
Opens the file browser for selecting a target folder.  

Liste Sprachdateien List field with the possibility to select the existing 
language files in the project. 

Select all Selects all entries in the list and activates the 
checkboxes. 

Deselect all Selects all entries in the list and deactivates the 
check boxes. 

Export Exports the files to the target folder. 

Is only active if one or more language tables are 
selected. 

Arrow left Goes back one tab in the wizard process. 

Arrow right Goes forward one tab in the wizard process.  

Cancel Closes the wizard without exporting. 

  

  Attention 

The following special characters must not be used in the screen names:   
: / \ * < >    

These special characters are removed and replaced by a serial number. 
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Import 

The ZIP file to be imported can be selected in this tab.  
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Button Description 

... Save location of the import file. Click on button ... 
Opens the file browser to select a file folder.  

List of language files List field with the possibility to select the language 
files to be translated and imported. 

Select all Selects all entries in the list and activates the 
checkboxes. 

Deselect all Selects all entries in the list and deactivates the 
check boxes. 

Import Imports the selected language tables in the current 
zenon project. 

Is only active if one or more language files are 
selected. 

Arrow left Goes back one tab in the wizard process. 

Cancel Closes the wizard without importing. 

  

  Attention 

If a new language file is added in zenon 6.51, the project must be reloaded in the 
workspace once the wizard has been ended.  

The language files are automatically updated in version 7.00 SP0 onwards.  

 
 

3.4.3 System Text Wizard 

The System Text Wizard allows the import of system text into the language table. System texts are 
Runtime texts  that are used in zenon dialogs and menus and cannot be changed by the user. In order 
to be able to make these texts, which are predetermined by zenon, compatible with language switching, 
these texts must first be imported into the language table with this wizard. The number of imported key 
words and texts can be limited by means of an option in the wizard. 

  Information 

The wizard is only available in English. 
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Calling up the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Language Table. 

3. There select System Text Wizard. 

4. Click on OK. 

The wizard starts with the welcome page (on page 312). 
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Start window 

When opening the wizard, you get an overview page with English-language documentation for the 
wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys.  

Click on Cancel to close the wizard.  
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Settings 

The settings for importing the system texts are combined together in the "Settings" tab.  

 

PROJECT SETTINGS 

Option Description 

Overwrite existing language table  Active: Texts with existing key words are 

overwritten. 

Add keyword to language table global project  Active: System texts are written to the language 
table in the global project. 

 Inactive: System texts are written in the language 
table in the local project. 

Select keyword language Selection of the language for the key words from a 
drop-down list.   
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SELECT LANGUAGE 

Selection of the languages and the attendant language file. The languages supported by zenon are 
available. 

To select a language: 

1. Activate the checkbox in front of the desired language. 
Multiple selection is possible. 

2. Select the appropriate language file in the drop-down list. 
Caution: The language must file have have already been configured in zenon.  

SELECT CATEGORY 

Selection of the modules and functions for which symbol texts are to be imported. To select an object, 
activate the check box in front of the entry.   
 

Finish 

You start the import in this tab.  

 

To start with the import, click on the Finish button. 
The configuration of the wizard can be saved for future use on closing.  
 

3.5 Metering Point Administration 

Wizard for the configuration of metering points in the Editor. 
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  Information 

This documentation also contains information for the operation of the metering 

point administration module in zenon Runtime. 

 
 

3.5.1 Metering Point Administration 

 

The Metering point administration is a tool to manage technical data and administer metering points. 

 In zenon Editor, the project configuration is created with the Metering Point Administration 

Wizard (on page 320). 

 For display in Runtime, a corresponding ActiveX element (on page 363) is configured in the 
Editor in any desired zenon screen. 

 Meters can be assigned to metering points in Runtime, meters can be replaced and values can 
be (manually) corrected. 

 In addition, there is the possibility to transfer archive entries from existing source archives to a 
target archive, using a validation process in Runtime. 

The wizard is available in the following languages: 

 English 

 Romanian 

 German 

 Chinese 
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General - project configuration 

 

To use the metering point administration, the following project configuration steps are necessary: 

1. Configure variables in zenon Editor. 
Note: corresponding variables for relative values can also be created in the wizard directly. 

2. Configure archives in zenon Editor. 
Note: Archives can also be created directly in the wizard. 

3. In zenon Editor, start the Metering Point Administration wizard. 

4. Create metering points and meters in the wizard. 
Note: Meters can also be created in Runtime. 

5. In the wizard, assign the metering points to absolute value variables and relative value variables 
from archives. 
Note: Relative values can also be calculated automatically. 

6. Configure a screen in zenon Editor. 

7. Place an ActiveX element (on page 363) in this zenon screen. 

8. Assign meters to the corresponding metering points in Runtime. 

9. If necessary, enter current values for manual metering points in Runtime for the meters. 
 

Install and call up metering point administration 

The Metering Point Administration is automatically installed as part of the zenon standard installation. 
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STARTING THE WIZARD 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Metering Point Administration. 
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3. Then click on Metering Point Administration. 

 

4. Click on OK. 
 

Wizard - start dialog 

The Metering Point Administration wizard starts with the welcome page in English. 
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When starting the Metering point Administration in the zenon Editor, a check is first made to see 
whether zenon Logic Workbench is open. To avoid incorrect configurations, you are requested to close 
zenon Logic Workbench if it is open. The wizard cannot be started if Workbench is open! 

 

 To continue, click on the Metering Point Administration button. 
The dialog switches to the configuration dialog for metering point administration. 

 Clicking on the Exit button closes the wizard. 
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Wizard - Metering Point Administration 

 

Once the start dialog for the wizard has been confirmed, start the configuration of the metering point 
administration. Configuration starts with the Database tab. 

Initially, all activated zenon projects of the workspace and the attendant databases are loaded. This 
loading process is visualized with a progress bar. 

 

If database settings have already been saved, an attempt to establish a connection is started 
automatically when the wizard is called up. If this is successful, a switch to the Measuring points tab is 
made. If the establishment of a connection is unsuccessful, a corresponding error message is shown. 

Navigation through the tabs is carried out by clicking on the title of the tab. 

It is possible to select from German, English or Romanian in the drop-down list for the display 
language. 
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Parameter Description 

Database (on page 322) Tab for the settings of the necessary database 
connection. 

Metering Points (on page 327) Tab for the creation and administration of metering 
points in zenon Editor. 

Each metering point is assigned corresponding archives 
and variables. 

Counter (on page 356) Tab for the creation and administration of meters. 

Display language Drop-down list to select the display language for the 
wizard. 

 Deutsch 

 English 

 Română 

 Chinese 

CLOSE DIALOG 

Button Description 

Exit Closes the wizard. 

Changes that have not been saved are lost. 

  Information 

Settings changed in the wizard are saved in the user profile of the operating system 
and loaded at the next opening by the same user. 
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Database 

You configure the communication settings for a database in this tab. 
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Parameters Description 

Database Host Drop-down list for the selection of the database server. 

Select, for example, your computer in this field. Note: 
Your computer is shown as a default when the tab is 
opened. 

Authentication Drop-down list for selection of the login method: 

 Windows Authentication (Default): 
The login to the database is carried out with 
the information of the user logged in to the 
local computer. 

 SQL Server Authentication: 
User name and password are entered 
manually. The corresponding login data must 
be available for database login. 

User name  User name for login to a database. 

Grayed out if the authentication is Windows 

Authentication. 

Password Password for login to a database. 
For security reasons, each letter is shown with a * when 
the password is entered. 

Grayed out if the authentication is Windows 

Authentication. 

Connect Establishes the connection to the configured database 
server. 

If no connection is possible (for example due to incorrect 
entry of user name and/or password), an error message is 
called up. 

Grayed out if it is already connected to a database server. 

Disconnect Disconnects an existing connection to a database server. 

Grayed out if no connection is active. 

Database Name Drop-down list to select a database. 

This list shows all available databases of the database 
server configured under Datenbank-Host. 

If this list is empty, there is no connection to a database 
server or there is no SQL database available on the 
selected computer. 

Start configuration Switches to the Metering point tab. 

If there is not currently a connection to a database, a 
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connection with the login information that has already 
been entered is established when clicking on the Start 

configuration button. 

If this input is incorrect or incomplete, no further settings 
can be changed in the Metering points or Meters tabs. 
A connection to a database is always necessary for this! 

CLOSE DIALOG 

Button Description 

Exit Closes the wizard. 

Changes that have not been saved are lost. 

  Information 

If there is already a connection to a database, all input fields are grayed out. 

 
 

Database - evaluation and amendment 

If a connection to a database is established, the structure of this database is evaluated immediately. 
Tables required for metering point administration are created automatically if required. The validation is 
carried out in the Editor and in Runtime. 

If amendments to the existing database are required, you are informed of this by means of a dialog. The 
dialog only appears if amendments are necessary. 

EVALUATION DIALOG 

 

 Confirm this dialog with Yes if the database is to be amended to the corresponding tables. 

 Cancel closes the dialog. No amendments are made in the dialog. Configuration of metering 
points is not possible. The wizard jumps to the Database tab. 
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VALIDATION OF THE ARCHIVES 

A validation is carried out on starting - errors are visualized. 

If a problem occurs when validating the archives, this is signaled by a red warning symbol next to the 
problematic element. You get a detailed description in the tool tip, if you move to the warning symbol 
with the mouse. 

EXAMPLE OF A VIEW - RUNTIME 

 

 
 

Industrial Maintenance Manager compatibility 

The functionality of the Industrial Maintenance Manager (IMM) can be used for meters in metering 
point administration. The IMM is used for the administration of machine and maintenance data. Service 
intervals can be planned and administered with ease. You can see at a glance which devices, items of 
equipment, machines, etc. have to be maintained today / this week / next month etc. Furthermore, the 
service work that has been completed in the past is also logged.  

When checking the database, the table names of an existing IMM project configuration are checked. If 
necessary, these names are amended after confirmation. 
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 Confirm this dialog with Yes if the table names are to be amended. 

 No closes the dialog. No amendments to the table names are made in the database. 
Configuration of metering points is possible. 

IMM TABLE NAMES: 

 Table for devices: Devices  

 Table for maint. works: MaintenanceWorks 

 Table for history: MaintenanceHistory 

 Table for documents: Documents  

  Information 

Project configurations from zenon version 7.20 are not affected by this. From version 
7.20, the table names for the Industrial Maintenance Manager can no longer be 
freely configured. 
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Metering Points 

New metering points are created in this tab and existing ones are administered. 
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Parameter Description 

New... (on page 329) Opens the dialog to create a new Metering Point (on page 
329). 

Edit... (on page 346) Opens the dialog to edit the selected metering point (on 
page 346). 

Delete (on page 347) Deletes the selected Metering Point. 

List of metering points List of the metering points that have been created, as 
configured in the dialog to create a new metering point 
(on page 329). 

Selection by means of clicking. The selected metering 
point is highlighted in color. Multiple selection is not 
possible. 

 Name 
Name of the metering point 

 Description 
Short description of the metering point 

 Location 
Location of the metering point 

 Automatic 
Active, if Metering Point behavior is 
automatic. 

 Metering point Type 
Type of the metering point 

 Calculation active 
Active if Calculate relative value has been 
activated. 

 Meter name 

 Meter description 

 Behavior 
Metering Point Administration 

 Relative value variable 
Assigned variable for the relative value. 

 Absolute value variable 
Assigned variable for the absolute value. 

You can find out more information in the dialog 
description (on page 329). 

Filter variable [...] (on page 354) Opens the dialog to select a filter variable (on page 354) 
that is used in Runtime for the filtering of metering 
points. In addition to the variable name, the name of the 
project from which the filter variable comes is shown 
here, separated by #. 
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CLOSE DIALOG 

Button Description 

Exit Closes the wizard. 

Changes that have not been saved are lost. 

 
 

Create new metering points 

Click, in the Metering points tab, on New to create a new metering point. 

The following dialog opens, in which you can configure the new metering point. 
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Parameter Description 

Name Name of the metering point. 

Mandatory field 

Description Description of the metering point. 

Optional entry 

Location Location of the metering point. 

Optional entry 

MeteringType Type assignment of the metering point. 

Optional entry 

Note: A list is kept with all the previously-configured 
metering point types. These types are displayed 
when the first applicable letter is typed. If the type 
that has been entered does not exist in the list, that 
type is added to the list (auto suggest). 

Metering Point behavior Option field for selection of the value entry 

 Automatic:  
When this option is activated, both cyclical 
and spontaneous archives can be selected 
for the absolute value. The values are taken 
from the variable. 
Relative values can be automatically 
calculated in due course. 
You can find further information on this 
behavior in the Relative value (on page 335) 
tab. 

 Manually:   
When this option is activated, only 
spontaneous archives can be selected for the 
absolute value.  
The meter values must be read and entered 
manually. 

 Validation: 
When activating this option, archive values 
can be confirmed or modified in Runtime. 
You can find further information on this 
behavior in the Validation (on page 339) tab. 

The following is applicable for automatic and 
manual metering point behavior: 

Note: The list of the archives and the list of variables 
for absolute and relative values is filtered according 
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to the metering point behavior. This means that, 
with manual metering point administration, only 
spontaneous archives or variables from 
spontaneous archives are displayed in the list of 
archives and variables. 

Attention: If you change the metering point 
behavior of an existing metering point, the absolute 
value variable and the relative value variable must 
be reselected. 

Project selection Drop-down list with projects from the current 
workspace in zenon Editor. 
Note: Archives and variables available are tied to a 
project. 

Select the desired project in this field. 

Absolute value (on page 331) Tab for the configuration of the absolute value of 
the metering point. 

Relative value (on page 335) Tab for the configuration of the relative value of the 
metering point. 

Validation (on page 339) Tab for the configuration of the validation. 

Summary (on page 344) Checking and conclusion of the configuration of 
metering point administration. 

 

NAVIGATION 

Parameter Description 

Cancel Discards all changes in all tabs and closes the dialog. 

 
 

Absolute value 
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In this tab, an absolute value variable is assigned to the metering point. 

 

Parameter Description 

Variable from archive  In the list of variables, variables from the selected archive 
(list of archives) are displayed. 

Select a corresponding archive and a corresponding 
variable for the absolute value. 

Attention: The calculation of substitute values must be 
activated for this archive. 

Add variable to archive Variables from the project are displayed. The selected 
variable is added to the selected archive. 

Attention: The calculation of substitute values must be 
activated for this archive. 

New archive Opens dialog for the creation of a new archive (on page 
348). 

Only active if Add variable to archive is active. 

  Information 

The options in this tab are not available if the metering point behavior is validation. 
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ARCHIVES (LIST) 

Here, you select an archive from which you want to have variables displayed or to which you want to 
add a selected variable. 

Note: Existing project configurations of archives are displayed in the list. In addition, it is possible to 
create a new archive directly in the wizard by clicking on the New archive (on page 348) button. 
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Parameters Description 

Short name Archive reference. 

Archive ID Archive name 

Type Archive type 

 Cyclic 
Archive is cyclical. 
Values are saved in configured time 
intervals. 

 EventTriggerd 
Archive is event-triggered. 
Note: Event-triggered archives can only be 
used for automatic metering points. 
Direct configuration of event-triggered 
archives in the metering point 
administration is not possible. 

 Value Change 
Archive is spontaneous. 
Each change to a value is immediately 
written to the variable in the archive. 
Hysteresis can be configured. 

Archive trigger Trigger in order to write values to an archive. 

Note: Only available with event-triggered archives. 

Cycle time Time interval in which values are written to the archive 
with cyclical scanning. 

Format:  

 n.A. 
If archive type is Value Change or 
EventTriggerd. 

 DD:HH:MM:SS 

 MonthWith monthly cycle 

Saving cycle Time interval between the creation of new archive 
files. 
Format:  

 DD:HH:MM:SS 

 Month With saving cycle set to „turn of 
month“. 

 YearWith saving cycle set to turn of year. 
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VARIABLES (LIST) 

Parameters Description 

Name Name of the variable. 

Measuring unit Measuring unit of the variables. 

Identification Identification of the variable. 

Driver Driver of the variable. 

Equipment Groups Equipment group that is assigned to the variable.  
Note: A variable can also be assigned to several 
equipment groups. 

NAVIGATION 

Parameter Description 

Cancel Discards all changes in all tabs and closes the dialog. 

 
 

Relative value 

In this tab, a relative value variable is assigned to the metering point. 
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Parameter Description 

Create variable A new variable is created for the relative value. 

Type: LREAL, driver: INTERN. 

Name Name of the new variable to be created. 

A valid name, based on the selected absolute value 
variable, is proposed. The name must be unique and can 
be given as desired. No special characters are permitted. 
A maximum of 256 characters can be entered. 

The entry is validated. The result of the validation 
(success or error) is shown next to the input field by 
means of a symbol. 

Note: Only visible if Create variable has been selected. A 
variable must be selected in the Absolute value tab, so 
that a proposed name is shown here. 

Variable from archive Shows list of archives and list of variables belonging to 
the selected archive: 

Attention: The calculation of substitute values must be 
activated for this archive. 

Add variable to archive Variables from the project are displayed. The selected 
variable is added to the selected archive. 

Attention: The calculation of substitute values must be 
activated for this archive. 

Calculate relative value Checkbox to activate the automatic calculation of 
relative values: 

Selection is optional with automatic metering 
points. 

Selection is automatically activated with manual 
metering points. This automatic preselection cannot 
be deactivated. 

Note: You can get further information on the 
automatic calculation of relative values in the zenon 
Logic (on page 399) chapter. 

New archive Opens dialog for the creation of a new archive (on 
page 348). 

Not active if Variable from archive is active. 

Archives Archives that were previously created in zenon 
Editor or with the New archive button are ready for 
selection in list form. Only cyclical archives are 
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displayed. 

 

  Information 

The options in this tab are not available if the metering point behavior is validation. 

ARCHIVES (LIST) 

Here, you select an archive from which you want to have variables displayed or to which you want to 
add a selected variable. 

Note: Existing project configurations of archives are displayed in the list. In addition, it is possible to 
create a new archive directly in the wizard by clicking on the New archive (on page 348) button. 
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Parameters Description 

Short name Archive reference. 

Archive ID Archive name 

Type Archive type 

 Cyclic 
Archive is cyclical. 
Values are saved in configured time 
intervals. 

 EventTriggerd 
Archive is event-triggered. 
Note: Event-triggered archives can only be 
used for automatic metering points. 
Direct configuration of event-triggered 
archives in the metering point 
administration is not possible. 

 Value Change 
Archive is spontaneous. 
Each change to a value is immediately 
written to the variable in the archive. 
Hysteresis can be configured. 

Archive trigger Trigger in order to write values to an archive. 

Note: Only available with event-triggered archives. 

Cycle time Time interval in which values are written to the archive 
with cyclical scanning. 

Format:  

 n.A. 
If archive type is Value Change or 
EventTriggerd. 

 DD:HH:MM:SS 

 MonthWith monthly cycle 

Saving cycle Time interval between the creation of new archive 
files. 
Format:  

 DD:HH:MM:SS 

 Month With saving cycle set to „turn of 
month“. 

 YearWith saving cycle set to turn of year. 
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VARIABLES (LIST) 

Parameters Description 

Name Name of the variable. 

Measuring unit Measuring unit of the variables. 

Identification Identification of the variable. 

Driver Driver of the variable. 

Equipment Groups Equipment group that is assigned to the variable.  
Note: A variable can also be assigned to several 
equipment groups. 

 

  Information 

The list of variables is hidden if Create variable is active. 

 

NAVIGATION 

Parameter Description 

Cancel Discards all changes in all tabs and closes the dialog. 

 
 

Validation 
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Variables from archives are configured for a validated metering point in the Validation tab. 

 

The parameters of this tab are only available if, in the Metering point behavior property, the 
Validation option has been selected. 
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Parameter Description 

Variable from archive In the list of variables, variables from the selected source 
archive (list of archives) are displayed. 

Select a corresponding archive and a corresponding 
variable for the measured value. 

Add variable to archive Variables from the project are displayed. The selected 
variable is added to the selected archive. 

Source archive List of the configured archives. 
Selection of the archive with the click of a mouse. After 
selection, the variables contained therein are displayed in 
the variable list. 

New archive... Opens the dialog for the creation of a new source 
archive (on page 348). 

Not active if Variable from archive is active. 

Variables List of variables: 

 Variable from archive: 
Variables from the selected source archive 

 Add variable to archive: 
Variable list of the loaded project. 

Source archive List of all configured  EventTriggered archives. 

New archive... Opens the dialog for the creation of a new target 
archive (on page 348). 

Note: Target archives are only EventTriggered 
archives by default. 

STANDARD TIME FILTER FOR VALIDATION 

Input field for selection of the validation time range. The time range set here is used in Runtime during 
validation as a time filter for the archive entries to be displayed. 

The time range comprises days and hours. 
Click on the desired range to highlight this for the change. Change the area with an entry or by clicking 
on the arrow keys. 

The following is applicable for entry: 

 Only whole numbers are taken into account. 

 Value entries with a comma are rounded up. 

 An hour entry >23 is corrected to 23. 

 A day entry > 1000 is corrected to 1000. 
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 Negative inputs receive the value 0. 

Parameter Description 

Days Time range of validation in days. 

Default: 1 

Hours Time range of validation in hours. 

Default: 0 

ARCHIVES (LIST) 

Here, you select an archive from which you want to have variables displayed or to which you want to 
add a selected variable. 

Note: Existing project configurations of archives are displayed in the list. In addition, it is possible to 
create a new archive directly in the wizard by clicking on the New archive (on page 348) button. 
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Parameters Description 

Short name Archive reference. 

Archive ID Archive name 

Type Archive type 

 Cyclic 
Archive is cyclical. 
Values are saved in configured time 
intervals. 

 EventTriggerd 
Archive is event-triggered. 
Note: Event-triggered archives can only be 
used for automatic metering points. 
Direct configuration of event-triggered 
archives in the metering point 
administration is not possible. 

 Value Change 
Archive is spontaneous. 
Each change to a value is immediately 
written to the variable in the archive. 
Hysteresis can be configured. 

Archive trigger Trigger in order to write values to an archive. 

Note: Only available with event-triggered archives. 

Cycle time Time interval in which values are written to the archive 
with cyclical scanning. 

Format:  

 n.A. 
If archive type is Value Change or 
EventTriggerd. 

 DD:HH:MM:SS 

 MonthWith monthly cycle 

Saving cycle Time interval between the creation of new archive 
files. 
Format:  

 DD:HH:MM:SS 

 Month With saving cycle set to „turn of 
month“. 

 YearWith saving cycle set to turn of year. 
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VARIABLES (LIST) 

Parameters Description 

Name Name of the variable. 

Measuring unit Measuring unit of the variables. 

Identification Identification of the variable. 

Driver Driver of the variable. 

Equipment Groups Equipment group that is assigned to the variable.  
Note: A variable can also be assigned to several 
equipment groups. 

 
 

Summary 

The configurations of a metering point are evaluated and concluded in this tab.  

The result is shown in the summary window in two fields. 
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SUMMARY 

Parameters Description 

Field for project configuration information The upper field contains a summary of the 
configuration of the metering point. 

The text information is distinguished by being 
displayed in different colors. 

Black text color Settings are correct. These are created and applied 
by clicking on Save & New.  

Red text color Errors in the configured settings must be checked 
once again and improved. 

No saving is possible in this case. 

Green text color New settings are created and applied. Saving is now 
possible. 

Blue text color Amended project configurations are shown in blue 
text. 

Orange text color Warning messages.  

Project configurations that are not recommended 
are shown in orange. 

Field for additional information General information about the steps carried out is 
shown in this field if available. 

The color coding of the texts is the same as in the 
field for project configuration information. However 
in this text field, only successful (green text) and 
faulty steps (red text) are shown. 

Save & New Accepts settings and creates the new metering 
point. All values are reset and it is possible to 
continue with the configuration of other metering 
points. 

If the project configuration in incorrect, 
corresponding project information is shown in the 
field for project configuration information. 

Cancel Discards all changes in all tabs and closes the dialog. 
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Edit metering points 

To edit an existing metering point, proceed as follows: 

1. Select a metering point that you want to edit in the Meter tab. 
The selected metering point is accented in color. 

2. Then click on the Edit button or double click on the desired metering point. 

The existing project configuration is shown in the dialog Edit Metering Point. 

3. Add additional information, administer the metering point as you wish and click in the Summary 
tab on Save & Close. 
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SUMMARY: 

 

Amended settings are shown in the summary in blue. 

 Clicking on Save & Close saves the amended settings. 

  Attention 

Ensure that the project is loaded when editing a metering point. Editing without a project 
destroys the metering point. 

 
 

Delete Metering Point 

To delete an existing metering point, proceed as follows: 

1. Select a metering point that you want to delete in the Meter tab. 

2. Then click on the Delete button. 

3. A warning dialog appears. 

4. Confirm the deletion by clicking on the OK button. 

5. The selected metering point is deleted. 
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WARNING DIALOG 

 

Parameter Description 

OK Selected metering point is deleted. 

Cancel Cancels deletion process. 
Warning dialog is closed without an action. 

 

  Information 

If an automatic metering point with automatic relative value calculation is deleted, 
the attendant project configurations (variables and code lines) are removed in zenon 
Logic. 

 
 

New archive 

The "New archive" button is visible: 

 If, in the Absolute value tab of the wizard, the Add variable to archive button is active. 

 If, in the Relative value tab of the wizard, the Create variable or Add variable to archive buttons 
are active. 
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If the Add variable to archive button is active in the Validation tab. 
The button is always active during validation of target archives. These archives have event triggered 
as the archive type by default. 

 

Parameter Description 

Archiv Short name Short name for the archive to be created. 

Maximum 2 characters, 0-9 or A-Z, must be unique. 

Attention: You cannot change the identification 
afterwards. 

Archive ID Name of the archive. 

Default: empty 

Archive type Type of recording: 

 Cyclic 
The data is written to the archive in the set 
interval (default). 

 ValueChange 
Record on change 

 Event triggered 
Is only available for target archives of the 
validation. 

Cycle time Define the cycle (days, hours, minutes and seconds) 
in which values for cyclical archives are to be read. 

Default: 15 minutes (for cyclical archives) 
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Monthly If active: The values are read in each time the month 
changes (monthly archive). 

Default: inactive. 

Saving cycle Define the cycle time (days, hours and minutes) in which 
new archive files are to be created. 

Default: 1 day 

Note: grayed out if cycle time is monthly 

Monthly If active: The archive file is saved each time the 
month changes 

Default: inactive. 

CLOSE DIALOG 

Parameter Description 

Save Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

 

  Information 

You can get further information about archives in the Historian manual, in the Edit 
archives chapter. 

 
 

Background information 

When creating new archives for absolute value and relative value variables in metering point 
administration, the duration of storage for archive files is set to the maximum possible value. 

This is necessary because manual editing via the metering point administration is not possible for 
non-evacuated archive files (in *.ARX format). This does not include data that has been evacuated to 
SQL; subsequent manual editing of this is always possible. 

  Attention 

Evacuated archive files in .ARX internal database format cannot be edited. You should 
therefore always select SQL database for evacuated archives. 
Note: You configure the evacuation in the Edit archive dialog in the Save.tab 
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RECOMMENDATION 

To keep the number of files to be stored within limits, it is recommended that you configure a 
sufficiently large save cycle. 

  Hint 

Always configure your save cycle >= 1 day. 
You can get further information in the Historian manual, in the Edit archive, Save 
chapter. 

OFFSET AND WAITING TIME 

To ensure correct archiving of the relative value, the metering point administration module carries out 
automatic project configurations. 

The following settings are set automatically: 

 Offset: 5 seconds (only for relative value archives) 
You can find further information in the Historian manual, in the Edit archive, Recording type 
chapter. 

 VACO waiting time: 10 seconds 
If an automatic measuring point calculation is activated for relative value, the waiting time of the 
VACO (on page 401) must be set to 10 seconds and the offset for new relative value archives to 5 
seconds.  
For existing relative value archives, the offset must be checked manually and amended 
accordingly.  
You can find more information in the VACO function block chapter. 

INFORMATION DURING PROJECT CONFIGURATION 

The corresponding information is shown during project configuration in the Summary (on page 344) tab 
for the Metering Points (on page 327): 

 Archive for absolute values should have offset 0 (corresponding warning message) 

 Relative value archive must have offset 5 (information, amendment is automatic) 

 Both archives should be different (corresponding waning message) 

 
 

Visualization of incorrect project configurations 
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If a problem occurs when configuring a project, this is signaled by a red warning symbol next to the 
problematic element. You get a detailed description in the tool tip, if you move to the warning symbol 
with the mouse. 

 
 

Checking the archives 

Archives used in the Metering Point Administration module are evaluated during project configuration. 

The archive configuration is checked as follows: 

 After the wizard has started, in the list of metering points. 
A cause for the incorrect project configuration could be editing the archive in zenon Editor 
directly. 

 When creating/editing metering points. 

 When creating a new archive using metering point administration. 
Validation is triggered by clicking on the Save button. 

CONFIGURATION CRITERIA FOR RELATIVE VALUE ARCHIVES 

Certain configuration criteria are applicable for automatic metering points for relative value archives. 
These criteria result due to the logic of the relative value calculation. 
Archives created with the wizard always correspond to these criteria. 

 The cycle time must not be greater than the save cycle. 

 The save cycle must be an integral multiple of the cycle time. 

 If monthly change is selected as a cycle time, the save cycle must be a monthly change or yearly 
change. 

 If monthly change is selected as a save cycle, the cycle time must be a maximum of 1 day. 

 
 

Examples 
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CYCLE TIME GREATER THAN SAVE CYCLE 

 

SAVE CYCLE NOT A WHOLE-NUMBER MULTIPLE OF THE CYCLE TIME 
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INCORRECT CYCLE TIME FOR MONTHLY SAVE CYCLE 

 
 

Link filter variable 

This dialog can be used to select a variable for filtering in Runtime. 

First, create a variable from the Intern driver with the String Data Type and sufficient String length 
(such as 500) in you project. 

Note: The filter is always updated if the variable is updated. 

 



Topics 

 

 

355 

 

 

Parameter Description 

Project selection Combobox to select the project. A variable from another 
project can also be selected as a filter variable. 

List of variables Selection of the variable by clicking. The selected 
metering point is highlighted in color. Multiple selection 
is not possible. 

 Name 
Name of the variable 

 Identification 
Identification of the variable 

 Driver 
Driver on which the variable is based 

No selection Deletes the variable selection and closes the dialog. 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

This variable is used for filtering in Runtime. You can find detailed information on this in chapterFiltering 
of meters by means of variable 
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Counter 

In this tab, there is the possibility to create new meters, to administer them and to display the meters 
that have already been created in a list. 
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Parameter Description 

New... Opens the dialog to create a new meter (on page 358). 

Edit... Opens a dialog to edit the selected meter (on page 360). 

Delete Deletes the selected meter. 

LIST OF THE CONFIGURED METERS 

Parameter Description 

Name Name of the meter. 

Description Description of the meter. 

Manufacturer Manufacturer of the meter. 

Meter type Type assignment of the meter. 

Serial number Serial number of the meter. 

Comment Note for the meter. 

Year of construction Year of construction of the meter. 

 

CLOSE DIALOG 

Button Description 

Exit Closes the wizard. 

Changes that have not been saved are lost. 
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Create new meter 

In this dialog (both in the wizard and in Runtime), meters are configured and existing project 
configurations are amended. 
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Parameters Description 

Name Identification of the meter.  

Mandatory field 

Description Description for the meter.  

Optional entry 

Note Note in relation to the meter.  

Optional entry 

MeteringType Type assignment of the meter.  

Drop-down list with types that have already been 
configured. This drop-down list also corresponds to the 
type list for the creation of a new metering point. 

Optional entry 

Manufacturer Name of the manufacturer of the meter. 

Optional entry 

Serial Number Serial number of the meter.  

Optional entry 

Year of construction Year of construction of the meter.  

Optional entry 

CLOSE DIALOG 

Parameters Description 

Save & New Saves the new meter. 

The dialog to create a new meter is then called up with 
empty content again. Other meters can be configured. 

Cancel Discards all changes and closes the dialog. 

Note: Once the entries have been saved, a new entry is written to the database and the new entry is 
added to the list. 

 
 

Configuration of a meter 

To create a new meter, proceed as follows: 

1. Click on the Meter button in the wizard 

2. Click on New. 
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3. The dialog to create a new meter or amend an existing one is opened. 

 

4. Enter the information about the meter. 

Note: Incorrect entries are signaled by a red warning triangle next to the input field. 
 

Edit meter 

To edit a meter that already exists, proceed as follows: 

1. Switch to the Meter tab. 

2. Select the corresponding meter in the list of the configured meters. 

3. Click on Edit. 

4. The Edit meter dialog is opened. 

5. Add any other desired information and administer the meter as you wish. 

6. Click on Save & Close. 
 

Delete meter 

To delete an existing meter, proceed as follows: 

1. Select a meter that you want to delete in the Meter tab. 

2. Then click on the Delete button and confirm the warning dialog with OK. 

3. The meter you have elected is deleted. 
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Note: If a meter is already connected to a metering point, it cannot be deleted. The Delete button is 
grayed out in this case. To delete a meter that has already been assigned, it must first be deleted from 
the metering point or replaced in Runtime. 
 

Multi-user projects 

The wizard for metering point administration in the zenon Editor does not support multi-user projects. 

If there are multi-user projects in the workspace, a dialog is shown accordingly when the wizard is 
started: 

 

Note: This dialog is only available in English. 

If there are only multi-user projects in the workspace, the following message is given: 

 

Note: This dialog is only available in English. 

CONVERT MULTI-USER PROJECT TO STANDARD PROJECT 

A multi-user project can be converted to a "non-multi-user" standard zenon project: 

1. Create a project copy: 
Select, in the context menu of the respective project, the Project -> Save as ... command. 
The dialog to back up the project data is opened. 

2. Give it a new name. 

3. The backed-up project is read back as a new "non-multi-user" project in the current workspace 
and created. 
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  Information 

If the project is in an association of multi-user projects, the project references must 
be taken into account. 

You can find further information in relation to this in the Project administration and 
workspace manual in the Replace project references chapter. 

 
 

Engineering in the zenon Editor 

In zenon Editor, configure an ActiveX element in a screen in order to be able to use metering point 

administration in Runtime. 

 

1. To do this, create a new screen in zenon Editor. 

2. Select the ActiveX element and draw an area in the screen with it. 

3. The Enter element dialog is opened. 

4. In this dialog, select MeteringPointControl.MeteringPointUserControl from the list of the 
ActiveX elements. 

Attention: The ActiveX element must be at least 900 pixels wide and 575 pixels high in order for it 
to be shown correctly in Runtime. 
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  Information 

You can find information about the ActiveX element in the Screens manual in the 
Screen elements/ActiveX chapter. 

 
 

Metering Point Administration in the Runtime 

The following is carried out in Runtime: 

 Configured metering points and meters are linked to one another. 

 New meters are created. 

 Existing meter information is amended. 

 Manual values are entered. 

 
 

Database 
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Parameters Description 

Database Host Drop-down list for the selection of the database server. 

Select, for example, your computer in this field. Note: 
Your computer is shown as a default when the tab is 
opened. 

Authentication Drop-down list for selection of the login method: 

 Windows Authentication (Default): 
The login to the database is carried out with 
the information of the user logged in to the 
local computer. 

 SQL Server Authentication: 
User name and password are entered 
manually. The corresponding login data must 
be available for database login. 

User name  User name for login to a database. 

Grayed out if the authentication is Windows 

Authentication. 

Password Password for login to a database. 
For security reasons, each letter is shown with a * when 
the password is entered. 

Grayed out if the authentication is Windows 

Authentication. 

Connect Establishes the connection to the configured database 
server. 

If no connection is possible (for example due to incorrect 
entry of user name and/or password), an error message is 
called up. 

Grayed out if it is already connected to a database server. 

Disconnect Disconnects an existing connection to a database server. 

Grayed out if no connection is active. 

Database Name Drop-down list to select a database. 

This list shows all available databases of the database 
server configured under Datenbank-Host. 

If this list is empty, there is no connection to a database 
server or there is no SQL database available on the 
selected computer. 

Start configuration Switches to the Metering point tab. 

If there is not currently a connection to a database, a 
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connection with the login information that has already 
been entered is established when clicking on the Start 

configuration button. 

If this input is incorrect or incomplete, no further settings 
can be changed in the Metering points or Meters tabs. 
A connection to a database is always necessary for this! 

CLOSE DIALOG 

Button Description 

Exit Closes the wizard. 

Changes that have not been saved are lost. 

  Information 

If there is already a connection to a database, all input fields are grayed out. 

 
 

Metering Points 

Metering points in zenon Runtime can be administered in this tab. 
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Parameter Description 

Assign Meter... (on page 367) Only active if the selected metering point has not 
been assigned a meter. 

History... (on page 374) Keeps a log of edited metering points and replaced 
meters. 

Replace Meter... (on page 367) Only active if the selected metering point has 
already been assigned a meter. 

Manual value input... (on page 376) Allows manual value input for the desired metering 
point. 

If, in the list of metering points, an automatic 
metering point is selected, the Manual entry of 

values button is grayed out. 

Manual post processing... (on page 379) Allows subsequent manual editing of relative values 
of metering points. 

Fix invalid values... (on page 384) Opens the Fix invalid values dialog. 

Allows the determination, display and correction of 
invalid values. 

Only available for automatic metering points. 

Note: Multiple selection of metering points for the 
correction of the values of several metering points is 
possible. 

Validation... (on page 388) Allows the taking and modification of values from a 
validation metering point. 

Only active if the selected metering point is 
Validation. 

Reload Loads zenon project configurations in Runtime and 
gets new settings from the database. 

List of metering points List of the created metering points. 

Selection by means of clicking. The selected metering 
point is highlighted in color. 

 Name 
Name of the metering point 

 Description 
Short description of the metering point 

 Location 
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Location of the metering point 

 Metering point Type 
Type of the metering point 

 Calculation active 
Active if Calculate relative value has been 
activated. 

 Meter name 

 Meter description 

 Behavior 
Metering Point Administration 

 Equipment groups 

 

  Information 

If a variable of a project is not available, this is signalized by a red warning symbol in 
the list view. In this case, check to see if a project with these variables is loaded. 

 
 

Assign, replace or remove meter 

In this dialog, individual meters can be assigned to a metering point, amended or removed. 
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With automatic metering points, the dialog for subsequent editing (on page 379) always opens when 
there is a change to the allocation of meters (new assignment, change, deletion). 

 



Topics 

 

 

369 

 

 

METERING POINT 

Parameters Description 

Name Name of the metering point.  

Cannot be changed in this dialog. 

Location Location of the metering point. 

Cannot be changed in this dialog. 

Description Description of the metering point. 

Cannot be changed in this dialog. 

Measuring unit Measuring unit of the metering point. 

Cannot be changed in this dialog. 

Meter type Type of meter. 

Cannot be changed in this dialog. 

MANUAL 

Parameters Description 

Date and time Date and time of the meter allocation or meter 
replacement. 

Default: Query time period, rounded up to a complete 
hour. 

Clicking on the drop-down list opens a dialog to 
select the date and time. 

Note: Only the entry of dates from 1. 1. 2000 is possible. 
Calls before this date are not valid and are signalized by a 
red warning symbol. 

Range The range of the absolute value variable. 

Min. Minimum input range. 

Cannot be changed in this dialog. 

Max. Maximum input range. 

Cannot be changed in this dialog. 
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Old value Value of the old meter at the time of replacement.  

Default: 0 

Note: Only visible when a meter is replaced.  

New value Value of the new meter at the time of replacement. 

Default: 0 

Note: If the entry is outside the input range of the 
variable (min./max.), the incorrect entry is automatically 
amended to the range. 

AVAILABLE METERS 

Parameters Description 

Available meters List of available meters  

All meters of the appropriate meter type that are not yet 
assigned to a metering point are displayed. 

Only one meter per metering point can be assigned. 

Select Assigns the selected meter and transfers its values to the 
Assign meter range. 

Delete Deletes the assignment of a meter to a metering point. 

The meter itself is not deleted and remains in the list of 
meters. 

ASSIGN METER 

Parameters Description 

Name Name of the assigned meter. 

Cannot be changed in this dialog. 

Description Description of the assigned meter 

Cannot be changed in this dialog. 

CLOSE DIALOG 

Option Description 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

 
 

Project configuration - meter assignment 
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To assign a meter to a metering point or to amend an existing assignment: 

1. Select a metering point in the list of metering points. 

2. Click on: 

a) Assign Meter if the meter has not yet been assigned to a meter. 

b) Replace Meter if the meter has already been assigned to a meter. 

3. The Assign Meter/Replace Meter dialog is opened. 

4. If there is a meter replacement or allocation, enter the current value of the newly-assigned 
meter in the New value input field. 
A warning dialog appears if this value is already present in the archive. 
Entries that do not correspond to the input range are automatically amended to the maximum 
or minimum value. 
Note: For automatic metering points, the value entered here in the dialog for subsequent 

editing is shown in green in the Absolute value column. 

5. In the event of a meter replacement or when a meter assignment is deleted: 
Also enter the current value of the meter to be replaced or deleted in the Old value input field. 
Entries that do not correspond to the input range are automatically amended to the maximum 
value or minimum value. 
Note: For automatic metering points, the value entered here in the dialog for subsequent 

editing is shown in green in the Absolute value column. 

6. Select a meter from the list of available meters. 
Note: All meters with the same metering point type as the selected metering point are displayed 
here. 

7. Configure the meter assignment: 

a) Click on the Select button to assign the selected meter to the metering point. 

b) Click on the Delete button to release a meter that has already been assigned from the 
metering point. 

8. The selected meter is: 

a) Applied in the Assign Meter area. 

b) Removed from the Assign meter area. 

9. Click on OK to end the assignment. 

10. The dialog is closed: 

a) For manual metering points: 
Absolute values are written to the absolute value archive. Corresponding relative values are 
calculated automatically and written to the relative value archive. 

b) For automatic metering points: 
The dialog for subsequent editing is opened. 
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Meter assignment for manual metering points 

Values are automatically written to the archive depending on the action: 

1. Assign meter: 
New value 

2. Remove meter: 
Old value 

3. Replace meter: 
Both values 
Note: Time stamp for replacement: 

a) Old value: Current time stamp 

b) New value: Two seconds later than the time stamp of the old value. 

RELATIVE VALUE CALCULATION 

The relative values are automatically recalculated. 

1. During assignment: 

a) Relative values between the new value and the last absolute value found before that are 
recalculated. 

b) Relative values between the new value and the first absolute value found after that are 
recalculated. 

2. During deletion: 

a) Relative values between the old value and the last absolute value found before that are 
recalculated. 

b) Relative values between the old value and the first absolute value found after that are 
recalculated. 

3. When replacing: 

a) Relative values between the old value and the last absolute value found before that are 
subsequently calculated. 

b) Relative values between the new value and the first absolute value found after that are 
recalculated. 

EXAMPLE OF A METER REPLACEMENT: 

Maintenance should be carried out every 11 operations. 

The last maintenance was carried out when the counter reading was 90. The current counter value is 99 
operations. 
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The next maintenance must therefore be carried out 2 operations later when the counter reading is 101. 

If the counter now breaks down, it must be replaced with another counter. This has the counter value 
12. 

Because the next maintenance is due 2 operations later, it is to be carried out when the counter reading 
is 14. 

WARNING DIALOG 

If a meter replacement is carried out at a time at which an archive entry already exists, this must be 
overwritten. A dialog warns of this. 

 

Parameters Description 

Yes Applies settings and closes the dialog. 

No Discards all changes and closes the dialog. 

Cancel Retains all changes. The changes are not carried out. The 
dialog remains open for corrections. 

 
 

Meter assignment for automatic metering points 

With automatic metering points, the post editing dialog (on page 379) always opens when amending the 
assignment of a meter. The values configured in the allocation dialog (Old value and New value) are 
shown in green in the Absolute value column. The respective time stamp is increased by two seconds. 

  Information 

The new values are only applied to the relative value archive after completion of the 
project configuration in the post editing dialog! 
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History 

The metering point history dialog shows the course of configuration of the selected metering point. 
Changes are not possible in this dialog. 

 



Topics 

 

 

375 

 

 

Parameter Description 

Name Name of the metering point. 

Cannot be changed in this dialog. 

Location Location of the metering point. 

Cannot be changed in this dialog. 

Description Description of the metering point. 

Cannot be changed in this dialog. 

MeteringType Type of the metering point 

Cannot be changed in this dialog. 

HISTORY 

Parameter Description 

Time Time of the meter assignment or the meter replacement. 

Old meter name Name of the old meter. 

Old meter value Value of the old meter. 

New meter name Name of the new meter. 

New meter value Value of the new meter. 

User ID ID of the user who has entered the meter replacement. 

User name Name of the user who has entered the meter 
replacement. 

Change type The change that has been made is shown. 

 Added 
When a meter is assigned for the first time  
= Assign Meter 

 Changed 
When a meter replacement is carried out  
= Replace Meter 

 Deleted 
The assignment of a meter has been 
removed. No new meter was assigned to the 
metering point. 

Close Closes the dialog. 
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  Information 

The history only shows changes of meter assignments for a metering point. 

Value changes are not displayed in the history. 

 
 

Manual value input 

Manual values can only be entered for manual (i.e. not automatic) metering points. With the manual 
value entry, values can be entered for a certain point in time. Value entries for the future are not 
permitted. 
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METERING POINT 

Parameter Description 

Name  Name of the metering point. 

Cannot be changed in this dialog. 

Location Location of the metering point. 

Cannot be changed in this dialog. 

Description Description of the metering point. 

Cannot be changed in this dialog. 

Measuring unit Measuring unit of the metering point. 

Cannot be changed in this dialog. 

Meter type Type of meter. 

Cannot be changed in this dialog. 

SETTINGS FOR MANUAL VALUE 

Parameter Description 

Date and time Date and time of the entry of the absolute value. 

Clicking on the drop-down list opens a dialog to 
select the date and time. 

Note: Only the entry of dates from 1. 1. 2000 is possible. 
Calls before this date are not valid and are signalized by a 
red warning symbol. 

Default: Query time point, rounded up to a complete 
hour. 

Value Absolute value of the manual meter. 

Note: If the entry is outside the input range of the 
variable (Min./Max.), this is signalized by a red warning 
symbol. 

Default: Last-saved absolute value in the 
archive. 

Range Range of the absolute value. 

Min. Minimum value of the absolute value variable 

Cannot be changed in this dialog. 

Max. Maximum value of the absolute value variable 

Cannot be changed in this dialog. 
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CLOSE DIALOG 

Option Description 

OK Applies settings and closes the dialog. 

Cancel Discards all changes and closes the dialog. 

 
 

Manual value input 

To enter values manually: 

1. Select a manual metering point from the list of metering points. 

2. Click on the Manual value input button. 

3. The Manual value input dialog is opened. 

4. Select the date and time of the manual value: 
To do this, click on the Date and time drop-down list or enter the corresponding time in the input 
field directly. 
Attention: Manual value entries must not be in the future! 

5. Enter the new value in the input field 
Note: The valid input range of the selected variable is shown under Range. 

6. Click OK to apply the new value with the configured time stamp. 

7. The value input is validated. 
A warning dialog opens if there is already a value for the selected time point. 

8. The relative values are automatically recalculated. 
The following takes place after the values are entered: 

a) From the entered value until the last absolute value found is subsequently calculated. 

b) From the entered value until the next subsequent absolute value found is subsequently 
calculated. 

DIALOG IN THE EVENT OF DUPLICATE VALUE ENTRIES 

If there is already an archive entry at the selected time point, this must be overwritten. A dialog warns 
of this. 
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Parameters Description 

Yes Applies settings and closes the dialog. 

No Discards all changes and closes the dialog. 

Cancel Retains all changes. The changes are not carried out. The 
dialog remains open for corrections. 

SHOW MANUAL ENTRIES 

  Hint 

To have manual value entries shown, use the Post-editing button. 

 
 

Manual post processing 

Values from an archive can be subsequently edited in this dialog. Missing entries for relative values can 
be interpolated in order to get continuous values and thus, for example, close gaps more quickly as a 
result. 
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If, for an automatic metering point, the meter is replaced or deleted, the dialog for subsequent editing 
also opens. 
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METERING POINTS 

Parameter Description 

Name  Name of the metering point. 

Cannot be changed in this dialog. 

Location Location of the metering point. 

Cannot be changed in this dialog. 

Description Description of the metering point. 

Cannot be changed in this dialog. 

MeteringType Type of the metering point 

Cannot be changed in this dialog. 

VALUES 

Parameter Description 

Time period Time range from relative values and absolute values that 
is to be displayed. 

From Start of the time query 

Clicking on the drop-down list opens a dialog to 
select the date and time. 

Note: Only the entry of dates from 1. 1. 2000 is 
possible. Calls before this date are not valid and are 
signalized by a red warning symbol. 

Default: Query time point - 2 h (rounded up to a full 
minute). 

to End of the time query 

Clicking on the drop-down list opens a dialog to 
select the date and time. 

Note: Only the entry of dates from 1. 1. 2000 is 
possible. Calls before this date are not valid and are 
signalized by a red warning symbol. 

Default: Query time point (rounded up to the next 
whole minute). 

Load Loads the archive files for the absolute and relative 
values for the selected time range and lists these 
individually in the list of archive entries. 
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Interpolate Calculates the relative values in the range between two 
selected absolute values. Selection of start and end by 
clicking and pressing the Shift key. 

Apply Writes the changes that have been made into the archive. 

Range Value range of the relative value. 

Min. Minimum value of the relative value variable 

Cannot be changed in this dialog. 

Max. Maximum value of the relative value variable 

Cannot be changed in this dialog. 

LIST OF ARCHIVE ENTRIES 

This list is empty when the dialog is called up. After the query time has been entered and the Load 
button is clicked on, the list is filled with the archive entries that are found. 

Parameter Description 

Time Time of the archive entry. 

Format: DD.MM.YYYY hh:mm:ss 

Absolute value Absolute value of the archive entry. 

Note: Values that are transferred from a meter 
assignment, a meter replacement or a meter deletion are 
shown in green. 

Relative value Relative value of the archive entry. 

CLOSE DIALOG 

Parameter Description 

Close Closes the dialog. 

 
 

Subsequent editing of values 

To edit values subsequently: 

1. Select the desired metering point in the Metering points tab. 

2. Click on the Post-editing... button. 

The post editing dialog is opened 

3. Select a time range. 
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4. Click on Load to load the archive data for the absolute and relative values for the selected time 
range. 

The value entries that are found are shown in the list. 

INTERPOLATE VALUES 

There must be valid absolute values in order to be able to interpolate values. 

1. Go to the list of archive entries and select the absolute values that you want to use for the 
calculation of relative values. 

2. To do this, hold down the Shift key and select the start and end values that are to be used for 
interpolation. 

3. Click on Interpolate to automatically calculate relative values between these. 

The new values are shown in the relative value column. 

4. Click on the Apply button to transfer the newly-calculated relative values to the archive. 

A dialog is called up if the start or end values for interpolation are not valid: 

 

ENTER RELATIVE VALUES 

1. Click on the list of the archive entries for the relative value that you want to change. 

The field to enter the relative value is unlocked. 

2. Enter the desired new relative value. 

The entry is validated. 

VALIDATION 

If the value entered is outside the valid input range, it is not possible to complete the entering of the 
values in the input field. This is visualized with a red warning symbol at the start of the line. You can get 
other error details in the tool tip if you move the mouse over the warning symbol. 

Note: empty value entries are not permitted. In this case, enter the figure 0. 
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Fix invalid values 

Invalid values are determined, displayed and corrected in this dialog. 

 

TIME PERIOD 

The time range for the determination of invalid values is configured in this area. 
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Parameter Description 

From Start of the time range to be examined. 

Selection from drop-down dialog or by direct input. 
Invalid entries are already corrected or suppressed during 
input. 

Format: Weekday, dd. month YYYY hh:mm 

Default: 1 day before calling up the dialog 

To End of the time range to be examined. 

Selection from drop-down dialog or by direct input. 
Invalid entries are already corrected or suppressed during 
input. 

Format: Weekday, dd. month YYYY hh:mm 

Default: Time the dialog is called up 

Search invalid values Starts the search for possible invalid values for the 
specified time range. 

The progress is shown in a bar during the search. The 
search can be canceled by clicking on the Cancel button. 

Note: A value is invalid if the 18 [INVALID] status bit 
is active for this. The relative value archive of the selected 
metering point is examined. 

List of invalid values List of entries found in the relative value archive with 
invalid values. 

Default: Empty with display text "No data to 
display". 

FOOTER 

Parameter Description 

Apply Starts the correction for the selected entries. 
Correction is visualized with a progress bar and can be 
canceled by clicking on the Cancel button. 

Correction overwrites the incorrect relative values in the 
archive. 

Note: Corrections are logged for each entry in the CEL. 

Relative value correction for the 

metering point [metering point name]: 

Start [date], end: [Date], Relative 

value: [Relative value] 

Not available if no value is selected for correction or 
correction is not possible for the selected value. 
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Close Closes the dialog. 

LIST OF INVALID VALUES 

All invalid values are shown in this list. 

 

 Consecutive incorrect values are compiled into one entry. 

 Entries that cannot be corrected are marked with a warning symbol (red circle or exclamation 
mark). 

 The possible reason for the prevention of automatic correction is visualized with a tool tip. 

 The view of the list can be configured: 

 Move the display width by clicking on the hyphen in the column view and moving the 
divider. 

 Arrange the columns by means of clicking the mouse and Drag&Drop. 

 The list can be sorted and filtered. 

 Sort by clicking on the column heading. 

 Filter by entering a filter term into the input field underneath the column heading. 
The filter criteria can be selected with the context menu 
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Parameter Description 

Metering Point Name of the metering point. 

Start Time stamp of the last valid absolute value. 

Start value Last valid absolute value before an invalid value. 

End Time stamp of the first valid absolute value after an invalid value. 

End value First valid absolute value after an invalid value. 

Number of values Number of invalid relative values in the entry. 

Interpolated value Value that is written to the archive on correction. 

Fix Checkbox for the activation of automatic correction. 

Default: inaktiv 

Note: Clicking on the checkbox in the column header activates 
correction for all entries. 

Not available if correction is not possible for the entry (warning 
symbol). 

TIME SELECTION DROP-DOWN DIALOG 

Drop-down dialog to select the start time and end time for the determination of the invalid entries. 
Selection by means of mouse click. 
Note: The drop-down dialog is only available in English. 
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PROGRESS BAR 

Progress bar when determining the correction of invalid values. 

 

INVALID VALUES 

Visualization and tool tip for values that cannot be corrected. 

 

 
 

Validation 

In the metering point validation dialog, all archive values in the selected time range are shown for the 
configured metering point in a list. 
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The individual values can be confirmed and modified. 

 

TIME PERIOD 

Time filter for the display of variables from the archive. 

Parameter Description 

From Validation start time.  
Selection via D 

to Validation end time 

Reload Updates the list of values with the configured time range. 

SELECTED VALIDATION 

Clicking on the Validate Selected button sets the validation type to confirmed for all selected entries. 

LIST OF VALUES 

The list of values shows all archive entries of the archives configured for the metering point. 

The list can be sorted and filtered. 

 Click on a column heading to sort the list. 
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 Another click reverses the sorting order. 

 Right clicking on a column heading activates the context menu for the configuration of filtering. 

Parameter Description 

Metering Point Name of the metering point as configured. 

Note: cannot be changed 

Time Time stamp of the archive value. 

Note: cannot be changed 

Source value Value from source archive. 

Note: cannot be changed 

Target value Target value as applied after validation: 

 The original value from the source archive is entered by 
default. 

 The target value is 0 if there is not yet any value in the 
archive. 

A new target value is entered: 

 By double-clicking in the entry's target value cell 

 By entering the target value in the cell manually. Input takes valid 
counter values into account. There is no check of the limit values. 

The validation type is amended to manipulated after the value has 
changed. 

Validation type Editing status of the value 

 Unedited: 
Value has not yet been confirmed or amended. 

 Edited: 
The target value has been amended. 
Note: Amended entries are shown in the list in blue. 

 Confirmed: 
Value has been confirmed. 
Note: Confirmed values are shown in green in the list. 
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CLOSE DIALOG 

Parameter Description 

Close Closes the dialog. 

Before the closing process, a check is carried out to see whether all 
loaded values have been confirmed or processed. 

If there are values in the list that have not been confirmed or 
corrected (validation type: unprocessed), this is shown with a 

dialog. 

Apply Applies settings and writes amended values to the archive. 

For each value that is written to the target archive, a corresponding 
CEL entry is also created. 

DIALOG - MISSING VALIDATION 

Clicking on the Close button instigates a check for the unprocessed validation type. If there are still 
entries with the unprocessed validation type present, this is shown in a notice dialog. 

Parameter Description 

OK Closes the dialog. 

Attention: Values that have not been applied are thus not 
transferred to the archive. 

Cancel Returns to the metering point validation dialog. 
Further configuration can be carried out. 

 
 

Validation - Operation in the Runtime 

In order to validate entries of a metering point in Runtime: 

 Go to the Metering Points tab: 
A list of configured metering points is shown. 

 Highlight the metering point with the validation action. 

 Click on the Validation button: 
The metering point validation dialog is opened. 
Opening this dialog can take some time depending on the size of the archive entries. This loading 
process is shown. 

 Validate the data: 

 Modify the corresponding entries with new values. 
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 Confirm the existing entries for which no changes are necessary. 
To do this, use multiple selection and the Validate selected button. 
Individual entries can be confirmed by double-clicking in the target value line. 

 Click on the Apply button to write your amendments to the target archive. 
Successful saving of the data in the target archive is visualized with a green tick next to the 
button. 
The status of an edited entry is set to manual value (MAN_VAL). 

 Carry out further amendments. 

 End the validation by clicking on the Close button. 
Before closing the dialog, the list is checked for entries that have not yet been confirmed. 

 The validation dialog is closed by clicking on the OK button. 

  Information 

Entries that have already been amended or transferred (validation type: 
validated) can be amended again. These get the edited validation type again 
after a change. Ensure that each change is transferred to the archive with the Apply 
button. 

 
 

Filtering of meters by means of variable 

You have the possibility to filter the list of metering points according to certain criteria. To achieve this, 
write a corresponding value to the filter variable (on page 354). 

  Hint 

You can define a filter string for each user and set this to the filter variable using a recipe 
when the user is logged in. 

You thus have each user only having the metering points that are relevant to them visible 
in the list. 

This filtering can also be used for more simple validation, in that all metering points that 
are not relevant to validation are removed from the filter and the remaining ones are 
automatically selected. 

The following is applicable for filtering: 

 A filter can be defined for each column 

 Individual filter strings are separated by # 

 The divider within a filter string is an empty space 

 The arrangement of the elements in the filter string is as desired 
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 All filtered entries are automatically selected with the SelectAll string 

Structure of a filter string 

Operator filter value column code 

OVERVIEW OF COLUMN CODES AND OPERATORS FOR FILTERING 

The following column codes and operators are available 

OVERVIEW OF THE COLUMN CODES 

Code Column 

na Name 

de Description 

lo Location 

mt MeteringType 

ca Calculation active 

mn Meter name 

md Meter description 

bh Behavior 

eq Equipment groups 

OVERVIEW FOR OPERATORS 

The number or string can be chosen to be used as an operator. 
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Number String 

0 None 

1 IsLike 

2 IsNotLike 

3 IsLessThan 

4 IsLessThanOrEqualTo 

5 IsEqualTo 

6 IsNotEqualTo 

7 IsGreaterThanOrEqualTo 

8 IsGreaterThan 

9 StartsWith 

10 EndsWith 

11 Contains 

12 NotContains 

13 IsNull 

14 IsNotNull 

15 IsContainedIn 

EXAMPLES 

Entry in the Name column contains the Com string: 
Value of the filter variable: na Contains Com 

Calculation active is set: 
Value of the filter variable: ca 5 True 

Entry in the Behavior column starts with Auto, automatic selection of the filtered entries: 
Value of the filter variable: bh StartsWith Auto#SelectAll 

Combination of all three filters: 
Value of the filter variable: na Contains Com#ca 5 True#bh StartsWidth Auto#SelectAll 

If a filter string contains invalid values, the other filter strings are nevertheless applied. 
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Counter 

Meters are administered in Runtime in this tab. 

 

Parameter Description 

New (on page 358)  Opens the dialog to create a new meter. 

Edit (on page 360) Opens the dialog to edit the selected meter. 

Delete (on page 360) Deletes the selected meter. 

LIST OF THE METERS 

Parameter Description 

Name Name of the meter that has been created. 

Description Description of the meter. 

Manufacturer Manufacturer of the meter. 

Meter type Meter type of the meter. 

Serial Number Serial number of the meter. 

Comment Note in relation to the meter that has been created. 

Year of construction Year of construction of the meter. 
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Create new meter 

In this dialog (both in the wizard and in Runtime), meters are configured and existing project 
configurations are amended. 
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Parameters Description 

Name Identification of the meter.  

Mandatory field 

Description Description for the meter.  

Optional entry 

Note Note in relation to the meter.  

Optional entry 

MeteringType Type assignment of the meter.  

Drop-down list with types that have already been 
configured. This drop-down list also corresponds to the 
type list for the creation of a new metering point. 

Optional entry 

Manufacturer Name of the manufacturer of the meter. 

Optional entry 

Serial Number Serial number of the meter.  

Optional entry 

Year of construction Year of construction of the meter.  

Optional entry 

CLOSE DIALOG 

Parameters Description 

Save & New Saves the new meter. 

The dialog to create a new meter is then called up with 
empty content again. Other meters can be configured. 

Cancel Discards all changes and closes the dialog. 

Note: Once the entries have been saved, a new entry is written to the database and the new entry is 
added to the list. 

 
 

Configuration of a meter in Runtime 

To create a new meter, proceed as follows: 

1. Click on the Meter tab. 
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2. Click on New. 

3. The dialog to create a new meter or amend an existing one is opened. 

 

4. Enter the information about the meter. 

Note: Incorrect entries are signaled by a red warning triangle next to the input field. 
 

Edit meter 

To edit a meter that already exists, proceed as follows: 

1. Switch to the Meter tab. 

2. Select the corresponding meter in the list of the configured meters. 

3. Click on Edit. 

4. The Edit meter dialog is opened. 

5. Add any other desired information and administer the meter as you wish. 

6. Click on Save & Close. 
 

Delete meter 

To delete an existing meter, proceed as follows: 

1. Select a meter that you want to delete in the Meter tab. 

2. Then click on the Delete button and confirm the warning dialog with OK. 
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3. The meter you have elected is deleted. 

Note: If a meter is already connected to a metering point, it cannot be deleted. The Delete button is 
grayed out in this case. To delete a meter that has already been assigned, it must first be deleted from 
the metering point or replaced in Runtime. 
 

Metering Point Administration in the zenon network 

If the metering point administration in Runtime is executed on a client and the primary server fails, the 
module is deactivated. A corresponding message is shown in zenon Runtime. 

 

Entry of dialogs that are still open at the time of the server failure are ignored. This ensures that there is 
no inconsistent data between zenon archives / Chronological Event List and the metering point history. 

The module is active again as soon as the primary server can be reached again. 

 
 

zenon Logic components of metering point administration 

The calculation of relative values with automatic metering points is implemented with the Calculate 

relative value setting active with zenon Logic. 

Necessary configurations are automatically applied by the metering point administration. You can find 
information about these automated steps in the Summary (on page 344) tab of the Metering Point 
Administration wizard in zenon Editor. You are informed of any problems that occur in this tab. 

 
 

Check for open zenon Logic Workbench 

When starting the Metering point Administration in the zenon Editor, a check is first made to see 
whether zenon Logic Workbench is open. To avoid incorrect configurations, you are requested to close 
zenon Logic Workbench if it is open. The wizard cannot be started if Workbench is open! 
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Note: This dialog is only available in English. 

 

Parameter Description 

Wiederholen Another check for open zenon Logic Workbench. If zenon 
Logic Workbench is not open, the wizard is loaded. 

If zenon Logic Workbench is still open, the error dialog 
appears again. 

Abbrechen Cancels the opening of the metering point administration. 

 
 

zenon Logic project configurations for metering point administration 

When creating automatic metering points with the Calculate relative value setting activated, the 
following actions are carried out in the background: 

CREATION OF A DRIVER  

1. Typ STRATONNG 

2. Name: MeteringPoint 

3. Amendment of the driver settings 

a) Host: localhost 

b) Port: 14731 
The port number is increasing by 1 for every loaded project if there are many projects in the 
workspace. 

CREATION OF A ZENON LOGIC PROJECT 

1. Name: MeteringPoint 

2. Host: localhost 

3. Port: 14731 
The port number is increasing by 1 for every loaded project if there are many projects in the 
workspace. 
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CREATION OF A PROGRAM IN THE ZENON LOGIC PROJECT FOR THE CALCULATION OF RELATIVE 
VALUES 

Name: RelativeValueCalculation 

Once configuration has been completed, the zenon Logic project and the zenon project are compiled. 

The zenon Logic Workbench must be closed during the configuration of a metering point in the wizard. If 
there is a problem, a corresponding warning message appears in the Summary of the wizard (on page 
344). 

  Attention 

All manual changes to the MeteringPoint driver, as well as the changes to the zenon 
Logic MeteringPoint  project (including RelativValueCalculation program) 
can lead to automatic relative value calculation no longer working. 

 
 

Apply changes in zenon Logic 

Changes to the configuration of metering points can lead to changes in the zenon Logic Program (on 
page 399). 

These changes are not applied in zenon Runtime by reloading. The current zenon Logic program is only 
loaded when Runtime is restarted. 

  Example 

Change to the cycle time of an existing archive. 

In order for correct calculations to take place for a metering point with calculated 
relative values (Calculate relative value property active), zenon Runtime must be 
restarted. 

 
 

VACO function block  

The VACO function block in zenon Logic carries out the calculation of relative values. 

When creating automatic metering points with the "Calculate relative value" setting activated, an 
instance of the function block is created in the zenon Logic program RelativValueCalculation for 
the corresponding metering point. If an automatic metering point with activated relative value 
calculation is deleted or the relative value calculation for an automatic metering point is deactivated, 
the attendant project configurations (variables and lines of code) are removed in zenon Logic. 



Topics 

 

 

402 

 

 

PROGRAMMING - SOURCE CODE 

//Instance for Metering Point MessstellenName 

VACO_MessstellenID(ANY_TO_LREAL({AbsolutVariablenName}),INT#1,{FunktionsTriggerVariabl

enName},T#5s,FALSE,0.0); 

{RelativVariablenName}:=ANY_TO_DatenTypRelativVariable(VACO_0001); 

{ArchivTriggerVariablenName}:=VACO_MessstellenID.TA; 

 
 

ArchivTrigger function block 

The ArchivTrigger function block carries out the necessary calculations (in the background) in order to 
trigger cyclical archives with the configured cycle time. 

If the project configuration of a cyclical archive for the metering point administration in zenon is 
changed, the zenon Logic program is automatically updated after the wizard is opened. 

PROGRAMMING - SOURCE CODE 

//Instance for Trigger RE 

Trigger_RE(ULINT#1420066800,ULINT#900,ULINT#28800,False,False,False); 

OUT_TF_RE:=Trigger_RE.TF; 

 
 

3.6 Pharmaceutical 

Wizards for the pharmaceutical industry. 
 

3.6.1 Pharmaceutical Wizard 

The pharmaceutical wizard enables the management of validated projects for the pharmaceutical industry. It 
summarizes the relevant settings necessary for a Good Manufacturing Practice (GMP) project. These settings can 
be managed and changed in the wizard. The settings are loaded into the wizard either via an existing project or via 
a configuration files. 

The following settings are managed: 

 General project settings 

 User Administration 
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 User Groups 

 Settings for the Chronologic Event List 

 Settings for the Alarm Message List 

 XML template 

Engineered settings in the wizard can be: 

 written back to the active project 

 saved in a new project 

 saved to a special configuration file 
These configuration files created in the wizard can be used over and over again and can be 
enhanced. However they can be only read and edited with the wizard. 

 
 

Starting the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Pharmaceutical. 

3. There select the Pharmaceutical Wizard  

4. Click on OK. 

The wizard starts with the welcome page (on page 404). 
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Welcome 

The tab Welcome informs you about performance and use of the wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys. 

Click on Cancel to close the wizard. All changes made to a file or project since the last saving are 
discarded. 
 

Settings 

In this tab: 

 Settings are loaded 
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 Project descriptions are adapted 
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Parameter Description 

Configuration Definition which project is edited. 

Load from active project Loads the settings of the active project in the workspace 
into the wizard. 

Load from configuration file Loads data from a saved configuration file (*.cof). The 
file is selected from the list. The list displays all available 
configuration files in the selected folder (Select 

directory). 

Info: The configuration files can only be read, created and 
edited with the wizard. 

Select directory Opens file selection dialog in order to select the folder in 
which the desired configuration files (*.cof) are 
available. They are displayed in the list below the button. 

Templates Settings for XML and XRS templates. 

Project description Information about the project as defined in property 
Project description of the dialog. 

It is taken over by the loaded project and can be edited. 
For checking purposes all changes are displayed on tab 
Finish (on page 429). 

Author Author of the project. 

Manager Project manager. 

Company Company. 

Comment Comment. 

 
 

Project properties 

Settings for: 

 Network 

 Authorization in the network 



Topics 

 

 

407 

 

 

 History of Changes 
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Parameter Description 

Network Network 

Properties for use of the project in a network. 

More in the online help. 

Active Network active 

 Active: The project is used as a network project. A server 
must be defined. 

 Inactive: The project is a standalone project. 

Default: Inactive 

More in the online help. 

Server name Server 1 

Only available if property Network active is active. 
Computer which establishes the connection to the hardware for 
network projects and which manages the project data. The clients 
connect to this computer. 

Clicking on ... opens the dialog with a list of the computers available in 
the network. 

Hint name: The IP address is not sufficient; the name of the computer 
must be entered. "localhost" must not be used as name. 
If the name is changed, it cannot be reloaded. It is updated only after 
the Runtime has been restarted. 

More in the online help. 
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Standby name  Server 2 

Only available if a computer has been specified in Server 1 property. 

Clicking on ... opens the dialog with a list of the computers available in 
the network. 
This computer takes over the role of the server in redundant systems 
in the event of a primary server failure. The failure is detected if the 
Primary Server does not react in the time defined in the  Network 

communication timeout property in the Startup Tool. An own buffer in 
the Standby bridges the downtime between server loss and switch 
thus preventing data loss. 

Hint name: "localhost" must not be used as name. 
If the name is changed, it cannot be reloaded. It is updated only after 
the Runtime has been restarted. 
Attention: Primary Server and Standby Server must have identical 
system times. 
More in the online help. 

 

Redundancy type  Redundancy type 

Only available if a computer has been specified in property Server 2. 

zenon supports two types of redundancy: 

 Software redundancy: The system consists of one PLC and 
two redundant control system computers. Both computers 
must have a connection to the PLC. Both computers 
communicate with the control and at the same time keep the 
data from the control updated. The communication to the 
control is managed by the computer which is the server. The 
server communicates bidirectionally, the standby 
communicates unidirectionally. If the Server crashes, the 
Standby Server takes over the bidirectional communication 
with the PLC. 

 Hardware redundancy: The system consists of two 
redundant PLCs and two redundant control system computers. 
Each server communicates bidirectionally with one PLC. Both 
computers and both PLCs are synchronizing their data. If one 
component in the first system crashes, the second system 
takes over. 

Default: Software redundancy 

More in the online help. 
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Network authorization Operating authorization 

Properties for the operating authorization in the network. 

More in the online help. 

Active  Bedienberechtigung aktiv 

Only available if property Network active is active. 
The authorization in the network makes sure that in the network only 
one station at a time can carry out active operations (e.g. change set 
values). Passive, reading access is always possible regardless of the 
option. 

 Active: 
Only one computer can operate the project at a time (e.g. 
acknowledge alarms, write set values). 

 Inactive:  
Several computers can operate the project at the same time. 

Default: Inactive 

More in the online help. 

Timeout for request [s]  Timeout for request [s] 

Only available if, for the Operating authorization in the network 
property, Global operating authorizations or Operating 
authorization via equipment model has been selected from the 
drop-down list. 
If the operating authorization in the network is blocked by a station, it 
can be requested by another computer. Within the time limit defined 
here the request must be answered. After the time expires without an 
answer, the requesting station automatically receives the 
authorization. 

Default: 60 Seconds 

More in the online help. 

Timeout for 

acknowlewdgement [s] 
Timeout for operating authorization [s] 

Only available if the Operating authorization in the network property 
has been configured. 
Within this time period, the computer (client) that has the operating 
authorization must report to the server. If this does not happen, the 
authorization is released automatically. 
Attention: This value must be smaller than the time defined in 
property Timeout [s]. 

Default: 60 seconds 

More in the online help. 
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History of changes History of Changes 

Properties for the history of changes. 

More in the online help. 

Active  History of changes active 

Active: Changes to the project are also logged. 
Inactive: Changes to the project are not logged. 
Default: inactive. 

More in the online help. 

Detailing level  Detailling level 

Only available if the History of changes active property has been 
activated. 

Selection of details levels from drop-down list. 

 Object: Only the object names of the changed objects are 
logged. Details concerning properties and their values are not 
displayed in the History of changes. 

 Properties: Additionally to the object names the changed 
properties and the new values are displayed in the history of 
changes. 

 Value changes: This setting causes the most detail level of 
logging. Not only the new value of a property is displayed but 
also the old one. This makes complete traceability of the 
changes of values possible. 

Default: Object 

Note: Amended values are cut to a length of 128 characters. 

More in the online help. 
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User administration 

Settings for the user administration: 
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Parameter Description 

User administration User Administration 

 

Project-related properties for user administration. 

More in the online help. 

Delete users Deleting users 

 

 Active: Deletion of a user in Runtime is permitted. 

 Inactive: Users can only be marked as deleted. The users 
remain in the list of users, but are no longer valid for 
operation in Runtime (in accordance with FDA guidelines). 

Default: active 

More in the online help. 

Minimum password length Minimum password length 

 

Minimum length of the password in characters. 

 Minimum: 0 

 Maximum: 20 

Default: 6 

More in the online help. 

Period of password validity [days] Password - period of validity [d] 

 

Enter a time period (in days) defining how long a password 
should stay valid. After the time expired, you must enter a 
new password.  

 Minimum: 0 - The password never expires and need not be 

renewed. For this setting the value 2147483647 is written 
to system driver variable "Days until password expires". 

 Maximum: 4294967295 

Default: 0 
Attention: For productions according to the FDA guidelines 
entry 0 is not allowed as the rules of the FDA demand a 
cyclic change of the password. 

More in the online help. 

Number of invalid user name inputs Max. user error 
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Number of permitted entries of a non-existent user name. 
The system is blocked if this number is exceeded. With the 
exception of administrators, no more users can log on. The 
system is automatically unlocked after an administrator logs 
on. A corresponding entry is made in the Chronological 
Event List (CEL). Changes to this value are only effective in 
Runtime after restarting. 

 Minimum: 0 

 Maximum: 65535 

Default: 3 

More in the online help. 

Number of invalid password inputs Max. password error 

 

Number of incorrect password entries. 
The corresponding user is blocked if this number is 
exceeded. The block can only be lifted by an administrator. A 
corresponding dialog is created in the Chronological Event 
List (CEL).  

 Minimum: 0 

 Maximum: 65535 

Default: 3 

More in the online help. 

User administration storage Saving the user administration 

Selected user storage Select where you want to save the user administration: 

 Project 

 Active Directory (AD) 

 Active Directory Application Mode (ADAM) 

ADAM connection string AD LDS connection 

 

Connection path to ADAM or AD LDS.  

You must enter the connection path in the following form: 
[PC name]:[port]/[organization] 

Example: w3k:50000/O=800,c=com 

More about the AD LDS in the online help. 
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More about ADAM in the online help.  

ADAM user identification AD LDS user name 

 

User name of a local user of the ADAM/AD LDS computer 
with administrator rights. 

More about the AD LDS in the online help. 

More about ADAM in the online help.  

ADAM password AD LDS password 

 

Password of the local user of the ADAM/AD LDS PC. 

More about the AD LDS in the online help. 

More about ADAM in the online help.  

Log out/log in Properties for log in and log out. 

Activate automatical logout Activate automatical logout 

 

 Active: The user is automatically logged out if there is no 
operation for the time period defined in the Time [min] 
property. 

 Inactive: The user is not automatically logged out by the 

system. 

Default: Inactive 

More in the online help. 

Activate temporary login Temp. login active 

 

Activation of temporary login for users who want to operate 
an element but are not logged in: 

 Active: A user who needs operating authorization is 
requested to enter their identification and password. To do 
this, the login screen or a modal dialog is called up, 
depending on the configuration. The user is automatically 
logged out again immediately after the operation 

 Inactive: The user who needs operating authorization is 
informed that they are not entitled to carry out this 
operation. 

Default: active 

Note: 
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 You can define the position and size of the modal dialog in the 
zenon6.ini file at [Befehlsgabe] Position =. 

 The login screen can be used instead of the modal dialog. 
This is defined with the Screen for Login with signature 
property. 

More in the online help. 

Locked buttons style Locked buttons 

 

Only available if the property is Temp. login active 
inactive. 
Defines the look of buttons that are locked due to the 
configuration of the authorization. Is combined in the 
Runtime for the operation of keys with property Interlocked 

buttons (graphical design). 

Possible formats: 

 Grey 

 Normal 

 Invisible 

Default: Normal 

More in the online help. 

 

Set names for authorization levels Conforms to property Rename authorization levels. 

You can assign a name to each of the 128 authorization 
levels. Click in the right-hand column in order to enable the 
renaming. 
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User groups 

On this tab you assign authorization levels to user groups. 

 

Parameter Description 

User groups List of user groups 

User group levels List of the authorization levels 

Delete Deletes selected object without confirmation message. 

Click on a user group in order to show its authorization level. Clicking on the level allows the editing of 
the authorization level. The name is automatically adapted. Click on an empty level to insert a new 
authorization level. 

When clicking on Delete , you can delete both the groups and the assigned authorization levels. At 
deleting no confirmation message is displayed. 
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CEL & alarms 

Configuration of the Chronological Event List and the Alarm Message List. 
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Parameter Description 

Chronlogic Event List and Alarm 

Message List 
Chronological Event List 

 

Properties for administration of the Chronological Event List 
(CEL). 

More in the online help. 

CEL active CEL active 

 

 Active: The Chronological Event List (CEL) is active in the 

Runtime. Events are recorded and the CEL is available. 

 Inactive: No event are recorded. 

Default: active 

Note: Changes take effect after the Runtime has been 
restarted. 

More in the online help. 

Update automatically Update automatically 

 

Only available if property CEL active is active. 

 Active: During the time the CEL is open in 
Runtime, amended events are immediately added 
when they occur. 

 Inactive: Whilst the CEL is open, amended 
entries are only added each time before a value is 
written to the PLC. In doing so, the value that was in 
the PLC before writing is entered as the actual value 
in the CEL.  
The new entries are added when the CEL is opened 
the next time. 

Default: active 

More in the online help. 

Print system messages Print system messages 

 

Active: At online printing system messages are also 
printed. 
Inactive: At online printing system messages are not 
printed. 
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Default: active 

More in the online help. 
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Long dynamic limit texts CEL Long dynamic limit value texts CEL 

 

Determines whether the comment field for dynamic limit 
value texts is available. The dynamic limit value allows you 
to include the current values of other variables in the limit 
value text of a variable. 

 Active: Dynamic contents will be stored in a file with the 
file format D*.CEL. It will be stored in addition to the file 
C*.CEL. The comment filed can therefore been used for 
comments. Dynamic limit value texts can have a maximum 
length of 1024 characters. 

 Inactive: The comment field is used for dynamic limit 
value texts and is therefore not available for comments. 
Maximum length: 80 characters. 

Default: Inactive. 

More in the online help. 

Signature text editable Signature text editable 

 

Active: A dialog to edit the signature text is opened in 
Runtime. 

Inactive: The signature text cannot be changed in Runtime. 

Default: Inactive 

More in the online help. 

Data storage CEL Data storage CEL 

 

Properties for saving Chronological Event List entries (CEL) 
in the main memory and to the hard drive. 

More in the online help. 
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Size of the ringpuffer Size of the ring buffer 

 

Only available if property CEL active is active. 

Size of the CEL ring buffer. If the ring buffer overflows 
(cel.bin), the the superfluous entries are removed. Tthe ring 
buffer can be saved manually via the Save ring buffer on 

change property  

 Minimum: 1 

 Maximum: 32767 

Default: 100 

Note: In the Runtime it is possible that more entries are 
displayed than you engineered as old entries are only 
removed from the CEL when the list is updated. 

More in the online help. 

Save CEL data Save CEL data 

 

Only available if property CEL active is active. 

 Ring buffer and historic data: All CEL entries 
(*.cel) are saved. 

 Only ring buffer: Only a defined number of CEL entries 
(cel.bin) is saved. The number is defined via property Size of 

the ring buffer. 

 Default: On CE devices only the ring buffer (cel.bin) is 
saved on the hard disk; on PCs the historic entries (*.cel) are 
also saved. 

Default: Default 
The files (cel.bin and *.cel) are saved in 
folder\project folder\computer 

name\project name. 

More in the online help. 
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Save ringpuffer on change Save ring buffer on change 

 

Selection of the type of data saving: 

 Active: Each change of the data of the Chronological 
Event List (CEL) triggers the saving of the data (cel.bin).  

 Inactive: Data of the CEL (cel.bin) are only when the 
Runtime is closed or when function Save AML and CEL ring 
buffer is executed. Recommended especially for low 
performance. Historic data (*.cel) can be saved 
independently at every value change. 

Note: If the property is set to active, this can lead to a 
considerable load being placed on the system - with flash 
disks most of all. If the property is set to inactive, this 
can lead to data being lost in the event of Runtime closing 
unexpectedly. Inactive Recommended especially for low 
performance. 

Default: Inactive 

More in the online help. 

Logging Logging 

 

General properties for the Chronological Event List (CEL). 

More in the online help. 

Alarm acknowledgement Alarm acknowledgement 

 

Only available if property Alarm Message List active is 
active. 
Active: If an alarm is acknowledged, an entry is created in 
the Chronological Event List (CEL). 
Inactive: Acknowledging an alarm does not trigger an 
entry in the CEL. 
Default: Inactive. 

More in the online help. 
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Function Set SW Function Write set value 

 

Only available if property CEL active is active. 

 Active: At successful writing of values to the hardware, a 
corresponding entry is entered in the CEL. 

 Inactive: The successful writing of values is not logged in 

the CEL. 

Default: Inactive 

Note: This setting only has an effect on Runtime if the 
writing of the set value is carried out using the Write set 

value function. 

More in the online help. 

 

Send recipes Send recipes 

 

Only available if property CEL active is active.  

 No logging: The changing of standard recipes and 
recipes of the Recipegroup Manager (RGM) is not 
logged in the CEL. 

 Log recipes: When sending a recipe, it is logged 
with the name of the recipe in the CEL. 

 Log recipes and values: When writing a recipe, 
it is logged in the CEL with: 

 Name of the recipe  

 New and old values of the variables 

 Names of the variable  

Default: no logging 

More in the online help. 
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Change recipes Change recipes 

 

Only available if property CEL active is active. 

 No logging:  
The changing of standard recipes and recipes of the 
Recipegroup Manager (RGM) is not logged in the 
CEL. 

 Log recipes:  
When changing a recipe, it is logged with the name 
of the changed recipe in the CEL. 

 Log recipes and values:  
The following is logged in the CEL when the recipe is 
changed: 

 Name of the recipe 

 New and old values of the variables 

 Names of the variable 

Default: no logging 

More in the online help. 

Alarm groups Alarm/event groups 

Add Adds the character string entered in the input field as new 
alarm/event group. Adding can also be carried out via key 
Enter. 

Remove Deletes highlighted alarm/event group. 

Alarm classes Alarm/event classes 

Add Adds the character string entered in the input field as new 
alarm/event class. Adding can also be carried out via key Enter. 

Remove Deletes highlighted alarm/event group. 

 
 

Templates I 

On this tab you can edit the following elements: 

 Screens 

 Data Types 
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 Color Palettes 

 Reaction Matrices 

 

In each right-hand list the XML files, which exist in the current configuration file for the element, are 
displayed and edited. 
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Buttons Function 

Right-hand list  

Export Opens the dialog for exporting XML files which were created in the Editor via 
command Exported selected XML. 

Import Opens the dialog for importing XML files which were created in the Editor via 
command Exported selected XML.  
Import is into the following folder: 
%ProgramData%\COPA-DATA\zenon8.00\Templates\PharmaWizard 

Delete Deletes XML files that have been created in the Editor using the Export selected 

XML command. 

Left-hand list  

Add  Adds templates from the left-hand list. As an alternative you can also carry out a 
double click on the template. 

Saving to the current project or to another project is carried out on tab Finish (on 
page 429). 

Remove Removes template from the list. 

 
 

Templates II 

On this tab you can edit the following elements: 

 Symbols 
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 Reports from the Report Generator 

 

In each right-hand list the XML files, which exist in the current configuration file for the element, are 
displayed and edited. Reports are saved as XRS files. 

Buttons Function 

Right-hand list  

Export Opens the dialog for exporting XML files which were created in the Editor 
via command Exported selected XML. 

Import Opens the dialog for importing XML files which were created in the Editor 
via command Exported selected XML. 
C:\\ProgrammData\COPA-DATA\zenon8.00\Templates\Pha

rmaWizard. 

Delete Deletes XML files that have been created in the Editor using the Export 

selected XML command. 

Left-hand list  

Add  Adds templates from the left-hand list. As an alternative you can also carry 
out a double click on the template. 

Saving to the current project or to another project is carried out on tab 
Finish (on page 429). 

Remove Removes template from the list. 
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Finish 

In this tab: 

 the project description is entered 

 you define how the changed engineering is saved 

 



Topics 

 

 

430 

 

 

Parameter Description 

Project description Information about the project as defined on tab Settings (on 
page 404). Display only, cannot be changed. 

Author Name of the engineer. 

Manager Name of the manager. 

Company Company. 

Comment Comments to the project. 

Save configuration settings Options for saving changes done by the wizard. 

Message field Messages about success/failure of save actions. 

... in current project All settings are loaded in the current project. With this the 
settings in the project are overwritten. 

... as new project A new project is created with the defined settings and the 
selected frames. You must first select a project name. 

... as fíle A new configuration file of file name *.cof is created. If the 
name of an existing configuration file is used it is overwritten. 

Attention: The created configuration files can only be read, 
created and edited with the wizard. 

Name Name of the configuration file. 

 
 

3.7 Project 

Wizards for: 

 Project creation (on page 443)   

 the compare of project backups (on page 430) 

 the creation of a project documentation (on page 467) 

 
 

3.7.1 Project comparison 

The wizard makes it possible to compare project backups. At this it is analyzed which objects and 
elements were deleted, added or changed. The result can be saved and displayed as XML or HTML file. 
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REQUIREMENTS 

The wizard can read in and compre project backups which: 

 were saved as zip file 

 were created with activated versioning 

 were created with activated XML export 

To activate versioning and XML export: 

1. Open the General node in Project Properties. 

2. Go to the  section Versioning. 

3. Activate the Versioning active property. 

4. Activate the XML export active property. 

TEMPORARY FILES 

During the compare the wizard unzips the project backup in the temporary fodler 
BackUpComparisonWorkingFolder. It is created in path 

C:\Users\Public\Documents\zenon_Projects\Worspace. This temporary folder is 
deleted when the wizard is closed. 
 

Starting the wizard 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 
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The selection window with the available wizards opens. 

 

2. Select the folder Project. 

3. There select the Backup Comparison Wizard 

4. Click on OK. 

The wizard starts with the welcome page (on page 433). 
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Welcome 

The tab Welcome informs you about performance and use of the wizard. 

 

The navigation through the wizard is done by clicking on the individual tabs or step by step by clicking on 
the arrow keys. 

Click on Cancel to close the wizard. 
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Settings 

On this tab the two project backups which should be compared are selected and the zenon modules 
which should be part of the compare. 
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Parameter Description 

Select project backups Selection of the backup files. 

Latest version Latest version. Click on button ... Opens the file browser to select 
a project backup. 

Note: Per default project backups are in folder 
%ProgramData%\COPA-DATA\SQL2008R2\BACKUP\[Pro

ject]; via export however they can be stored in any folder. 

Older version Older version. Click on button ... Opens the file browser to select a 
project backup. 

Select project modules Selection of the modules which should be compared. Selection 
takes place via activating the checkboxes in front of the module 
names. 

These settings are saved for each user individually and are 
available when the wizard is opened again. 

Arrow keys Click on the button to go to the previous or next tab. 

Cancel Closes the wizard. 
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Compare 

On this tab the project backups are compared on basis of the selected modules. 
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Parameter Description 

List field After you click on button Compare the differences of the 
project backups are displayed in the list field. 

Content of the columns: 

 Module: Name of the module. 

 Result: Name of the object. 

 Element: Display and description of the element. 

 Parameter: Name of the changed parameter. 

 Old: Previous value of a changed parameter. 

 New: New value of a changed parameter. 

Color-coded marking: 

 blue: new objects and elements 

 red: deleted objects and elements 

 green: changed objects and elements 

 black: unchanged objects and elements 

Navigation Elements for the navigation in the list. 

Changed elements Active: Click on the button with the vertical arrow in order to 

jump to the previous/next changed element. 

Deleted elements Active: Click on the button with the vertical arrow in order to 

jump to the previous/next deleted element. 

New elements Active: Click on the button with the vertical arrow in order to 
jump to the previous/next new element. 

Show only differences Active: After you click on button Compare only the 
differences are displayed color-coded; unchanged elements are 
not displayed. 

If this option is changed, you must start the compare again by 
clicking Compare. 

Compare Compares the project backups in accordance with the selection 
and displays them in the list field. 

vertical double arrow buttons Click on the button to jump to the previous/next module. 

Vertical arrow buttons Click on the button to jump to the previous/next result of 
the same type depending on the setting. 

 Changed elements 

 Deleted elements 

 New elements 

Horizontal arrow keys Click on the button to go to the previous or next tab. 
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Cancel Closes the wizard. 

EXAMPLE PROJECT COMPARE: 

ALL OBJECTS: 

 

Some changes: 

In module screens: 

 the screen batch  was deleted 

 in screen SYSTEM_2 a text element was changed 

 in screen START a button named Button_1 was added 

 in screen ALARM nothing was changed 
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ONLY DIFFERENCES:  

 

The changes are visible in the same way as in the previous screenshot. Objects and elements which have 
not been changed are hidden. 
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Documentation 

On this tab you can display and save the result of the project backup compare as XML file or HTML file. 
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Parameter Description 

Settings Settings for type of documentation. 

Create XML Active: An XML file is created. 

Create HTML Active: A HTML file is created. 

Save Path Path to the folder in which the file is saved. Display only. Selection is 
carried out via button Compare. 

Create documentation Click on button: 

 to open the file browser: Select the saving location and give a 
name to the documentation file. 

 The documentation is saved in the desired type and is displayed 
in the list field. 

List field Display documentation. 

Arrow button Click on the button to go to the previous tab. 

Cancel Closes the wizard. 

EXAMPLE XML FILE 

Display in the wizard: 
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Display as XML file: 

 

EXAMPLE HTML FILE 

At the creation of an HTML file, an XML and an XSLT file are also created at the saving location. These 
two files are used to generate the HTML file dynamically: 
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Structure of the HTML file: 

 
 

3.7.2 Project Configuration Wizard 

With this wizard you can create basic objects for new projects. You can configure: 

 Information about the project 

 Drivers also with driver variables 

 Graphics settings 

 Basic screens with symbols, WPF element, AML, CEL, system information and an overview of the 
simulation variables 

 Navigation 

Settings changed in the wizard can be saved in the operating system's user profile and loaded upon 
opening by the same user. 

The wizard is executed in English; the language in the project corresponds to that of the open zenon 
Editor. This wizard is automatically executed when a new project is created. 

MULTI-USER PROJECTS  

The wizard does not support multi-user projects. When a new multi-user project is created, the wizard 
is not automatically started. With a manual start, it is ended again with a warning message. 
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  Information 

If the wizard is selected manually via the Wizard selection dialog, then the following must 
be the case: 

 An empty project must be created 

 The project must be active 

 
 

Starting the wizard 

This wizard is automatically executed when a new project is created. It can also be selected directly in 
the dialog for starting wizards. 

  Attention 

The complete scope of wizard functions is only available for an empty zenon project. If 
the wizard is started in a project that already contains project configurations, only the 
creation of dashboards is supported by the wizard. 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 

The selection window with the available wizards opens. 

 

2. Select the folder Project. 

3. There select the Project Configuration Wizard 
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4. Click on OK. 

The wizard starts with the welcome page. 

If you call up the wizard from an existing project, you receive a warning: 

 

By clicking on Yes, you confirm that you accept changes to your existing configuration. 
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Welcome 

The Welcome tab provides a brief overview of the wizard's scope. 

 

The navigation (on page 447) through the wizard is done by clicking on the individual tabs or step by 
step by clicking on the arrow keys. 
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If the wizard is started in an existing zenon project in which changes have already been made, the 
following start page appears in the Welcome tab: 

 

Note: Instead of the Finish button, the Overwrite button is now shown, because data will be 
overwritten in the event of changes being made. 
 

Navigation bar 

You can go forwards or backwards by one tab with the navigation bar. 

View when the wizard is used the first time: 

 

View when the wizard is subsequently used: 
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Parameter Description 

Arrow keys Move one tab forward or back. 

Finish Creates project and overwrites possibly existing object. Only active if tab 
Finish is opened. 

Overwrite Replaces existing data in the project with the changes made in the 
wizard. Only active if the wizard is started in an existing zenon project in 
which changes have already been made. 

Close Closes the wizard.  
The made changes can be saved for the current user. 

 
 

Project Info 

On this tab you configure general project settings and settings concerning versioning and the History of 
Change. 
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Parameter Description 

Author Optional input field for the author of the project. 

Manager Optional input field for the project manager. 

Company Optional input field for the project company. 

Comment Optional input field for comments in relation to the project. 

BACKUP SETTINGS 

Settings for backup and versioning. 
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Parameter Description 

Versioning 
Active: Project versioning is used. Every project backup is saved 
with an own version number.  

Inactive: no versioning of the project backup. 

Default: Inactive  

More in the online help. 

Main version Input field for the number of the main version. All other versions 
continue to be counted from the number entered. 

Default: 0 

Activate XML export 
Active: At each project backup an zip file (version.zip) is 
inserted. It includes 24 XML files with the backups of the 
individual modules. 

Note: For multi-user projects only for local backups. 

Default: Inactive 

More in the online help. 

HISTORY OF CHANGES 

Settings for history of changes. 

Parameter Description 

Active History of changes active 

 

Active: Changes to the project are also logged. 
Inactive: Changes to the project are not logged. 
Default: inactive. 

More in the online help. 

Detailing levels Only available if the History of changes active property has been 
activated. 

Selection of details levels from drop-down list. 

 Object: Only the object names of the changed objects 
are logged. Details concerning properties and their values 
are not displayed in the History of changes. 

 Properties: Additionally to the object names the 
changed properties and the new values are displayed in 
the history of changes. 
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 Value changes: This setting causes the most detail level 
of logging. Not only the new value of a property is 
displayed but also the old one. This makes complete 
traceability of the changes of values possible. 

Default: Object 

Note: Amended values are cut to a length of 128 characters. 

More in the online help. 

 

 
 

Drivers 

In this tab, the zenon driver is selected, which is automatically configured when the wizard is executed. 
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Parameter Description 

Driver list List of the zenon drivers in a tree display. 

 Clicking on [+] expands the entry. 

 Clicking on [-] reduces the entry. 

Select the driver by clicking. 

Driver information Display of the additional information about the selected driver. 

Driver name Name of the driver as it is to be created in the project. Free text 
input. 

The driver name is pre-filled with a proposal after it is selected. 

Unique name of the driver. 
zenon identifies the driver with the help of this name and not 
with the help of the file name. Thus it is possible to load the same 
driver several times. This is necessary, for example, when you 
have to access the same control types that are connected to 
different serial interfaces. 
Attention: This property is not available for language switch. 

Add Adds the selected driver to the list of driver to be created. 

Remove Removes the selected driver from the list drivers to be created. 

List of drivers to be created List of drivers to be created with name, description and file name. 

Create screen with driver statistic 

variables 
Checkbox for the activation of automatic configuration of a 
zenon screen and the attendant system driver variables 
with static information in the zenon project. 

 Active:  
A screen with driver variables is created for the selected 
driver(s). 

 Inactive: 
No project configuration in the zenon project. 
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Graphic Settings 

On this tab you configure the resolution and the settings for the Runtime and touch screens. 

 

GENERAL PROJECT SETTINGS 

General graphical settings for the project. 
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Parameter Description 

Current primary monitor size 

(current) 
Display of the current screen resolution. For multi-monitor systems the 
resolution of the main screen is displayed. 

Note: This option cannot be changed. 

Screen resolution Selection of desired screen resolution from drop-down list. 

Runtime Title Runtime title 

Display of the Runtime main window.  
Select from drop-down list: 

 no title:  
Complete display. Title bar is not displayed. 

 Title with min. and max. button:  
The window can be changed in its size and can be moved. 
Closing is not possible (also not via context menu, task bar 
or the shortcut Alt+F4). Right click on the header opens 
the context menu. 

 Title with system, min. and max. button:  
The window can be changed in its size and can be moved 
and it can be closed by clicking on button X. Right click on 
the header opens the context menu. 

 Title with system menu:  
The window can be moved and closed by clicking on 
button X. Right click on the header opens the context 
menu. 

 Title without buttons:  
The window can be moved and closed by clicking on 
button X. Right click on the header opens the context 
menu. 

Default: no title 

Attention: If this property is changed in the Editor, Runtime must 
be restarted. Reloading alone does not work, because Runtime 
must first be closed and then reopened in order for the main 
menu to be applied. 

More in the online help. 

Graphics quality Setting for the quality of the graphics display. 
DirectX allows a higher quality than Windows Basic. In 
principle, when using DirectX, the DirectX Hardware setting is 
preferable and DirectX Software should only be used if 
absolutely necessary. Possible selection: 

 Windows Basic:  
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Basic graphics settings. Recommended for resource-weak hardware. 

 DirectX Software:  
Graphics calculation is done by the CPU and can lead to high CPU 
load. 

 DirectX Hardware:  
A part of the graphics calculation is done by the graphics card. If the 
system does not support the setting, it automatically switches to 
DirectX Software. 

Default: DirectX Hardware 

Attention: DirectX Not available under Windows CE. 

Note: 

 When switching the mode during the engineering, there 
can be slight pixel deviation. There set this property before 
you create screens. 

 When activating Windows basic for all line types that use 
Line width [Pixel] > 1, all line types are set to solid line. 

 DirectX is not used for the display of ActiveX elements 
(file suffix: *.ocx). 

More in the online help. 

Menu position Menu position for the display in zenon Runtime. Select from drop-down 
list: 

 Top: 

Menu bar is configured at the top 

 Bottom: 

Menu bar is configured at the bottom 

RUNTIME SETTINGS 

Settings for the display when zenon Runtime starts. 
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Parameter Description 

Alarm status active Status line active 

Only available if property Alarm Message List active is active. 

 Active:  
As soon as an alarm occurs, a red status line with alarm information 
is displayed at the top of screen in the Runtime. In this status line 
the alarm can also be acknowledged with a double right click if the 
logged in user has the corresponding rights. 

 Inactive:  

No status line is displayed. 

Default: active 

Attention multi-project administration: The setting in the 
integration project defines the behavior for sub projects, regardless 
of the setting of the sub projects. The alarm status line of the 
uppermost project is always used in Runtime. 

More in the online help. 

Note: This wizard automatically activated property Alarm Message List 

active. 

Driver invisible Driver invisible 

Checkbox for the display of the driver that has been started in the 
Windows task bar. 

 Active:  
Started drivers are not displayed in the Windows task bar in the 
Runtime. 

 Inactive:  
Started drivers are displayed in the Windows task bar in the 
Runtime. 

Default: Inactive. 

More in the online help. 

TOUCH OPERATION 

Settings for touch operation in zenon Runtime. 
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Parameter Description 

Multi-Touch Multi-Touch active 

Checkbox for the application of Multi-Touch. 

 Active:  
Multi-Touch can be used. Flicks (short swipe) and right click (touch 
and hold) are deactivated.  
Requirements: All corresponding driver and devices are available. 
The device must be connected and switched on. 

 Inactive: 

no Multi-Touch operation in the zenon Runtime. 

More in the online help. 

Cursor visible Cursor visible 

Checkbox for the behavior of the mouse pointer in zenon Runtime. 

 Active:  
The mouse pointer is visible in Runtime. 

 Inactive:  
The mouse pointer will not be displayed during Runtime For projects 
with a touchscreen, the display of the mouse pointer can be 
considered to be distracting and can be switched off with this 
property. 

Default: active 
Attention: This setting only has an effect on zenon, not on 
Windows standard elements such as title bars, menus, scroll bars, 
etc. For Windows elements, the mouse pointer must be 
deactivated in the operating system directly. 

More in the online help. 

Automatic keyboard Automatic keyboard 

Checkbox for the activation of an automatic keyboard in zenon 
Runtime for projects with a touchscreen. 

 Active:  
A keyboard screen is automatically called if input is necessary (for 
example to write a setpoint value or to log in). 

 Inactive:  
No keyboard screen is opened. 

Default: Inactive 

More in the online help. 

Create keyboard screen Checkbox for automatic configuration of a keyboard 

screen. 

 Active:  
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Creates DIALOGKBD for alphanumeric input and SETVALUEKBD 
for numeric input. For details see chapter Create screen of type 
keyboard. For it to be used in the Runtime, you must activate the 
option Automatic Keyboard. 

 Inactive: 
No configuration of a keyboard screen. 
None 

Keybooard size (%) Defines in which size - in percent, starting from the original size - 
the automatic keyboard should be displayed in the Runtime. 
Minimum: 50 % 
Maximum: 300 % 
Default: 100 % 

More in the online help. 

 
 

Screen Selection 

On this tab you can select screens which should be created in the project. 
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Attention: By default, the screen switch functions to the selected screens are configured with the 
standard settings. No special settings such as filter, variables, etc. are made. If dashboard screens are 
created in a new project, a button with a linked screen switching function is created in the Navigation 
screen. In a pre-existing project, only the screen switching function is created; it is not linked to a 
button. 

 

CREATE SCREENS FROM TEMPLATES 

Area for setting parameters of zenon screens that are created automatically in the zenon project when 
the wizard is executed. 
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Parameter Description 

Screen types Selection of the screen types for automatic configuration 
when the wizard is executed. 

Selection of the screen type from drop-down list. 

List of possible templates Selection of the template for the screen. Size and preview 
are displayed. 

Width Width of the screen. This value is pre-set in the template 
and cannot be changed. 

Height Height of the screen. This value is pre-set in the template 
and cannot be changed. 

Screen preview Preview of the selected template of the selected screen 
type. 

Eingabefeld Name Input field for naming the screen in the zenon Editor. 

Add Adds screen with the selected name to list of 

screens. 

Remove Removes selected screen from list of screens. 

Screens list List of all selected screens with name, screen type 

and size. 

A maximum of 14 screens can be created. If the 
maximum number of screens has been reached, this is 
shown with a dialog. 

DEMO PROJECT 

Settings for the automatic configuration of an example project when the wizard is executed. 
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Parameter Description 

Create demo screens Checkbox for the activation of automatic project 
configuration when the wizard is executed for an example 
project that can be executed in zenon Runtime. 

Active: When the wizard is executed, corresponding 
screens are configured in the zenon Editor and the 
appearance of the demo project is created, as well as 
linked automatically for linking in Runtime. 

Selection of the demo screens by means of checkbox: 

 Demo pages:  

Example pages (are always created) 

 Alarm message list:  

AML 

 Chronologic event list:  

CEL 

 System information:  

Pages with system information, number depending 
on the resolution 

Create Dashboards Checkbox for the activation of the automatic 
configuration of corresponding diagnosis screens when 
the wizard is executed. 

 Active: 
Checkbox for the activation of automatic 
configuration of corresponding diagnosis screens 
and variables when the wizard is executed. 
In addition, the created screens are linked for display 
in Runtime in the navigation of the example project. 

 Inactive: 
No configuration of diagnosis screens. 

 
 

Dashboards - Diagnosis screens 

All four areas are shown in one screen in the complete display of the dashboard in Runtime: 

 Clicking on the Details... button in a sub-section calls up a new screen with further information 
in relation to the respective topic. 

 Clicking on the photo camera symbol (top right) creates a screenshot and copies it to the 
clipboard. 
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 Clicking on the Dashboard tab in the navigation bar switches to the dashboard overview page. 

 

The information is divided into the following areas: 

 Local system information 
Screen with system information and information about save locations of the executing 
computer. 

 Network information 
Screen with network information from the executing computer. 

 Drivers information 
Screen with information in relation to the drivers. Selection of the drivers from a list. 
In addition, with the Variable diagnosis button, it is possible to link a variable diagnosis screen. 

 System events 
Switch to Chronological Event List. 
In addition, the events can be exported to a file. For this export click on the button Export 

Events... 

AVAILABLE MONITOR RESOLUTIONS 

The Dashboard screen template is available for the following screen resolutions: 

 1280 x 960 

 1280 x 1024 

 1920 x 1080 
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Finish 

On this tab the project is created. 

 

 The first time the wizard is used: 

Click on button Finish to create the project according to the settings on the tabs. The wizard 
remains open for further configuration. To close the wizard, click on button Close. 

 Subsequent times the wizard is used: 

Click on the Overwrite button to apply the changes according to the settings in the tabs in the 
project. The wizard remains open for further configuration. To close the wizard, click on button 
Close. 

 

Examples in the Runtime 

Below you will find two example how your entry in the wizard effects the display in the Runtime. 

 Example 1: (on page 464) With the Create demo screens (on page 458) options active. 

 Example 2: (on page 466) Without example screens. 
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  Information 

The screenshots for this theme are only available in English. 

 
 

With demo screens 

Start page: 

 

Navigation:  

 

SIMUL information: 
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Report Viewer:  

 

AML: 

 

CEL: 

 

SystemInfo_1 ( for each screen resolution 1-3 screens): 
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SystemInfo_2 (1280x1024): 

 

Driver: 

 
 

Without demo screens 

Start page: 
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Navigation: 

 
 

3.7.3 Documentation wizard 

This wizard leads you through the steps needed to create a HTML document of the active project. 

It can be defined, which modules should be included in the documentation and which not. 

The wizard can be edited. 
 

3.8 Variables 

Wizards for variables. 
 

3.8.1 Everywhere Essentials QR Code Generator 

The Everywhere Essentials QR Code Generatorwizard is for creating QR codes that can be visualized 
with the Everywhere Essentials QR Data App. 

  Information 

The wizard needs the Everywhere Server for visualization (payable). 

You can find further information on this in the mobile applications for zenon manual 
in the Everywhere Server by zenon and Everywhere Essentials QR data app chapters. 

 

Possible content of the QR code: 

 Project name 

 Variable name 
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 A certain variable 

 Several variables linked to an equipment group 

 Connection data to the Everywhere Server 

 

  Hint 

 Use the Everywhere Server in order to be able to use your project 
configuration for the mobile applications of zenon. 

 Use the equipment model in the zenon Editor in order to link variables (such 
as for key figures or alarm messages) with an equipment group. 

 Create a QR code for this equipment group with the Everywhere Essentials 

QR Code Generator. 

 Print out this QR code and place it on the device. 

 Scan the QR code on site with the Everywhere Essentials QR Data App to 
visualize real-time data. 

  
 

Install and call up wizard 

The Everywhere Essentials QR Code Generator is automatically installed as part of the zenon standard 
installation. 

WIZARD DISPLAY IN THE ZENON EDITOR 

For wizards to be displayed, the settings for VBA or VSTA must be set correctly in file  zenon6.ini: 

[VBA] 

EIN=1  

[VSTA] 

ON=1 

If VSTA wizards are not displayed although the settings are correct, set entry LOADED= to 1 in area 
[VSTA]. 

STARTING THE WIZARD 

To start the wizard: 

1. Click on Tools -> Start Editor Wizards.... 
Or: Press the short cut Alt+F12 
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The selection window with the available wizards opens. 

 

2. Select the folder Variables. 

3. There, click on Everywhere Essentials QR Code Generator. 

 

4. Click on OK. 

The wizard starts with the start window.  

  Information 

The Everywhere Essentials QR Code Generator is only available in English. 
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Start window 

The Welcome tab provides a brief overview of the functionality of the wizard. 

Note: The wizard is only available in English. 

 

 

NAVIGATION 

 

Navigation through the wizard is by clicking on the individual tabs, or with the mouse clicking on the 
arrow keys. 
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Clicking on the Close button closes the wizard. A dialog is called up before the wizard is closed. 

 

Parameter Description 

Yes Closes the wizard. 
Configured settings are retained when the wizard is 
restarted. 

No Closes the wizard. Existing project configurations are not 
saved. 

 
 

Configuration 

You configure the content of the QR code in the Generate QR Code tab. 

Content of the QR code: 

 Either: 
A variable from the current project. 

 Or: 
An equipment group of the equipment model in the global project or the current project. 
The variables linked to the equipment group are displayed in the Everywhere Essentials QR 

Data App. 

 Optional: Connection parameters to the Everywhere Server. 

Behavior in the Everywhere Essentials QR Data App: 

 No connection parameters contained in the QR code: 

The app attempts to establish a connection to the Everywhere Server with the existing 
connection profiles. 

 QR code includes connection parameters: 

The app established a connection to the Everywhere Server with the parameters entered in 
the wizard. In the app, a dialog to enter the user name and password is called up when the 
connection is established. 
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Generate QR Code 
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VARIABLE/EQUIPMENT GROUP 

Parameter Description 

Variable 

Equipment Group 

Option field to select the preview list: 

 Variable 

Shows the variable list of the active zenon 
project. 

 Equipment Group 

Shows the equipment model of the global 
project (if available) and the equipment 
model of the active zenon project. 

EVERYWHERE SERVER 

The connection parameters to the Everywhere Server can be configured facultative via the setting 
Everywhere Server. 

This information is, if configured, also encoded in the QR code. 

Parameter Description 

Encode connection details Activates the coding of the connection parameters in the 
QR code. 

URL Name of the Everywhere Server to which a connection is 
to be created. 

Port Port address for the connection to the Everywhere 
Server. 

Note: Entries outside the valid entry range are 
automatically corrected to the value 65536. 

PREVIEW 

Shows a preview screen of the QR codes of your project configuration. 

QR CODE 

Parameter Description 

Save to file The currently-displayed QR code is saved as a .png file. 

Copy to Clipboard Copies the displayed QR code to the clipboard. 
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Variable 

If the "„Variable" option field has been selected, the variable list of the active project is displayed. 

 The information of the selected variable is encoded in the QR code. 

 The QR code is updated in the preview directly. 
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Parameter Description 

Equipment Group Option field to switch to the equipment model view. 

Filter Filters the entries in the variable overview. Filtering is 
only carried out for the variable name. 

The text entered here corresponds to the "contains" 
condition. 

Variable Overview of all variables of the current project. 

The list can be sorted by clicking on the column heading. 
Another click reverses the sorting order. The sorting 
direction is shown with an arrow. The column width can 
be freely changed with a right-click. 

 Name 

Variable name. It corresponds to the Name 
property in the Editor. 

 Identification 

Identification of the variable. It corresponds 
to the Identification property in the Editor. 

 Driver 

Driver name. It corresponds to the 
Identification property in the Editor. 

 
 

Equipment Group 

If the "Equipment Group" option field has been selected, the equipment model of the current project 
configuration is displayed. 

 The following is displayed: 

 The equipment model of the global project (if present) 

 The equipment model of the active project. 

 The variables linked to the selected equipment group are encoded in the QR code. 
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 The QR code is updated in the preview directly. 

 

Equipment models of the global project are only offered for selection if there are no equipment models 
with the same name in the active project. If there are models with identical names, this is visualized with 
a warning symbol (yellow triangle) and a tool tip. The equipment model of the global project is grayed 
out. 

 

If you move the mouse over the warning signal, you receive the following error message in a tool tip: 

The following Equipment Model(s) from the Global Project will be ignored! There 

is at least one Equipment Model with the same name in the local Project:  

- [model name in the local project] 

 
 

3.8.2 Variable creation wizard 

This wizard serves to create many variables quickly. 

  Attention 

This wizard does not support distributed engineering and is not available in multiuser 
projects. 

This wizard serves as an example; not all drivers are supported. 
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4. Create and adapt wizards 

Wizards are common VBA forms that contain certain functions in the code part. As a result of this, the 
formulas are recognized as zenon wizard. 

 

The wizards supplied with zenon can form the basis of your own wizards. 

Your own wizards can be stored in your own folders. All required information must be entered into the file named 
wizards.ini (on page 485). This can be included when the wizard is updated (on page 483). 

VBA AND VSTA WIZARDS 

To create wizards the following information is necessary for VBA and VSTA (on page 479): 

 Name 

 Description 

 Category 

 Display in the dialog 

 Version number 

These functions are read by zenon in order to identify forms as wizards and to display corresponding 
information in the wizard dialog. 

  Attention 

Commas (,) are not permitted in the (GetWizard...) wizard fields!  
If a comma is nevertheless used in one of the wizard fields, the wizard is not displayed in 
the zenon Editor in the wizard dialog. 
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The demo wizard offers an empty template that can be individually adapted. For details on creating 
VSTA wizards see chapter Details VSTA wizards (on page 479). 

NAME 

States the wizard name as it is displayed in the dialog for the wizard. 

Example: VSTA project wizard 

VBA VSTA (on page 479) 

Public Function GetWizardName() As String 

GetWizardName = "Project-Wizard" 

End Function 

GetWizardName (Type string) 

DESCRIPTION 

Contains the description of the wizard as it is displayed in area "Descripton" of the dialog. 

Example: This wizard creates a simple zenon Project (V.1) 

VBA VSTA (on page 479) 

Public Function GetWizardInfo() As String 

GetWizardInfo = "Wizard for creation of a 

project" 

End Function 

GetWizardInfo (Type string) 

CATEGORY 

States the category in which the wizard is sorted. 

For example: Project 

Note: You can use existing categories. VBA and VSTA wizards can be sorted in the same category. 

VBA VSTA (on page 479) 

Public Function GetWizardCategory() As String 

GetWizardCategory = "Project" 

End Function 

GetWizardCategory (Type string) 
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DISPLAY IN THE DIALOG 

Defines whether the wizards is displayed in the dialog. With this you can hide a wizard without deleting all 
functions or removing them from the add-in: 

= true: is displayed 

= false: is hidden 

VBA VSTA (on page 479) 

Public Function IsZenOnWizard() As Boolean 

IsZenOnWizard = True 

End Function 

IsZenOnWizard (Type bool) 

VERSION NUMBER 

States the version number which is displayed at the description. The version number is used to manage 
the update of the wizards. 

Example: (V.1) 

Note: Within a wizard class there must not be different functions with the same name. This is also true 
when they report back different parameters. 

VBA VSTA (on page 479) 

Public Function GetWizardVersion() As Integer 

GetWizardVersion = 6 

End Function 

GetWizardVersion (Type int) 

 
 

4.1 Details VSTA Wizard 

VSTA WIZARD 

#region Wizard_Identification 

/// <summary> 
/// This Static method returns the name of the wizard, 
/// which will be displayed in the wizard-tree. 
/// </summary> 
/// <returns></returns> 

static public string GetWizardName() 
{ 
    string strValue = "Name of the wizard"; 
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    return strValue; 
} 

/// <summary> 
/// This Static method returns the description of the wizard, 
/// which will be displayed at the bottom of the wizard-dialog. 
/// </summary>/// <returns></returns> 
static public string GetWizardInfo() 
{ 
    string strValue = "A more detailed description of the wizard."; 
    return strValue; 
} 

/// <summary> 
/// This static method returns the category name of the wizard, 
/// which will be used as node-name in the wizards-tree. 
/// </summary> 
/// <returns></returns> 

static public string GetWizardCategory() 
{ 
    string strValue = "Wizard category"; 
    return strValue; 
} 

/// <summary> 
/// This static method returns a bool which can be used to "switch" the wizard 
/// on/off in the wizard dialog (false=wizard is not shown in the tree). 
/// </summary> 
/// <returns></returns> 

static public bool IsZenOnWizard() 
{ 
    bool bValue=true; 
}    return bValue; 

/// <summary> 
/// This static method returns the version of the wizard. 
/// Indicated at the bottom of the wizard-dialog. 
/// </summary> 
/// <returns>wizard version</returns> 

static public int GetWizardVersion() 
{ 
    int nValue = 1; 
    return nValue; 
} 

/// <summary> 
/// This method is called when the wizard has been selected in the 
/// wizard dialog and confirmed with "OK". 
/// </summary> 
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public void StartWizard() 
{ 
    this.Show(); 
} 
#endregion 

VB.NET 

'This shared method returns the name of the wizard, 
'which will be displayed in the wizard-tree. 

Public Shared Function GetWizardName() As String 

    GetWizardName = "Name of the wizard" 

End Function 

'This shared method returns the description of the wizard, 
'which will be displayed at the bottom of the wizard-dialog. 

Public Shared Function GetWizardInfo() As String 

    GetWizardInfo = "A more detailed description of the wizard." 

End Function 

'This shared method returns the category name of the wizard, 
'which will be used as node-name in the wizards-tree. 

Public Shared Function GetWizardCategory() As String 

    GetWizardCategory = "Wizard category" 

End Function 

'This shared method returns a bool which can be used to "switch" the wizard 
'on/off in the wizard dialog (false=wizard is not shown in the tree). 

Public Shared Function IsZenOnWizard() As Boolean 

    IsZenOnWizard = True 

End Function 

'This shared method returns the version of the wizard. 
'Indicated at the bottom of the wizard-dialog. 

Public Shared Function GetWizardVersion() As Integer 

    GetWizardVersion = 1 

End Function 

'This method is called when the wizard has been selected in the 
'wizard dialog and confirmed with "OK". 

Public Sub StartWizard() 

    Me.Show() 

End Sub 
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C# WORKSPACE 

For the Editor to create an instance of the VSTA class dynamically, you must add an additional function 
to the "Default" Workspace Code. This code segment must exist so that the wizard is displayed after 
selection in the dialog. This code segment should not be modified! 

#region Wizard 

/// <summary> 
/// This Routine Enables the Dynamic creation of VSTA-Wizards. 
/// </summary> 
/// <param name="strClassname"></param> 

public void StartWizard(string strClassname) 

{ 

    //Retrieve the ClassType by its Typename: 

    Type t = Type.GetType(strClassname); 

    if(t!=null) 

    { 

        //Since the ClassType has been found, let's create it. 
        //The wizard from ClassType %strClassname% is required  
        //to have a Constructor with ZenWorkspace Parameter! 

        object[] Params = new object[] { this.ZenWorkspace }; 

        object Wizard = Activator.CreateInstance(t, Params); 

        if (Wizard != null) 

        { 

            t.InvokeMember("StartWizard", BindingFlags.Public | BindingFlags.Instance | 

BindingFlags.InvokeMethod, null, Wizard, null); 

        } 

    } 

} 

#endregion 

And for the VB.Net workspace like this: 
'This Routine Enables the Dynamic creation of VSTA-Wizards, 
'and should not be modified or removed! 

Public Sub StartWizard(ByVal strClassname As String) 

Dim obClassType As Type 

Dim obWizard As Object 

Dim obParams(0) As Object 

    obClassType = Type.GetType(strClassname) 

    If (Not obClassType Is Nothing) Then 

        obParams(0) = Me.ZenWorkspace 

        obWizard = Activator.CreateInstance(obClassType, obParams) 

        If (Not obWizard Is Nothing) Then 

            obClassType.InvokeMember("StartWizard", 

System.Reflection.BindingFlags.Public Or System.Reflection.BindingFlags.Instance Or 

ystem.Reflection.BindingFlags.InvokeMethod, obWizard, Nothing, Nothing) 

        End If 
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    End If 

End Sub 

 
 

5. Update wizards 

When installing a zenon Service Pack, a wizard update is automatically offered. Existing wizards are not 
overwritten by the setup. It can therefore be necessary for the wizards to be manually imported and 
updated. 

  Attention 

This information is only applicable for wizards that were programmed in C#. That is all 
wizards that are shown in the Update wizards window. 

This information does not apply to wizards that were programmed in .Net, such as. 

 Analyzer Wizards 

 Sankey Wizard 

.Net Wizards are integrated by means of a DLL and automatically kept up to date with 
the updates of zenon. The update can, if required, also be carried out manually via the 
build file contained in the zenon Analyzer installation medium for zenon. 

REQUEST UPDATE 

An update can also be initiated manually at any time by selecting the Update Editor add-ins entry in the 
Extras menu. 

Parameter Description 

Wizard list Lists all VBA wizards and VSTA wizards present in the add-in 
that is running. 

 Name Name of the wizard. 

 Object name VBA/VSTA object name. 

 Previous Version Version currently being used. 

 Create Version that it is being updated to. 

 Information Status information and information on the pending 
action: 

 New: Wizard does not exist in the VBA file. 
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 Changed: A new version is available. 

 No longer supported: The existing wizard is obsolete and 
will be deleted. 

 Type VBA or VSTA 

 User-specific wizard was created or changed by the user 

Data source Possibility of defining your own folder for your own wizards. 
The save location of the individual wizards.ini (on page 485) is 
entered.  

The entries for this are saved in zenon.ini in the [VSTA] 
section or [VBA] as WIZARDPATH=. 

Additional folder for VSTA wizards Individual save location for your own VSTA wizards. 

Additional folder for VBA wizards Individual save location for your own VBA wizards. 

Remember me again The dialog will open again when the Editor is next started. 

Start update The wizards selected in the wizard list are updated. 

Cancel The dialog is ended without updating and is only offered again 
after the next installation of a Service Pack. 

MAKE SURE THAT YOU ARE UP TO DATE 

As objects which are not instanced at the time the dialog is opened are not checked, some objects are 
always offered for update. This makes sure that you do not work with out-of-date versions. The versions 
displayed in the update dialog is only used as information for the Consulting and Development 
departments. 

DISTRIBUTE WIZARDS THROUGHOUT THE COMPANY 

If you have written your own wizards and would also like to make these available to other users, then 
you can also use this method.  
To do this, you export the wizard from your VBA/VBA development environment and ideally place the 
export files in an approved network drive. ini files serve to control the imports. These must be created 
accordingly and also stored in the network. 
You can find a description of the files here: For VBA (on page 488) and for VSTA (on page 486). 

Now you only need to show your colleagues the location where it is saved and the wizards can easily 
import these into your Editor. If you have changed or new wizards, you only need to export the new 
status, store it and increase the version number. You can therefore easily distribute wizards in your 
company. 
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POSSIBLE ERRORS WHEN UPDATING VSTA WIZARDS 

Error Possible causes 

No VSTA wizards are displayed in the update 
dialog 

 Only wizards that are in the add-in at the time are 
listed.  
If VSTA wizards are not shown, the VSTA add-in must 
be activated with the Start Editor. To do this, in 
zenon6.ini, in the [VSTA] section, set LOADED= to 
1. 

 If the workspace cannot be compiled due to errors in 
the code, no wizards are listed. 

You can read how the original wizards are recovered in 
the Recover original wizards section. 

A particular wizard is not displayed.  The wizard does not support the required methods. 

 The workspace was not yet compiled after the wizard 
was implemented; the add-in that is running does 
not contain the wizard. 

Self-created wizards are not displayed.  The configured path is incorrect. 

 The wizards.ini in the path configured is obsolete or 
defective. 

RECOVERING ORIGINAL WIZARDS 

If wizards are not displayed in the list of the wizards, you can recover the original wizards. To do this: 

1. End the zenon Editor. 

2. Navigate to the folder: %ProgramData%\COPA-DATA\zenonxxx\VSTAWorkspace   
(xxx stands for the zenon version) 

3. Rename the complete folder. 

4. Restart the Editor. 

The folder and the wizards are recreated. 

 
 

5.1 wizards.ini 

Creation of the INI file for administering the wizard in VSTA and VBA. 

  Information 

This documentation is only available in English. 
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5.1.1 VSTA wizards.ini  

[DEFAULT]: Contains global settings 

COUNT: Amount of wizards included in the INI (must be modified when adding/removing a wizard 

to the ini 

[MYWORKSPACE] Contains settings for the Workspace.cs 

VERSION: Current version 

[WIZARD_X]: Contains settings of a wizard: 

NAME: Name as indicated in the update dialog 

CLASSNAME: Name of the form class representing the wizard. 

VERSION: Version number 

PATH:path-expansion to location of the files. 

DELETE: 1 when the wizard is to be removed from the workspace 

FILES: The amount of files included in this wizard 

FILE_X: The name of a file included in the wizard 

TYPE_X: The type of the file (required for the Form.cs and Resx file) 

DEP_X: The name of a file on which this file depends 

EXAMPLE 

[DEFAULT] 

COUNT=3 

 

[MYWORKSPACE] 

VERSION=1 

 

[WIZARD_1] 

NAME=Import-Wizard 

CLASSNAME=Wizard_Exportxml 

VERSION=3 

PATH=\Wizard_Exportxml 

DELETE=0 

FILES=3 

FILE_1=Wizard_Exportxml.cs 

TYPE_1=Form 

FILE_2=Wizard_Exportxml.Designer.cs 
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DEP_2=Wizard_Exportxml.cs 

FILE_3=Wizard_Exportxml.resx 

DEP_3=Wizard_Exportxml.cs 

TYPE_3=EmbeddedResource 

 

[WIZARD_2] 

NAME=Wizard_Project 

CLASSNAME=Wizard_Project 

VERSION=1 

PATH=\Wizard_Project 

DELETE=0 

FILES=3 

FILE_1=Wizard_Project.cs 

TYPE_1=Form 

FILE_2=Wizard_Project.Designer.cs 

DEP_2=Wizard_Project.cs 

FILE_3=Wizard_Project.resx 

DEP_3=Wizard_Project.cs 

TYPE_3=EmbeddedResource 

 

[WIZARD_3] 

NAME=Demo Wizard 

CLASSNAME=Wizard_Demo 

VERSION=1 

PATH=\Wizard_Demo 

DELETE=0 

FILES=3 

FILE_1=Wizard_Demo.cs 

TYPE_1=Form 

FILE_2=Wizard_Demo.Designer.cs 

DEP_2=Wizard_Demo.cs 

FILE_3=Wizard_Demo.resx 

DEP_3=Wizard_Demo.cs 

TYPE_3=EmbeddedResource 
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5.1.2 VBA wizards.ini 

[DEFAULT]: Contains global settings 

COUNT: Amount of wizards included in the INI (must be modified when adding/removing a wizard 

to the ini 

[MYWORKSPACE] Contains settings for the Workspace.cs 

VERSION: Current version 

[WIZARD_X]: Contains settings of a wizard: 

NAME: Name as indicated in the update dialog 

VERSION: Current version 

PATH:path-expansion to location of the files. 

VB_NAME: Name of the VBA object representing the wizard. 

VB_TYPE: 0=form, 1=class 

DELETE: 1 when the wizard is to be removed from the workspace 

EXAMPLE 

[DEFAULT 

COUNT=3 

 

[MYWORKSPACE] 

VERSION=3 

 

[WIZARD_1] 

NAME=Wizard for creating variables 

VERSION=8 

PATH=\CreateVariables\frmCreateVariables.frm 

VB_NAME=frmCreateVariables 

VB_TYPE=0 

DELETE=0 

 

[WIZARD_2] 

NAME=Document Wizard 

VERSION=12 

PATH=\DocuWizard\frmDocuWizardEx.frm 

VB_NAME=frmDocuWizardEx 

VB_TYPE=0 

DELETE=0 
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[WIZARD_3] 

NAME=Import-Wizard 

VERSION=3 

PATH=\ImportWizard\frmImportWizard.frm 

VB_NAME=frmImportWizard 

VB_TYPE=0 

DELETE=1 

 
 

5.1.3 Required methods for updating 

Example of methods that are required for the wizard to be displayed in the update dialog: 

VBA 

'The following methods define the form as a control system wizard. If IsZenOnWizard is set 

to false, 

'the wizard does not appear in the Wizard dialog and does not influence the wizard update 

dialog. 

Public Function GetWizardName() As String 

    GetWizardName = "Empty Wizard" 

End Function 

Public Function GetWizardInfo() As String 

    GetWizardInfo = "<TODO: Add description here>" 

End Function 

Public Function GetWizardCategory() As String 

    GetWizardCategory = "<TODO: Add category-information here>" 

End Function 

Public Function IsZenOnWizard() As Boolean 

    IsZenonWizard = False 

End Function 

Public Function GetWizardVersion() As Integer 

    GetWizardVersion = 6 

End Function 

VSTA 

#region Wizard_Identification 
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/// <summary> 

/// This Static method returns the name of the wizard, 

/// which will be displayed in the wizard-tree. 

/// </summary> 

/// <returns></returns> 

static public string GetWizardName() 

{ 

    string strValue = "Demo Wizard"; 

    return strValue; 

} 

/// <summary> 

/// This Static method returns the description of the wizard, 

/// which will be displayed at the bottom of the wizard-dialog. 

</summary>/// <returns></returns> 

static public string GetWizardInfo() 

{ 

    string strValue = "This is our Demo Wizard"; 

    return strValue; 

} 

/// <summary> 

/// This static method returns the category name of the wizard, 

/// which will be used as node-name in the wizards-tree. 

/// </summary> 

/// <returns></returns> 

static public string GetWizardCategory() 

{ 

    string strValue = "Wizard VSTA"; 

    return strValue; 

} 

/// <summary> 

/// This static method returns a bool which can be used to "switch" the wizard 

/// on/off in the wizard dialog (false=wizard is not shown in the tree). 

/// </summary> 

/// <returns></returns> 

static public bool IsZenOnWizard() 

{ 

    bool bValue = false; 

    return bValue; 

} 
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/// <summary> 

/// This static method returns the version of the wizard. 

/// Indicated at the bottom of the wizard-dialog. 

/// </summary> 

/// <returns>wizard version</returns> 

static public int GetWizardVersion() 

{ 

    int nValue = 1; 

    return nValue; 

} 

/// <summary> 

/// This method is called when the wizard has been selected in the 

/// wizard dialog and confirmed with "OK". 

/// </summary> 

public void StartWizard() 

{ 

    this.Show(); 

} 

        #endregion 
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